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1 Introduction

Decision Support System Extracts (DSS) Version 3.0 provides a means of exporting data from
selected Veterans Health Information Systems and Technology Architecture (VistA) modules to
a Decision Support System (DSS) resident in the Department of Veterans Affairs (VA) Austin
Information Technology Center (AITC).

This transfer is accomplished through a set of extract routines, intermediate files, audit reports, a
transmission routine, and a purge routine. Data from VistA packages is stored by the extract
routines in the intermediate files, where it is temporarily available for local use and auditing. The
data is then transmitted to the AITC where it is formatted and uploaded into commercial
software. After the data has been successfully uploaded into the commercial software, it is
purged from the intermediate files.

The DSS Extracts software includes the following functionalities:
e DSS Extract field additions and modifications
e DSS Menu additions, modifications and deletions
e New DSS reports and report modifications
e Implementation of the new and/or deleted extracts

1.1 Related DSS Manuals

Listed below are the following DSS Extract manuals that are available to view on the VA
Software Document Library at the following address
http://www.va.gov/vdl/application.asp?appid=35

File Name Manual Name Description

DSS_3_FY2015 DD DSS Extracts V3.0 Data Provides detailed information on formatting
Definitions Guide and defines the data terminology.

DSS 3 FY2015 T™M DSS Extract FY2015 Technical Describes the DSS Extract technical (high
Manual level) terminology

DSS_3 FY2015 UM DSS Extracts V3.0 Extracts User | Provides an overview of the functionality
Manual and enhancements.

DSS_3 FY2015 RN DSS Extract FY2015 Release Provides detailed information on the DSS
Notes extracts and DSS reports modified for this

patch release

The DSS web site is located at the following address: http://vaww.dss.med.va.gov/.
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2 Orientation
2.1 Components of this User Manual

The “Using the Software -Extract Manager’s Menu” section of this manual is designed to serve
as reference to the user, covering vital aspects of this tool. It is broken into five components.

e Maintenance

e Package Extracts

e SAS Extract Audit Reports
e Extract Audit Reports

e Transmission Management

2.2 User Responses

In this manual, user responses are shown in bold type. In most cases, you need only enter the
first few letters to increase speed and accuracy. Press the Return or Enter key (which is indicated
by the symbol <RET>) after each response. This symbol is not shown, but is implied, following
bold type entries.

Enter a caret, indicated by the symbol (©), at almost any prompt to terminate the line of
questioning and return to the previous level in the routine. Continue entering up-arrows (carets)
to exit the system.

2.3 Online Help

Online help is available at almost any prompt in the software by entering a single question mark
(?). This will provide information to help the user answer the prompt. In some instances, entering
double (??) or triple (???) question marks will provide more detailed information.

3 Before You Start Using the Software
3.1 Setup Required DSS Information

Use the options in the submenus of the Maintenance submenu of the Extract Manager's Options
menu listed below to setup information required for using the DSS Extracts software. Refer to
the section titled "Using the Software - Extract Manager's Options™ for information about using
the options. Refer to the DSS Extracts Version 3.0 Installation Guide for information about
installing and implementing the software.

e Setup for DSS Clinic Information
e Setup for DSS Lab Results Information
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3.2

Setup for Inpatient Medications Information
Setup for Inpatient Census Information

Setup QUASAR

If your facility uses the Quality: Audiology and Speech Pathology Audit & Review (QUASAR)
Version 2.0 software, and you wish to send Audiology and Speech Pathology data to DSS, take
the following steps:

1.

The DSS Site Manager, in conjunction with the Event Capture and QUASAR ADPACS,
should use the Event Capture option DSS Units for Event Capture (Enter/Edit) to create
two entries in the DSS UNIT file (#724). These two entries are to be used exclusively for
the QUASAR/DSS extract. One entry should be created for Audiology (e.g., Audiology
DSS Extract), the other for Speech Pathology (e.g., Speech Pathology DSS Extract) as
shown in the following example.

Example: Entries Made for QUASAR

Select Event Capture Management Menu Option: DSS Units for Event

Capture (Enter/Edit)

Select DSS Unit: AUDIOLOGY DSS EXTRACT

Are you adding “AUDIOLOGY DSS EXTRACT® as a new DSS UNIT
(the 54TH)? YES
DSS UNIT Service: AUDIOLOGY AND SPEECH PATHOLOGY
DSS UNIT Cost Center: 822800 Audiology & Speech Pathology
DSS UNIT Medical Specialty: AUDIOLOGY

DSS UNIT Number: <RET>

ASSOCIATED STOP CODE: 203

CATEGORY (Y/N): NO

DATA ENTRY DATE/TIME DEFAULT: <RET>

Select DSS Unit: SPEECH PATHOLOGY DSS EXTRACT

Are you adding "SPEECH PATHOLOGY DSS EXTRACT" as a new DSS UNIT (the 55TH)? YES

2.

DSS UNIT Service: AUDIOLOGY AND SPEECH PATHOLOGY
DSS UNIT Medical Specialty: SPEECH PATHOLOGY

DSS UNIT Number: <RET>

ASSOCIATED STOP CODE: 204

CATEGORY (Y/N): NO

DATA ENTRY DATE/TIME DEFAULT: <RET>

In the above process, the Event Capture software automatically answers YES to the USE
FOR EVENT CAPTURE field in the DSS UNIT file (#724). Use the VA FileMan Enter
or Edit File Entries option to change the answer to NO for the USE FOR EVENT
CAPTURE field for the two entries created in Step 1 above.

The QUASAR ADPAC, coordinating with the DSS Site Manager, should use the
QUASAR option A&SP Site Parameters [ACKQAS SITE PARAMS] to enter data for
the following two new fields in the A&SP SITE PARAMETER file (#509850.8) as
shown in the example below.
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AUDIOLOGY DSS UNIT LINK field — Answer with the Audiology DSS Unit created in
Step 1 above.

SPEECH PATHOLOGY DSS UNIT LINK field — Answer with the Speech Pathology
DSS Unit created in Step 1 above.

Example: Setup/Maintenance on A&SP Supervisor Menu

Select A&SP Supervisor Menu Option: SET Up/Maintenance

Select Set Up/Maintenance Option: A&SP Site Parameters
This option allows you to configure the QUASAR package to meet
facility needs.

Select A&SP SITE PARAMETERS SITE NAME: [Select your site name.]
SITE NAME: [Your site name is here.]// <RET>
USE ASP CLINIC FILE NUMBER: NO// <RET>
USE MODIFIERS: NO// <RET>
USE C&P: YES// <RET>
BYPASS AUDIOMETRICS: YES// <RET>
Select CLINIC LOCATION: SPEECH PATHOLOGY // <RET>
CLINIC LOCATION: SPEECH PATHOLOGY // <RET>
Select CLINIC LOCATION: <RET>
AUDIOLOGY DSS UNIT LINK: ?
Enter the name of the DSS unit to be used for audiology.
AUDIOLOGY DSS UNIT LINK: AUDIOLOGY DSS EXTRACT
SPEECH PATHOLOGY DSS UNIT LINK: ?
Enter the name of the DSS unit to be used for
speech pathology
SPEECH PATHOLOGY DSS UNIT LINK: SPEECH PATHOLOGY DSS EXTRACT
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4 Using the Software - Extract Manager’s Menu
4.1 The Security Keys Structure

This KEY functionality is a function of the Kernel's Key Management functions. These simple
adjustments make it possible to assign the [ECXMGR] Extract Manager's Options to a user so
that they can view all DSS reporting functionality with the assignment of a single option. The
security key then controls only those options that actually create/change data and as such should
not be available to all DSS employees.

The ECXMGR key has been removed from the following menus:
[ECX MAINTENANCE] Maintenance
[ECX TRANSMISSION] Transmission Management

The ECXMGR key has been assigned to the following menus:

[ECXSCLOAD] Create DSS Clinic Stop Code File

[ECXSCEDIT] Enter/Edit DSS Stop Codes for Clinics

[ECXSCAPPROV] Approve Reviewed DSS Clinic Worksheet

[ECX IV DIV EDIT] Enter/Edit IV Room Division

[ECX LAB RESULTS TRANS EDIT] Add/Edit Lab Results Translation Table

[ECXLABRS] Link DSS Selected Lab Tests to Local Lab
Tests

The ECXPVE key has been assigned to the following menu:
[ECX PHA VOL EDIT] Pharmacy Volume Edit

The ECX DSS TEST Security Key has been assigned for the following option:
[ECX FISCAL YEAR EXTRACT] Fiscal Year Logic — DSS Testing Only

4.2 Logon/Accessing DSS Options

Depending on your setup and permissions, you may have a short cut to the DSS menu.
This is one method for reaching the DSS Menu:

1. Logon to VistA.

2. On the Systems Manager Menu, select option: Core Applications

3. On the Core Applications Menu, select option: Administrative Services Menus

4. On the Administrative Services Menus, select option: Extract Manager's Options
View the choices that are on the Extract Manager’s Menu and select an option.
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4.3 Maintenance — Extract Manager’s Menu

The Extract Manager’s Menu [ECXMGR] is the main menu for the DSS. The options listed can
vary based on the user’s Security Keys settings, as described above.

Each option expands to a sub-menu giving detailed options for that area.

The remainder of this manual is organized according to the options shown on this menu and its
sub-menus.

Example: Extract Manager’s Menu

Maintenance

Package Extracts

SAS Extract Audit Reports
Extract Audit Reports Menu
Transmission Management

A mwnT=Z

4.3.1. Maintenance Menu

Choosing the Maintenance option from the Extract Managers Menu will display the following
menu and options. Many of these will then display sub-menus and additional options.

Example: Maintenance Menu Options

Select Extract Manager®s Options Option: M Maintenance

CBOC Activity Report
CPT Inquiry
DSS Department Management
Event capture
Laboratory
Pharmacy
Print Feeder Keys
Print Feeder Locations
10 Prosthetics
11 Setup for DSS Clinic Information
12 Setup for DSS Lab Results Information
**> Qut of Order: MENU OPTION NO LONGER USED
13 Setup for Inpatient Census Information
14 Setup for Inpatient Medications Information
15 Surgery

OCoO~NOOWNE
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4.3.1.1. CBOC Activity Report

This report includes information from every Clinical (CLI) record (by extract #) which has a
Community Based Outpatient Clinic (CBOC) status of YES. The report is grouped by feeder
key, division, and clinic. It lists Patient Name, Social Security Number (SSN) and Date of Visit.

Totals for unique SSNs and Visits will be printed with each clinic, division, and feeder key with
an overall total for the station.

When purging a CLI extract, a check will be made to determine if the CBOC activity report has
been run. If the report has not been run, the user will be told that the report has not been run and
asked if they still wish to purge the data. If the report has been run, no additional prompts will be
seen.

Example: CBOC Activity Report

Selectable Clinic Extracts for CBOC Activity Report Page: 1
Extract # Run Date Rec Count Date Range of Extract Division

1863 03/20/2003 10065 01/01/2003 - 01/31/2003 442

1881 04/03/2003 9519 02/01/2003 - 02/28/2003 442

1899 04/23/2003 9444 03/01/2003 - 03/31/2003 442

1917 08/04/2003 9546 03/01/2003 - 03/31/2003 442
Generate the CBOC Activity Report for the following extract: (1863-2104): 2104

CBOC Activity Report
MAR 01, 2002 — MAR 31, 2002

Page: 001

Run Date: NOV 26, 2002

Feeder Key: ##HH###H#HH#H#H###  Division: ######H  ClINIC: HHHHHHHHHHHHHHIHHH
Patient SSN VISIT DATE/TIME

DSSPATIENT ,ONE 000456789 OCT 12, 2002 @ 10:30:01
DSSPATIENT, TWO 666456789 OCT 14, 2002 @ 10:30:01
DSSPATIENT, THREE 666543009 OCT 12, 2002 @ 10:30:01
DSSPATIENT,FOUR 000768777 OCT 14, 2002 @ 10:30:01

Total Unique for Clinic:

Total Unique for Division: #i#H##H#H#HE  #HiHHHHHHHHE
Total Unique for Feeder Key: #H##HHHHHHIHHT  HEHHHHHHHHHIHHT

4

<- When applicable
<- When applicable

Total Unique (entire report): #HH##HH#H#HHH#H#E  #Hit##HH#HEH#H#E <- At end of report
<** Form feed on clinic, division, and feeder key **>
Use division number not name (ex: 528AB)
Truncate clinic name to 20 characters

Example: Exported CBOC Activity Report

FEEDER KEY DIVISION | CLINIC PATIENT NAME SSN VISIT DATE/TIME
102000030NONCO 674GA P NUR DISPOSITION XXXXXXXK,XXXXXXXX XXXXXXXXX | Feb 26,2014@16:15
102000030NONCO 674GA P NUR DISPOSITION XXXXXXXK, XXXXXXXX XXXXXXXXX | Feb 25,2014@17:30
Total Unique SSNs for Clinc 2 | Clinic Visits
Total Unique SSNs for Division 2 | Division Visits
Total Unique SSNs for Feeder Key 2 | Feeder Key Visits
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4.3.1.2. CPT Inquiry

This inquiry allows the user to select a CPT code. It then displays the Short Name, Category, and
Description for the selected code.

Example: CPT Inquiry
Select CPT: ??

Choose from:

10000 DRAINAGE OF SKIN LESION INACTIVE CODE
10001 DRAINAGE OF 2ND SKIN LESION INACTIVE CODE
10002 DRAINAGE OF SKIN LESIONS INACTIVE CODE
10003 DRAIN & TREAT SKIN LESION INACTIVE CODE
10020 DRAINAGE OF BOIL INACTIVE CODE
10021 FNA W/0 IMAGE
10022 FNA W/ IMAGE
10040 ACNE SURGERY
10060 DRAINAGE OF SKIN ABSCESS
10061 DRAINAGE OF SKIN ABSCESS
10080 DRAINAGE OF PILONIDAL CYST
10081 DRAINAGE OF PILONIDAL CYST
10100 DRAINAGE OF INFECTED NAIL INACTIVE CODE
10101 DRAINAGE OF INFECTED NAIL(S) INACTIVE CODE
10120 REMOVE FOREIGN BODY
10121 REMOVE FOREIGN BODY
10140 DRAINAGE OF HEMATOMA/FLUID
10141 DRAINAGE OF HEMATOMA INACTIVE CODE
10160 PUNCTURE DRAINAGE OF LESION
Select CPT: 10160 PUNCTURE DRAINAGE OF LESION
CPT Inquiry Date: OCT 07, 2003
CPT Code: 10160 Short Name: PUNCTURE DRAINAGE OF LESION

Category: INTEGUMENTARY SYSTEM
Description: PUNCTURE ASPIRATION OF ABSCESS, HEMATOMA, BULLA, OR CYST

4.3.1.3. DSS Department Management

Choosing the DSS Department Management option from the Maintenance Menu will display the
following sub-menu and options.
Example: DSS Department Management Menu

Select DSS Department Management Option: ?
Enter/Edit DSS Ward
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4.3.1.3.1 Enter/Edit DSS Ward
This option should only be used by the DSS Site Manager.

Use this option to enter or edit the DSS Department for Ward and suffix, if needed, associated
with each medical center ward within your division. If the ward you selected exists in the DSS
WARD file (#727.4), the DSS Department Code is displayed and the software asks if you want
to edit it. If the ward you selected does not exist in the DSS WARD file (#727.4), the software
prompts you to enter a DSS Department for Ward and suffix to complete the DSS Department
Code. The suffix must have at least one character, no more than three characters and must not
contain an embedded up-arrow. The hyphen character < - > should not be used unless this DSS
Department code was previously established in DSS/Austin. After you enter or edit information,
the new DSS Department code is displayed and you are asked to verify its accuracy.

Example: DSS Department Management

Select WARD LOCATION NAME: C MEDICINE
Ward: C MEDICINE

Ward Bedsection: MEDICINE

Ward Specialty: GENERAL(ACUTE MEDICINE)
Ward Service: MEDICINE

Division: CHEYENNE VAMROC/442
DSS Department for Ward:

43.1.4 Event Capture

43141 Unusual Volume Report for Event Capture

The Unusual Volume Report for Event Capture is a tool used by managers to validate the EC
volume data similar to the use of the Surgery or Pharmacy Unusual VVolume Report. It can be
used to identify - volumes above a user selectable threshold, thus avoiding tedious work by the
user. The report should be run prior to information being sent to the DSS database.

The example listed below depicts an example of a report when run for all DSS Units:

Example: Unusual VVolume Report for All DSS Units

Select Maintenance Option: Event Capture

Unusual Volume Report for Event Capture

Select Event Capture Option: Unusual Volume Report for Event Capture
ECS Extract Unusual Volume Report

This report prints a listing of unusual volumes that would be
generated by the Event Capture extract (ECS) as determined by

a user-defined threshold value. It should be run prior to

the generation of an actual extract to identify and fix, as

necessary, any volumes determined to be erroneous.

Unusual volumes are those in excess of the threshold value
defined by the user. The threshold value is 20 by default.
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Note: You may set a different threshold if you opt to continue.
Run times will vary depending upon the size of the EVENT CAPTURE
PATIENT file (#721) and the date range selected, but may be at
least several minutes. Queuing to a printer is recommended.

The running of this report has no effect on the actual extracts
and can be run as needed.

You may select one or all DSS Units. |If you select one unit,

the report is sorted by descending volume. If you select all DSS
Units, the report is sorted by DSS Unit, then by descending volume.
Enter RETURN to continue or "~ to exit: <RET>

The default threshold volume for unusual volumes in Event Capture is 20.
Would you like to change the threshold? NO// <RET>

Do you want ALL DSS UNITs? YES//<RET>

Enter the date range for which you would like to scan the
Event Capture records.

Starting with Date: 6/1/10 (JUN 01, 2010)
Ending with Date: 6/30/10 (JUN 30, 2010)

Do you want the output in exportable format? NO//
This report is formatted for 132-column line width.

Enter "Q" to queue report to TaskManager, then select printer.
DEVICE: HOME//

Example: CS Extract Unusual Volume Report

CS Extract Unusual Volume Report Page: 1
Start Date: JUN 01, 2010

Report Run Date: SEP 14, 2010

End Date: JUN 05, 2010

Threshold Value: 20

SSN FACILITY DSS UNIT DATE/TIME PROCEDURE  VOLUME PROVIDER
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AU61 Chronic Hmls HCHV 6/5/2010@16:57 HMOO2N 28 Provider,One
XXXXXXXXX 442  AUB1 CHYSNH 6/28/2010@10:00 SNOOIN 28 Provider,Two
XXXXXXXXX 442  AUB1 CHYSNH 6/28/2010@10:00 SNOOIN 28 Provider,Two

Example: Exported CS Extract Unusual Volume Report

=t=1.8 FACTLITY DSS UNIT DATE/TIME PROCEDURE VOLUME PROVIDER

A S 552 HCHC HOSPII3/1/2014@08:00 HH101N 31 | Xsewanxx, Gayle
FODORRONGT 552 HCHC HOSPTi13/1/2014@08:00 HH101N 31 | Xsowauxx, Gayle
HEGOOONNH 552 HCHC HOSPIi3/1/2014@08:00 HH101N 31 Hmomwanx, Gayle

The following example listed below depicts an example of a report when run for a single DSS
Units.
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Example: Event Capture Report for a Single DSS Unit

The default threshold volume for unusual volumes in Event Capture is 20.
Would you like to change the threshold? NO// <RET>

Do you want ALL DSS UNITs? NO

Select DSS UNIT NAME: AU

1 AuU4l1l Alc/Drug Halfway Au41

2 AU61 Chronic Hmls HCHV AU61

3 AUA1 CHYCNH AUAL

4 AUB1 CHYSNH AUB1

5 AUC1 CHYSD AUC1
CHOOSE 1-5: 4 AUB1 CHYSNH AUB1

Starting with Date: 6/1/2010 (JUN 01, 2010)
Ending with Date: 6/30/2010 (JUN 30, 2010)

Example: ECS Extract Unusual Volume Report

ECS Extract Unusual Volume Report Page: 1
Start Date: JUN 01, 2010

Report Run Date: SEP 14, 2010

End Date: JUN 30, 2010

Threshold Value: 20

SSN FACILITY DSS UNIT DATE/TIME PROCEDURE VOLUME PROVIDER

XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010010:00 SNOO1IN 28 Provider,Two
XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010@10:00 SNOOIN 28 Provider,Two
XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010010:00 SNOO1IN 28 Provider,Two
XXXXXXXXX 442 AUB1 CHYSNH 6/28/2010@10:00 SNOOIN 28 Provider,Two

Example: Exported CS Extract Unusual Volume Report Single Unit

SEN FRCILITY DSS5S UNIT DRTE/TIME PROCEDURE VOLUME DROVIDER

SOOCO00NT 552 HCHC HOSPII3/1/2014@05:00 HH101N 31 | Xxxuxxx, Gayle
A S 552 HCHC HOSPII3/1/2014@08:00 HH101N 31 | Xsewanxx, Gayle
A S 552 HCHC HOSPII3/1/2014@08:00 HH101N 31 | Xsewanxx, Gayle

4.3.1.5 Laboratory

Choosing the Laboratory option from the Maintenance Menu will display the following sub-
menu and options.

Example: Laboratory Menu Options

Select Laboratory Option: ?

1 Add/Edit Lab Results Translation Table

2 Lab Results Extract Untranslatable Results Report

3 Lab Results LOINC Code Report
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4.3.1.5.1 Add/Edit Lab Results Translation Table

This option allows the editing of existing entries or the addition of new entries in the LAB

RESULTS TRANSLATION file (#727.7). Free text results (non-numeric) are stored in this file
with their corresponding translation codes.

See Appendix B for further information, if necessary.

Example: Add/Edit Results Transition Table

Select Maintenance Option: Add/Edit Lab Results Translation Table

ADD/EDIT LAB RESULTS TRANSLATION TABLE

This option allows the editing of existing entries or the addition of new

entries in the LAB RESULTS TRANSLATION file (#727.7). Free text results(non-numeric)

are stored in this file with their corresponding translation codes

Select LAB RESULTS TRANSLATION:

?

Answer with LAB RESULTS TRANSLATION, or NUMBER

Do you want the entire 65-Entry LAB RESULTS TRANSLATION List? Y (Yes)
Choose from:

[E=Y

October 2014

NEG
POS

N
POSITIVE
NE

P
NEGATIV
NEGAT IVE
NEG.

ND

NEG#
NONREACT
NR

NRE
NONREAT IVE
NONREACT IVE
NON REAC
NOTDET
NON-REACT
POS#

POS.
WK . POS

R

REAC
REACT
REACTIVE
REACT IVE*
WK . POS.
WK POS
DETEC
DETECTED.
EQUIV
EQUIVOCAL
BDL
BRDLNE
BRDL INE
BORDERL INE
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38 REPEAT

39 NRG

40 LSG

41 DONE
42 NEH

43 MEG

44 NGE

45 REM

46 NREACT
47 SEE COM
48 SEE RPT
49 TYPE 1
50 2B

51 3A

52 BAS

53 POD

54 N-1

55 PEND

56 RPC

57 QNS

58 FFT

59 **pP0OS
60 ***pQS
61 +/-=P0S
62 =+P0S
63 INCONC.
64 +

65 -

You may enter a new LAB RESULTS TRANSLATION, if you wish
Answer must be 1-30 characters in length

Select LAB RESULTS TRANSLATION: pend
-..0OK? Yes// <RET> (Yes)

RESULT: PEND// <RET>
TRANSLATION CODE: Result cannot be translated// ??
Numeric Translation Code that the Result will be translated to.
Choose from:

0 Negative, Non-Reactive

1 Positive, Reactive

2 Borderline, Indeterminate

3 Test Not Performed, Qty not sufficient or other reason
5 Result cannot be translated

TRANSLATION CODE: Result cannot be translated// <RET>
Select LAB RESULTS TRANSLATION:

4.3.1.5.2 Lab Results Extract Untranslatable Results Report

This report prints a listing of results that are not translatable (have no entry in the Lab Results
Translation file (#727.7)). It is a pre-extract type audit report and should be run prior to the
generation of the actual extract. Running this report has no effect on the actual extract.

You will be prompted for the date range for which you would like to scan the LAR Extract
records. Beginning and ending dates must be in the same month and year.

See Appendix B for further information, if necessary.

Example: Lab Results Extract Untranslatable Results Report
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Select Maintenance Option: Lab Results Extract Untranslatable Results Report

This report prints a listing of results that are not translatable i.e. have
no entry in the Lab Results Translation File (#727.7).

This report is a pre-extract type audit report and should be run prior to the
generation of the actual extract. Running this report has no effect on the
actual extract.

**WARNING: This report can take a long time to process. You are encouraged
to queue this report for processing during the evening if possible._**

Enter the date range for which you would like to scan the LAR Extract records.

Starting with Date: 2/1/2011 (FEB 01, 2011)
Ending with Date: 2/28/2011 (FEB 29, 2011)

Do you want the output in exportable format? NO//<RET>

LAR Extract Untranslatable Results Audit Report Page: 1
Start Date: FEB 01, 2011

End Date: FEB 28, 2011

Report Run Date: FEB 02, 2012

Pat. SSN Date/Time Test Test Name Result
Name Collected Code

DSS1 XXXXXXXXX 2/24/11@19:50 32 MICROALBUMIN <0.3
DSS2 XXXXXXXXX 2/6/11@02:21 2 POTASSIUM (SERUM) canc
DSS3 XXXXXXXXX 2/7/11@08:04 27 LDLC comment
DSS4 XXXXXXXXX 2/13/11@04:58 25 FOLATE >20
DSS5 XXXXXXXXX 2/12/11@17:37 19 PSA (PROSTATIC SPECIFI >100
DSS6 XXXXXXXXX 2/26/11@00:11 25 FOLATE >20
DSS7 XXXXXXXXX 2/25/11@12:55 32 MICROALBUMIN <0.3

Example: Exported Lab Results Extract Untranslatable Results Report

PRT. NZME S5M DATE/TIME COLLECTED TEST CODE TEST NAME RESULT
22411@19:30 32 MICRCALEUMIN 0.3
2611@02:21 2 POTASSIUM (SERUM) canc
2TN1L@08:04 27 LDLC comment

4.3.1.5.3 Lab Results DSS LOINC® Code Report

This report prints a listing showing the DSS LOINC® Codes file (#727.29) and its definitions of
LAR Test Numbers and the local tests assigned to them. It also compares the LOINC Code
assigned by DSO for a LAR Test to the LOINC Codes found on the local database. The latter is
based on the linking of Workload Codes to LOINC Codes at the particular location. Differences
are marked with an asterisk following the Local LOINC Code column and must be resolved.
DSO can guide the location in this.

The report displays all workload codes associated with the DSS desired LOINC code. The report
prints the values in those columns even if there is no matching workload code found in file #60.
The intent of the modification is to identify inexact matches and to display all workload codes
associated with a DSS desired LOINC code.
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The report process attempts to find a matching LOINC code between the DSS LOINC file
(#727.29) and the WKLD Code file (#64). If a match is not found, an **’ (asterisk) displays in
the FLG column to indicate there is no local workload setup for the desired DSS LOINC code.
None of the “local’ fields (those fields coming from file #60 or #64) will be populated.

Select Laboratory Option: 3 Lab Results DSS LOINC Code Report

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported Lab Results DSS LOINC Report

T s (MO WO g oo e loawmo oo
1 Hemoglobin G/DL 718-7 NEW HGB BLOOD 100727 23020.4452
2 Potassium [Serum) MECQ/L or MMOL/L 2823-3 POTASSIUM  PLASMA 499 341400000
4 BUN mg/dl 11064-3 *

5 BUN [Blocd Urea Nitrogen) MG/DL 30540 UREA MITROG PLASMA 543 84520.0000

Example: Lab Results DSS LOINC Report Screen Print
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LAR RESULTS D35 LOTHC CODE REPORT
Report Run Date/Tine: AlG 21, 2014

055 Site: DRYTON (552

F LOC SPEC
LAR TEST# LAR TEST HAAE LAR UNITS LAR LODMC L LOCAL TEST MAAE TWPE
(w727.29]  (#727.20) (#727.09] (#27.20) 6 (#:4) (#64)
oo Herog lobin GAIL T8-7 T-HEHOGLOBTH BLOOD
oo Hexog lobin G/IL 187 HEW HGE BLOOD
oon2 Potassiun [Serun) AEQAL or HAOL 28e3-3 POTHASIUA PLASHA
onoz Potassiun [Serun) HEQ/L or HHOL 2023-3 POTASSTUA SERUA
o3 Sodiun [Serun) HEQAL or HHOL 2347 -0 T-500TU BLOOD

4.3.1.6 Pharmacy

Page: 1

LOC HELDLOC LD
IEH CODE
(464]  [(464)

100458 3020, 456
100727 33020, 4z
430 3140, 0000
499 841400000
100453 34295, 4456

Choosing the Pharmacy option from the Maintenance Menu will display the following sub-menu

and options.

Example: Pharmacy Options Menu

Select Pharmacy Option: ?

Pharmacy Edit and Edit Log

Pharmacy Extracts Incomplete Feeder Key Report
Pharmacy Extracts Unusual Cost Report

Pharmacy Extracts Unusual Volume Report
UDP/IVP Source Audit Report

A WNE

4.3.1.6.1 Pharmacy Edit and Edit Log

The option consists of Pharmacy Volume Edit and Pharmacy Volume Edit Log.

NOTE: The ECXPVE security key is required.

4.3.1.6.1.1 Pharmacy Volume Edit

This option allows authorized users to edit the Pharmacy Extracts (IVP, PRE and UDP).

Corrections may be made to the:
e Quantity field for IVP, PRE, UDP
e Unit of Issue field for PRE
e Total Doses per Day field for VP

contact the DSO CSHD.

NOTE: Extract must be rerun if changes need to be made after the extract is transmitted. Please

Example: Pharmacy Volume Edit for PRE
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1 Pharmacy Volume Edit
2 Pharmacy Volume Edit Log

Select Pharmacy Edit and Edit Log Option: 1 Pharmacy Volume Edit

Select one of the following:

P PRE
1 1VP
u UDP

Which extract do you need to edit?: PRE
Select PRE EXTRACT NUMBER: ?

Select from one of the following extract numbers:
IT¥ no numbers appear then there are no extracts that can
be edited.

3741
3863
3882

Select PRE EXTRACT NUMBER: 3741
Enter patient"s SSN, if known, or press ENTER to continue: ??

Enter patient®s SSN, if known. The SSN will be used to find sequence numbers
associated with this patient. Enter 9 digits or 9 digits and P, no hyphens or spaces.
Entry is optional.

Select PRE EXTRACT SEQUENCE NUMBER:

This is a required response. Enter "~" to exit

Select PRE EXTRACT SEQUENCE NUMBER: ?

NOTE: If apatient’s SSN is entered and a question mark (?) is entered for the extract
sequence number, only records including that patient’s SSN will appear in the results.

Select from one of the following sequence numbers:

SEQUENCE # SSN FILL DT QUANTITY UNIT OF ISSUE
3938879 XXXXXXXXX FEB 01, 2012 90 TAB
3938880 XXXXXXXXX FEB 01, 2012 90 TAB
3938881 XXXXXXXXX FEB 01, 2012 15 TAB
3938882 XXXXXXXXX FEB 01, 2012 30 TAB
3938883 XXXXXXXXX FEB 01, 2012 90 CAP
3938884 XXXXXXXXX FEB 01, 2012 30 TAB
3938885 XXXXXXXXX FEB 01, 2012 270 TAB
3938886 XXXXXXXXX FEB 01, 2012 90 TAB
3938887 XXXXXXXXX FEB 01, 2012 120 TAB
3938888 XXXXXXXXX FEB 01, 2012 30 ML
3938889 XXXXXXXXX FEB 01, 2012 227 GM
3938890 XXXXXXXXX FEB 01, 2012 120 ML
3938891 XXXXXXXXX FEB 01, 2012 80 GM
3938892 XXXXXXXXX FEB 01, 2012 270 TAB

Example: Pharmacy Volume Edit for IVP
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Which extract do you need to edit?: IVP
Select IVP EXTRACT NUMBER: ?7?

Select from one of the following extract numbers:
IT¥ no numbers appear then there are no extracts that can
be edited.

2908
3570

Select IVP EXTRACT NUMBER: 3570
Enter patient"s SSN, if known, or press ENTER to continue: ??

Enter patient™s SSN, if known. The SSN will be used to find sequence numbers
associated with this patient. Enter 9 digits or 9 digits and P, no
hyphens or spaces. Entry is optional.

Enter patient™s SSN, if known, or press ENTER to continue:
Select 1VP EXTRACT SEQUENCE NUMBER: ?

NOTE: If apatient’s SSN is entered and a question mark (?) is entered for the extract
sequence number, only records including that patient’s SSN will appear in the results.

Select from one of the following sequence numbers:
SEQUENCE # SSN DISPENSE DT QUANTITY TOTAL DOSES/DAY

202327 XXXXXXXXX  JUN 01, 2010 1 100 ML
202328 XXXXXXXXX  JUN 01, 2010 1 1GM
202329 XXXXXXXXX  JUN 01, 2010 1 1000 ML
202330 XXXXXXXXX  JUN 01, 2010 1 100 ML
202331 XXXXXXXXX  JUN 01, 2010 1 3.375 GM
202332 XXXXXXXXX  JUN 01, 2010 1 250 ML
202333 XXXXXXXXX  JUN 01, 2010 1 1000 MG
202334 XXXXXXXXX  JUN 01, 2010 1 100 ML
202335 XXXXXXXXX  JUN 01, 2010 1 3.375 GM
202336 XXXXXXXXX  JUN 01, 2010 1 100 ML
202337 XXXXXXXXX  JUN 01, 2010 1 40 MG
202338 XXXXXXXXX  JUN 01, 2010 1 1000 ML
202339 XXXXXXXXX  JUN 01, 2010 1 250 ML
202340 XXXXXXXXX  JUN 01, 2010 1 1000 MG
202341 XXXXXXXXX  JUN 01, 2010 1 500 MG

Example: Pharmacy Volume Edit for UDP

Which extract do you need to edit?: UDP
Select UDP EXTRACT NUMBER: ??

Select from one of the following extract numbers:
IT no numbers appear then there are no extracts that can

be edited.

2024
2921
3581

Select UDP EXTRACT NUMBER: 3581
Enter patient"s SSN, if known, or press ENTER to continue: ??
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Enter patient®s SSN, if known. The SSN will be used to find sequence numbers
associated with this patient. Enter 9 digits or 9 digits and P, no
hyphens or spaces. Entry is optional.

Enter patient"s SSN, if known, or press ENTER to continue:
Select UDP EXTRACT SEQUENCE NUMBER: ?

NOTE: Ifa patient’s SSN is entered and a question mark (?) is entered for the extract
sequence number, only records including that patient’s SSN will appear in the results.

Select from one of the following sequence numbers:

SEQUENCE # SSN DISPENSE DT  QUANTITY
1364046 XXXXXXXXX  JUN 01, 2010 1
1364047 XXXXXXXXX  JUN 01, 2010 1
1364048 XXXXXXXXX  JUN 01, 2010 1
1364049 XXXXXXXXX  JUN 01, 2010 1
1364050 XXXXXXXXX  JUN 01, 2010 1
1364051 XXXXXXXXX  JUN 01, 2010 1
1364052 XXXXXXXXX  JUN 01, 2010 4
1364053 XXXXXXXXX  JUN 01, 2010 2
1364054 XXXXXXXXX  JUN 01, 2010 1
1364055 XXXXXXXXX  JUN 01, 2010 1
1364056 XXXXXXXXX  JUN 01, 2010 2
1364057 XXXXXXXXX  JUN 01, 2010 4
1364058 XXXXXXXXX  JUN 01, 2010 4

4.3.1.6.1.2 Pharmacy Volume Edit Log

The Pharmacy Volume Edit Log requires a 132-column output. (The sample report was modified
to fit into the space below)

Example: Pharmacy Volume Edit Log for IVP

PHARMACY VOLUME EDIT LOG FOR 1VP Page 1
Printed on Oct 24, 2006@13:15:13 for 10/20/06 to 10/24/06

USER NAME DATE/TIME CHANGED SEQUENCE # EXTRACT # FIELD NAME OLD VALUE NEW
VALUE

DSS,USER1 OCT 24,2006 13:11 120583 2609 QUANTITY 1 2
DSS,USER2 OCT 24,2006 13:11 120584 2609 QUANTITY 1 5
DSS,USER3 OCT 24,2006 13:11 120585 2609 QUANTITY 1 5
DSS,USER4 OCT 24,2006 13:11 120586 2609 QUANTITY 1 5
DSS,USERS OCT 24,2006 13:11 120587 2609 QUANTITY 1 5

4.3.1.6.2 Pharmacy Extracts Incomplete Feeder Key Report

This report prints listing of Drug file entries that have incomplete Feeder Key based on one of
the following conditions:

e No PSNDF VA Product Name Entry (first 5 digits are zero)
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e No National Drug Code (NDC) (last 12 digits are zero)
e No PSNDF VA Product Name Entry or NDC (all 17 digits are zero)

This report is designed to be run before the extract for a specified date range and can be used as a
tool to identify and fix DRUG file (#50) entries that have incomplete Feeder Keys. Only those
drugs that would be included on the Extract for the specified date range are listed on the report
for the Pharmacy Extract selected (PRE, IVP or UDP). The following columns are included on
the report:

1. Drug Entry - INTERNAL ENTRY NUMBER (IEN) for the drug from the DRUG file
(#50).

2. Generic Name - The GENERIC NAME field (#.01) of the drug from the DRUG file
(#50).

3. Feeder Key - The Feeder Key for the drug, which is the first 5 characters of the PSNDF
VA PRODUCT NAME ENTRY field (#22) concatenated with the 12 characters NDC
field (#31) from the DRUG file (#50).

4. Number of Records - The number of Extract records that would contain this drug for the
date range specified if the extract were run.

5. Total Quantity - The sum of the quantities of the drug from all of the Extract records.
This is the same as the QUANTITY field for the PRE and UDP Extracts. For the IVP
Extract the Total Quantity is the sum of the values taken from the ADDITIVE
STRENGTH field (#7) or SOLUTION VOLUME field (#9) of the IV EXTRACT DATA
file (#728.113).

6. Unit Price - The PRICE PER DISPENSE UNIT field (#16) from the DRUG file (#50) for
the PRE and UDP Extracts. For the I\VVP Extract Unit Price is the COST field (#12) of the
IV EXTRACT DATA file (#728.13).

7. Total Cost - The total cost of the drug for the Extract (Total Quantity x Unit Price). For
all three Pharmacy Extracts, the Total Cost is the same as the sum of the COST filed from
all Extract records containing the drug.

This report requires a 132-column output.

Select Maintenance Option: Pharmacy Extracts Incomplete Feeder Key Report

This report prints a listing of Drug File (#50) entries that will generate
incomplete Feeder keys in the three Pharmacy Extracts. This listing

can be used to identify and fix Drug File entries. The number of extract
records, total, quantity, unit price and total cost for each drug are
included to aid in determining the impact of the incomplete Feeder Keys.

This report is broken into 3 sections as follows:

Section 1: No PSNDF VA Product Name Entry (first 5 digits are zero).

Section 2: No National Drug Code (NDC) (last 12 digits are zero) or the NDC
is prefixed with an "S", indicating possible supply item number
or UPC.
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Section 3: No PSNDF VA Product Name Entry, and
a. no NDC (all 17 digits are zero), or
b. The NDC is prefixed with an "S", indicating possible supply
item number or UPC.
Section 3: No PSNDF VA Product Name Entry or NDC.

Run times for this report will vary depending upon the size of the extract and

could take as long as 30 minutes or more to complete. This report has no effect
on the actual extracts and can be run as needed.

4.3.1.6.2.1 PRE Extracts Incomplete Feeder Key Report
Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UDP

Selection: 1// 1 PRE

Enter the date range for which you would like to scan the Prescription
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)

Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported PRE Extracts Incomplete Feeder Key Report

DRUG NUMBER OF TOTAL UNIT ~ TOTAL
TYPE ENTRY GENERIC NAME FEEDER KEY RECORDS  QTY PRICE COST ERROR
Prescription 1341  TETANUS & DIPHTHERIA TOXQID .5ML 00000049281021510 1 1 12,5700 12,57 NoPSNDF VA Product Name Entry (Five leadin)
Prescription 2823  PNEUMOCOCCALVACCINE 00000000006473900 25 25 104.9200 2623.00 Mo PSMDF VA Product Name Entry (Five leading zeros)
Prescription 3967  DERMA CERIN TOP CREAM 00000072140000021 1 227 0.0223  5.06 No PSNDF VA Product Name Entry (Five leading zeros)
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Example: PRE Extracts Incomplete Feeder Key Report Screen Print

Prescription Exfract Inconplete Feeder Key Report Page: 2
Start Date: MAR 01, 2014

End Date:  HAR 03, 2014 Report Run Date/Tine: AlG 24, 2014
Orug  Generic Mane Feeder key # of Total Unit Total
Entry Records  Quantity Price Cost

Ho Mational Orug Code [MOC] [Last 12 zeros, 'WA', or 'S prefis]

#10 BRIEF,PROTECTION PLUS LARGE #H5C33505 1EZ21000n0anononn g ] £0.5385 116,32
B34 HAKHOOD ABSORBEMT POUCH #27-4200-B 11ga40nonoanononn 1 181 f0.2203 §30.63
TOTAL RN

4.3.1.6.2.2 IVP Extracts Incomplete Feeder Key Report
Choose the report you would like to run.
Select one of the following:
1 PRE
2 1VP
3 UbP
Selection: 1//7 2 1VP
Enter the date range for which you would like to scan the 1V Detail
Extract records.
Starting with Date: 2/1 (FEB 01, 2013)
Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.
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NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: VP Extracts Incomplete Feeder Key Report Screen Print

IV Detail Ewtract Inconplete Feeder Rey Report Page: 3
Start Date: AR 01, 2014

End Date;  HAR 03, 2014 Report Run Date/Tine: AUG 21, 2014
Orug  Generic Made Feeder key # of Total Unit Total
Entry Records  Quantity Price Cost

Ho PSHOF UA Product Wane Entry or Mational Orug Code [HOC)

1623 URHCORYCIN S00RG in OGN 100AL ACDD-A-U'TAL uoononnononoonnon - 28 k) g0. 000 .24
B052  FENTANAL 2500HCG/NS 250HL aoononnonanoannnn 1 1 g0.nonn &0.00
TOTHL #.od

GRAKD TOTAL f.24

Example: Exported IVP Extracts Incomplete Feeder Key Report

TYEE DRUG ENTRY GENERIC NRME FEZDER EEY NUMBER OF RECORDSTOTAL QTY¥UNIT PRICE TOTAL COSTZRROR

IV Detail 9815 INV-2¢ TRANEXAMIC ACID/NS SYR OR PLACEBD £3323058310 1-Jan-00 1l 0-Jan-00  Jen-00 No PSNDF VA Product Neme Entry (Five leading zeros)

IV Deteil 981 INV-1C TRANEXAMIC ACID/NS BAG OR PLACERD £3323036310 i I 0-Jan-00  Jen-00 Mo PSNDF VR Product Neme Intry (Five leading zeros)

IV Detail 7623 VANCOMYCIN SO0MG in DSW 100ML ADD-A-VIAL i B-Feb-00 42 0-Jan-00  Jen-00 Ne PSNDF VA Product Neme Entry or National Drug Cede (NDC)
IV Detail 952 FENTANYL Z500MCG/NS Z50ML i 3-Jan-00 3 0-Jan-00  Jen-00 No PSNDF VA Product Neme Entry or National Drug Cede (NDC)

4.3.1.6.2.3 UDP Extracts Incomplete Feeder Key Report
Choose the report you would like to run.
Select one of the following:
1 PRE
2 1VP
3 UDP
Selection: 1// 3 UDP

Enter the date range for which you would like to scan the Unit Dose Local
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)
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Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported UDP Extracts Incomplete Feeder Key Report

TYPE E:';IIIG‘I’ GEMERIC NAME FEEDER KEY ::CI‘:;:EEDF 2:_:_1“ g:llt-:rE lzgm ERROR

UnitDoselocal 6443 VALPROICACID 250MG/SMLUD CUPS 000000068094019362 10 56  0.4207 23.56 Mo PSNDF VA Product Name Entry [Five lea)

Unit Dose Local 7741  APREPITANT 125MG CAP,UD 000000000006046206 1 1 80.6317 B0.63 Mo PSNDF VA Product Name Entry (Five leading zeros)
Unit Dose local 8873  ALOH 200/MGCH 200/5IMTH 20/5ML 30ML CUP 000000000121176130 14 1186 11157 1327.36  NoPSNDFVAProduct Name Entr)

Example: UDP Extracts Incomplete Feeder Key Report Screen Print

Unit Dose Local Extract Inconplete Feeder Key Report Page: 2
Start Date: AAR 01, 2014

End Date: HAR 05, 2014 Report Run Date/Tine: AUG 21, 2014
Drug Generic Mane Feeder Rey # of Total lnit Total
Entry Recards  Quantity Price Cost

Mo Mational Drug Code [MOC) (Last 12 zeros, 'HAR', or "5° prefiul

1108 SILVER HITRATE nn33goonnoonnonnn 1 1 F31.8500 §31.85
4814 AETOPROLOL TARTRATE 12.5HG »< TAB iEsg100n0nonnonnn a4 174 s0.00849 §1.54
8848 CHLORTHALIDOME 12.50G =< TAB B2oFsoonnoonnonnn g 16 s0.0000 g0.00
8867 ATEMOLOL 12.5MG »< TRBE n433100n000000000 a 3 g0.0000 gn.on
8875 GLIPIZIDE 2.5MG »< TRB I4a1g0on0nonn0000 g 4 a0.0104 g0.04
9539 LITHIUA BAEQSSHL ORAL SOLM 2.5HL 5YR 2ai4znoannonnnnnn g 4 20,0506 gn.z2n

TOTAL §33.64

4.3.1.6.3 Pharmacy Extracts Unusual Cost Report

Users with the ECXMGR security key can export the data for all reports on the Pharmacy
Extracts Unusual Cost Report option into an external spreadsheet. Users also have the option to
view the report on the screen.
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This report prints a listing of unusual costs that would be
generated by the pharmacy extracts (PRE, IVP, UDP and BCM) as
determined by a user defined threshold value. It should be run
prior to the generation of the actual extract(s) to identify and
fix as necessary any costs determined to be erroneous.

Note: The threshold can be set after a report is selected.

Run times for this report will vary depending upon the size of
the extract and could take as long as 30 minutes or more to
complete. This report has no effect on the actual extracts and
can be run as needed.

The report is sorted by Feeder Key, Descending Cost, and SSN.

Enter RETURN to continue or *"~" to exit:

Example: Pharmacy Extracts Unusual Cost Report
Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UDP
4 BCM

Selection: 1//

4.3.1.6.3.1 PRE Unusual Cost Report

The default threshold cost for the Prescription extract is $50.
Would you like to change the threshold? NO// n NO

Enter the date range for which you would like to scan the Prescription
Extract records.

Starting with Date: 2/1/12 (FEB 01, 2012)

Ending with Date: 2/28/12 (FEB 28, 2012)

Do you want the output in exportable format? NO// YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
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displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported PRE Unusual Cost Report

MAME | S5M DAY GENERIC MAME FEEDER KEY QUANTITY | TOTALCOST | DAYS SUPPLY

PATL FOOERENEE | 02711 | CALCIPOTRIEMEQ.005% TOP CREAM 11942066993087 761 240 GM 5531.6480 30

PAT2 REEREXEE | 02/15 | RILUZOLES0MG TAB 12472000075770060 180 TAB 51,752.1740 | 90

PAT3 MEEKEXEE | 0212 | CAPECITABINE S00MG TAB 12837000004110150 200 TAB 52,987.380 30

Example: PRE Unusual Cost Report Displayed on Screen

Prescription Extract Unusual Cost Report Page: 1
Start Date: FEB 01, 2013 Report Run Date/Time: MAY 17, 2013
End Date: FEE 15, 2013 Threshold Valus = $500

Name SEN Day Generic Name Feeder EKey ouantity Total Cost Days Supply
PAT1 EXEXEEEXE 0z/11 CALCIPOTRIENE 0.005% TOP CRELM 11943066993087761 240 GH $531.6480 30
PATZ XEXXXEXEX 0z/15 RILUZOLE S50MG TAE 124730000757 70060 180 TAE §1,752.1740 a0
PAT3 HEEEEEEEE 0z/1z2 LAMIVUDINE 150MG/ZIDOVUDINE 300MG TAE 12790049702020218 &0 TALE §533.8820 30
PAT4 HEEEYEEEX 0z/1z CAPECITAEINE SO0OMG TAE 12837000004110150 Z00 TAE §2,987.3800 30
PATSl EXEXEEEXE oz/08 ENOXAPARIN 100MG/ML INJ SYRINGE 1ML 12933000545560500 60 SYRINGE $936.7200 30

4.3.1.6.3.2 IVP Unusual Cost Report

The default threshold cost for the IV Detail extract is $100.
Would you like to change the threshold? NO// n NO

Enter the date range for which you would like to scan the 1V Detail
Extract records.

Starting with Date: 2/1/13 (FEB 01, 2013)

Ending with Date: 2/28/13 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g- 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
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Example: Exported VP Unusual Cost Report

MAME | 55N DAY GEMERIC MAME FEEDIER KEY TOTAL DOSES PER DAY | TOTAL COST
PAT1 bR E 02/06 | GEMCITABIMNE 200MG 10ML VIAL 12548000002750101 2150 MG 5853.3350
PATZ bR E 02705 | RITUXIMAB 10MG/ML INJ SOML 12847050242005206 900 MG 52,187 0000
Fﬁ.T3| AR EEEE 02/01 | SODIUM CHLORIDED.9%|N) BAG 1000ML | 145660002 38004004 2000 ML 51,983 4000
Example: IVP Unusual Cost Report Displayed on Screen
IV Detail Extract Unusual Cost Report Page: 1

Start Date: FEB 01, 2013 Report Run Date/Time: MAY 17, 2013

End Date: FEE 10, 2013 Threshold Value = §500

Narne 33N Day Generic Name Feeder Key Total Doses Total Cost
Per Day

PAT1 EEEXEEEXE oz/08 GEMCITAEINE ZOOMG 10ML VIAL 12545000002750101 2150 MG $853.3350

FPATZ EEEEEEXEE 0z/05 GEMCITABINE ZO00OMG 10ML VIAL 12548000002750101 1500 MG §595.3500

PAT3 EEEXEEEXE 0z/05 RITUZIMAE 10MG/ML INJ S0ML 12547050242005306 Q00 MG $2,187.0000

PAT4 EEEXEEEXE oz/01 RITUZIMAE 10MG/ML INJ SOML 12547050242005306 700 HG $1,701.0000

4.3.1.6.3.3 UDP Unusual Cost Report

The default threshold cost for the Unit Dose Local
Would you like to change the threshold? NO// n NO
Include S1G/0Order Direction on line 2 of report? NO// n

extract is $20.

NO

Enter the date range for which you would like to scan the Unit Dose Local
Extract records.

Starting with Date: 5/1/13 (MAY 01, 2013)

Ending with Date: 5/31/13 (MAY 31, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough

parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.
Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE: [In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported UDP Unusual Cost Report
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MAME | 55M DAY GEMERIC MAME FEEDER KEY CUANTITY | TOTAL COST
PATL AL OO 02/08 | PEGFILGRASTIM &MG/D.EML 15477055512019001 13¥R 51,854.7200
PAT2 AL OO 02/08 | NITROGLYCERINO.4MG SLTAB 25'5 20387000071041813 576 BT 51,2455200
PATZ AR 02/01 | NITROGLYCERINO.4MG SLTAB 25'5 20387000071041813 288 BT 5624.9600

Example: UDP Unusual Cost Report Displayed on Screen

Unit Dose Local Extract Thusual Cost Report Page: 1

Start Date: FEE 01, 2013 Feport Run Date/Time: MALY 17, 2013
End Date: FEE 10, 2013 Threshold Valus = §500

Narme 38N Day Generic Name Feeder EKey Quantity Total Cost
FPAT1 EEXXXEXEX 0z/08 PEGFILGRASTIM 6MG/0.6HML 15477055513019001 1 SYR §1,854.7200
PATZ TEEEEHERE 0z/08 NITROGLYCERIN 0O.4MG 3L TAE 25'3 20387000071041513 578 BT $1,249.9200
PAT3 TEEEEHERE 0z/01 NITROGLYCERIN 0O.4MG 3L TAE 25'3 20387000071041513 288 BT $624.9600

4.3.1.6.3.4 BCM Unusual Cost Report
Select one of the following:

1 v
N NON-1V

Select type of BCM record: n NON-I1V
The default threshold cost for the BCM-NON 1V Entries extract is $20.

Would you like to change the threshold? NO//
Include S1G/0rder Direction on line 2 of report? NO// y YES

NOTE: Users can choose to add the SIG/Order Directions on the second line of this report.

Enter the date range for which you would like to scan the BCM-NON IV Entries
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)

Ending with Date: 2/28 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen”™ tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.
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DEVICE: 0;225;99999//
Example: Exported BCM Unusual Cost Report (Non- 1V)

NAME S5N DAY GEMNERIC NAME FEEDER KEY COMPONENT TOTAL COST S1G
DOSE GIVEN

PATL COO0O0MO(K 02/14 ENOXAPARIN 100MG/ML INJ SYRINGE 1ML 12933000548560500 1SYRINGE $1,211.9000 100 MG/1ML NOW
PATZ COOOOMKKK 02/19 ENOXAPARIN 30MG/0.3ML INJ SYRINGE 0.3ML 12935000548560100 1 SYRINGE $107.8500 30 MG/0.3MLNOW
PATZ 0OCOOMO(C 02/01 INSULIN,GLARGINE, HUMAN 100 UNT/MLIN]  14476000088222033 1 VI $366.0800  QHS

Example: BCM Unusual Cost Report Displayed on Screen (1V)

BECM-IV Entries Extract Unusual Cost Report Page: 1
Start Date: FEE 01, 2013 Report Run Date/Time: MAY 17, 2013
End Date: FEE 05, 2013 Threshold Value = §500

Narme 53N Day Generic Name Feeder Eey Component Dose Given Total Cost
PAT1 XEXEEXXEX 0z/01 SODIUM CHLORIDE 0.9% INJ BAG 1000HML 14566000335004204 1000 ML §991.7000
PATZ XEEEEXXEX 0z/01 SODIUM CHLORIDE 0.9% INJ BAG 1000ML 14566000335004504 1000 ML §991.7000
PAT3 HEEEENNEY 0z/01 SODIOM CHLORIDE 0.9% INJ BAG 1000ML 14566000338004904 1000 ML $991.7000
PAT4 HEEXEEEEY oz/01 S0DIUM CHLORIDE 0.9% INJ EBAG 1000ML 14566000335004504 1000 ML $991.7000

4.3.1.6.4 Pharmacy Extracts Unusual Volume Report

This report prints a listing of unusual volumes that would be generated by the
pharmacy extracts (PRE, IVP, UDP and BCM) as determined by a user defined threshold
value. It should be run prior to the generation of the actual extract(s) to identify
and fix as necessary any volumes determined to be erroneous.

Unusual volumes are defined as follows:
PRE Extract: Quantity field greater than the threshold value.
IVP Extract: Total Doses Per Day field greater than the threshold
or less than the negative of the threshold value.
UDP Extract: Quantity field greater than threshold value.
BCM Extract: Component Dose Given field greater than threshold value.
Note: The threshold can be set after a report is selected.
Run times for this report will vary depending upon the size of the extract and could
take as long as 30 minutes or more to complete. This report has no effect on the
actual extracts and can be run as needed.
The report is sorted by Feeder Key, Descending Volume, and SSN.

Enter RETURN to continue or "~" to exit: <RET>

4.3.1.6.4.1 PRE Unusual Volume Report

Choose the report you would like to run.
Select one of the following:

PRE

1VP

UbP
BCM

AP WOWNPE

Selection: 1// 1 PRE
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The default threshold volume for the Prescription extract is 500.
Would you like to change the threshold?? NO//

Enter the date range for which you would like to scan the Prescription
Extract records.

Starting with Date: 02012013 (FEB 01, 2013)

Ending with Date: 02282013 (FEB 28, 2013)

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”

setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g- 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Export Prescription Extract Unusual Volume Report

DAYS
NAME S5M DAY GEMERIC NAME FEEDER KEY QUANTITY TOTAL COST SUPPLY
NUTRITIOMN SUPL
PATA WO | 02/08 ENSURE/VANILLA PWD 10222070074060750 16674 GM 5141.7790 90
NUTRITIOMN SUPL
PATB WD | 02/05 ENSURE/VANILLA PWD 10222070074060750 9528 GM SE0.988D a4
NUTRITIOMN SUPL
PATC MM | 02/05 ENSURE/VANILLA PWD 10222070074060750 7200 GM S61.2000 30
Example: Prescription Extract Unusual Volume Report Displayed on Screen
Prescription Extract Unusual Volume Report
Page: 1
Start Date: JAN 01, 2002
Report Run Date/Time: JAN 02, 2003
End Date: JAN 31, 2002
Threshold Value = 500
Name SSN Day Generic Name
Feeder Key Quantity Total Cost Days Supply
DSS1 XXXXXXXXX 03706 NUTRITION SUPL ENSURE/VANILLA PWD
10222070074607504 7560 $37.80 30
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DSS2

DSS3

XXXXXXXXX
10222070074607504

XXXXXXXXX
10222070074607504

03710 NUTRITION SUPL ENSURE/VANILLA PWD

7140 $35.70

03706 NUTRITION SUPL ENSURE/VANILLA PWD

5460 $27.30

4.3.1.6.4.2 IVP Unusual Volume Report

Choose the report you would like to run.

Selection:

The default threshold volume for the
Would you like to change the threshold? NO// n

A WOWNPE

17/ 2

Select one of the following:

PRE
1VP
UbP
BCM

1VP

30

90

1V Detail extract is 1000.

NO

Enter the date range for which you would like to scan the 1V Detail
Extract records.
Starting with Date: 02012013 (FEB 01, 2013)
Ending with Date: 02282013 (FEB 28, 2013)

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.
2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”

setting to at least 225 characters.
3. The DEVICE input for the columns should also contain a large enough

parameter (e.g. 225).

You may change it if need be.
Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width
and 99999 is the screen length.

NOTE:

when importing the data into the spreadsheet.

In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text

DEVICE: 0;225;99999//

Example: Exported IV Detail Extract Unusual Volume Report

The DEVICE prompt is defaulted to 0;225;9999 for you.

TOTAL DOSES
NAME | ssh DAY GEMERIC NAME FEEDER KEY PER DAY TOTAL COST
pATA | wooo0oo | 02/06 | GEMCITABINE 200MG 10ML VIAL 12548000002750101 2150 MG 58533350
PATE | ®xwmexxdx | 02/01 | DEXTROSE 53 INJ BAG 1000ML 145500003 35001704 2000 ML $134.0000
PATC | wxwxowxxx | 02/01 | SODIUMCHLORIDE0.9%IN) BAG 1000ML | 14566000335004904 2000 ML 51,983 4000
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NOTE: The Total Cost Per Day column displays 4 decimal places and is calculated by
multiplying the Average Drug Cost per Unit times Total Doses per Day.

Example: IV Detail Extract Unusual Volume Report

1V Detail Extract Unusual Volume Report
Page: 1
Start Date: FEB 01, 2012
Report Run Date/Time: MAY 29, 2012
End Date: FEB 29, 2012
Threshold Value = 20

Total Total
Name SSN Day Generic Name Feeder Key Doses Cost Per Day
DSS1 666551982 02/21  VINORELBINE 10MG/ML 12374000703418301 50 MG $6.0364
DSS2 000986514 02/28  VINORELBINE 10MG/ML 12374000703418301 50 MG $6.0364
DSS3 000762783 02/01  VINORELBINE 10MG/ML 12374000703418301 25 MG $6.0364
DSS4 666229182 02/08  VINORELBINE 10MG/ML 12374000703418301 25 MG $6.0364

4.3.1.6.4.3 UDP Unusual Volume Report

NOTE: Users can choose to add the SIG/Order Directions on the second line of this report.
SIG/Order Direction information is produced by combining Prescription Unit Dose and Schedule
information. This field will assist pharmacists that are responsible for audits to distinguish
dispensing errors.

Choose the report you would like to run.

Select one of the following:

1 PRE
2 1VP
3 UDP

Selection: 1// 3 UDP

The default threshold volume for the Unit Dose Local extract is 500.
Would you like to change the threshold? NO// Y YES

Quantity > threshold
Enter the new threshold volume: (0-100000): 20
Include SIG/Order Direction on line 2 of report? NO// YES

Enter the date range for which you would like to scan the Unit Dose Local
Extract records.

Starting with Date: February 1, 2012 (FEB 01, 2012)

Ending with Date: February 29, 2012 (FEB 29, 2012)

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
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To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g-. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported UDP Detail Extract Unusual Volume Report with SIG/Order
Directions Added

NAME 55N DAY GENERIC NAME FEEDER KEY QUANTITY TOTALCOST SIG
D551 HOOOOOO(K 02/03 GABAPENTIN 100MG CAP 11800000228266550 24 CAP 50.0024 200H
DS52 MOOOOGO(K 02/10 GABAPENTIN 100MG CAP 11800000228266550 24 CAP 50.0024 200H |
D553 OO0 02/17 GABAPENTIN 100MG CAP 11800000228266550 24 CAP 50.0024 200H

Example: UDP Detail Extract Unusual Volume Report with SIG/Order Directions Added
Displayed on Screen

Unit Dose Local Extract Unusual Volume Report
Page: 1

Start Date: FEB 01, 2012

Report Run Date/Time: MAY 24, 2012

End Date: FEB 29, 2012

Threshold Value = 20

Name SSN Day Generic Name Feeder Key Quantity Total
Cost

DSS1 000118721 02/03 GABAPENTIN 300MG CAP 11801000228266650 36 CAP $2.6712
SIG: 900 MG QID/FOOD

DSS2 000779855 02/01 GABAPENTIN 300MG CAP 11801000228266650 24 CAP $1.7808
SI1G: 900 MG QID/FOOD

DSS3 000912671  02/06 GABAPENTIN 300MG CAP  11801000228266650 24 CAP $1.9224
SI1G: 900 MG QID/FOOD

DSS4 000528727 02724 TRAMADOL 50MG TAB 12380016714011106 24 TAB $0.4224
SI1G: 100 MG QID

Example: Exported UDP Detail Extract Unusual Volume Report without SIG/Order
Directions Added
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MNAME 55N DAY GENERIC NAME FEEDER KEY QUANTITY TOTAL COST

PATL XXXXXXXXX 02/22 GABAPENTIN 300MG CAP 11801000228266600 864 BT 52.6712
PATZ ¥M]¥M)¥MX 02/22 GABAPENTIN 300MG CAP 11801000228266600 864 BT 52.6712
PAT3 Xx)XXXXxXX 02/08 GABAPENTIN 300MG CAP 11801000228266600 864 BT 52.6712

Example: UDP Detail Extract Unusual Volume Report without SIG/Order Directions
Added Displayed on Screen

Unit Dose Local Extract Unusual Volume Report
Page: 1

Start Date: FEB 01, 2012

Report Run Date/Time: MAY 24, 2012

End Date: FEB 29, 2012

Threshold Value = 20

Name SSN Day Generic Name Feeder Key Quantity Total
Cost

DSS1 000118721 02/03 GABAPENTIN 300MG CAP 11801000228266650 36 CAP $2.6712
DSS2 000779855 02/01 GABAPENTIN 300MG CAP  11801000228266650 24 CAP $1.7808
DSS3 000912671 02/06 GABAPENTIN 300MG CAP 11801000228266650 24 CAP $1.9224
DSS4 000528727 02724 TRAMADOL 50MG TAB 12380016714011106 24 TAB $0.4224

4.3.1.6.4.4 BCM Unusual Volume Report

Choose the report you would like to run.
Select one of the following:

PRE

1VP

UDP
BCM

P WNPF

Selection: 1// 4 BCM
Select one of the following:

| v
N NON-1V

Select type of BCM record: N

The default threshold volume for the BCM-NON IV Entries extract is 5.
Would you like to change the threshold? NO// n NO
Include S1G/0rder Direction on line 2 of report? NO// y YES

Enter the date range for which you would like to scan the BCM-NON 1V Entries
Extract records.

Starting with Date: 02012013 (FEB 01, 2013)

Ending with Date: 02282013 (FEB 28, 2013)

Do you want the output in exportable format? NO// N

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.
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Example: Exported BCM Detail Extract Unusual Volume Report with SIG/Order
Directions Added (Non-1V)

MAME S5M DAY GEMERIC MAME FEEDER KEY S‘:;"Ep{::E:T E‘;‘;L 516G

PATA A, 0z/01 CLOZAPINE [MYLAN]) 100MG TAB | 15368000378086001 | 6 TAB 50.0000 500 MG QHE
PATE e, 02/10 METHADOME 100G TAB U/D 00136000406577162 | 6 TAR 50.0000 DRAILY

PATC ERE R 02,/10 TRAZODOME HCL SOMG TAB 06132000602616032 | 6 TAB 50.0000 QHS

Example: BCM Detail Extract Unusual Volume Report with SIG/Order Directions Added
Displayed on Screen (Non-1V)

BCM-NON IV Entries Extract Unusual Volume Report

Start Date:

End Date:

PATL XXXXXXXXX 02701 CLOZAPINE (MYLAN) 100MG TAB 15368000378086005

SIG: 700 MG DALILY AT-1800

FEB 01, 2013

FEB 28, 2013

Report Run Date/Time:

Threshold Value = 5

Generic Name

Feeder Key

Page: 1

JUL 11, 2013

Component Dose Given

7 TAB

Total Cost

$2.9281

Example: Exported BCM Detail Extract Unusual Volume Report without SIG/Order
Directions Added (1V)

NAME 55N

DAY

PATL 0O000CKC 02/01
PAT2 OOOOEKXX 02/03

GENERIC NAME

SODIUM CHLORIDE 0.9% INJ BAG 1000ML
SODIUM CHLORIDE 0.9% INJ BAG 1000ML

FEEDER KEY

COMPONENT DOSE GIVEN TOTAL COST

14566000338004900 2000
14566000338004300 2000

1983.4000
1583.4000

Example: BCM Detail Extract Unusual Volume Report without SIG/Order Directions
Added Displayed on Screen (1V)

BCM-NON IV Entries Extract Unusual Volume Report

Start Date:

End Date:

FEB 01, 2013

FEB 28, 2013

Report Run Date/Time:

Threshold Value = 1000

Threshold Value = 1000

Day Generic Name

Feeder Key Component Dose Given

Page: 1

AUG 23, 2013

Total

PATL XXXXXXXXX 02/28 SODIUM CHLORIDE 0.9% INJ BAG 1000ML 14566000338004904 2000 $1,983.4000

4.3.1.6.5

UDP/IVP Source Audit Report

The Source Audit Reports provide a record count for each Division and Date combination
chosen. The reports pull information from the UDP and IVP Intermediate source files within the
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DSS name space: UNIT DOSE EXTRACT DATA file (#728.904) and the IV EXTRACT
DATA file (#728.113).

Example: UDP Source Audit Report

Select Maintenance Option: 22 UDP/IVP Source Audit Report
Select one of the following:
1 UDP
2 1VP

Select Source Audit Report: 1 UDP

Select division: ALL//

Enter Report Start Date: Oct 24, 2006// 04012006 (APR 01, 2006)
Enter Report End Date: Oct 24, 2006// 04302006 (APR 30, 2006)
Do you want the output in exportable format? NO//<RET>

DEVICE: HOME// ;132

UDP Source Audit Report

PAGE: 1
Run Date: Oct 24, 2006
Start Date: Apr 01, 2006
End Date: Apr 30, 2006
Division Date Record Count
442 Apr 01, 2006 6
442 Apr 02, 2006 11
442 Apr 03, 2006 387
442 Apr 04, 2006 388
UNKNOWN Apr 04, 2006 1
442 Apr 05, 2006 418
442 Apr 06, 2006 423
442 Apr 07, 2006 434
442 Apr 08, 2006 247
UNKNOWN Apr 08, 2006 14

Example: Exported UDP Source Audit Report

pIvIisiow  DATE RECORD COUNT

552 1-Mar-14 775
UMKNOWMN  1-Mar-14 34
552 2-Mar-14 519
UMEKNOWMN  2-Mar-14 45

Example: 1VP Source Audit Report

Select Maintenance Option: 22 UDP/IVP Source Audit Report
Select one of the following:
1 UDP
2 1VP

Select Source Audit Report: 2 [IVP

Select division: ALL//

Enter Report Start Date: Oct 24, 2006// 03012006 (MAR 01, 2006)
Enter Report End Date: Oct 24, 2006// 03302006 (MAR 30, 2006)
Do you want the output in exportable format? NO//<RET>
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DEVICE: HOME// ;132

IVP Source Audit Report PAGE: 1
Run Date: Oct 24, 2006

Start Date: Mar 01, 2006

End Date: Mar 30, 2006

Division Date Record Count
442 Mar 01, 2006 47
UNKNOWN Mar 01, 2006 17
442 Mar 02, 2006 32
442 Mar 03, 2006 21
442 Mar 04, 2006 17
442 Mar 05, 2006 29
442 Mar 06, 2006 40
442 Mar 07, 2006 63
UNKNOWN Mar 07, 2006 1
442 Mar 08, 2006 48
UNKNOWN Mar 08, 2006 3

Example: Exported IVP Source Audit Report

DIVISION DATE RECORD COUNT

552 1-Mar-14 78
UNKNOWN 1-Mar-14 1

552 2-Mar-14 85
UNKNOWN 2-Mar-14 g
4.3.1.7 Print Feeder Keys

Refer to Appendix A for information about feeder key transmission.

Use this option to print a list of feeder keys for a selected individual feeder system or a range of
feeder systems. For some feeder systems, you will be prompted to select the sort method (old or
new). All feeder systems prompt for a device. The output will vary slightly, depending on the
version of National Drug File (NDF) your site is running.

Example: Print Feeder Keys

Select Maintenance Option: Print Feeder Keys

Do you want the output in exportable format? NO//<RET>
Print list of Feeder Keys:

Select : 1. CLI
2. ECS
3. LAB
4. PHA
5. RAD
6
7

- SUR
. PRO
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Enter a list or range of numbers (1-7): 7

Feeder Key

A4230NC
A4265NC
A4301INC
A4364NC
A4465NC
A4466NC
A4500NC
A4556NC
A4557NC
A4565NC
A4565NV

Feeder Key List For Feeder System PRO Page:

Description

INFUS INSULIN PUMP NON NEEDL/New/COM
PARAFFIN/New/COM

IMPLANTABLE ACCESS SYST PERC/New/COM
ADHESIVE, LIQUID OR EQUAL/New/COM
NON-ELASTIC EXTREMITY BINDER/New/COM
ELASTIC GARMENT/COVERING/New/COM
BELOW KNEE SURGICAL STOCKING/New/COM
ELECTRODES, PAIR/New/COM

LEAD WIRES, PAIR/New/COM
SLINGS/New/COM

SLINGS/New/VA

Example: Exported Print Feeder Keys - PRO

FEEDER SYSTEM FEEDER KEY

FRO
FRC
FRC
PRO
PRO

4.3.1.8

feeder location within each feeder system. This report could be lengthy, so you might want to

A42B5NC
A4301NC
A43EINC
A43ETHC
AL44EENC

DESCRIFTION
PARAFFIN, New/COM
IMPLANTABLE ACCESS SYST PERC/ Mew/COM
DSTOMY CLAMP, REPLACEMENT/Mew/COM
OSTOMY BELT/Mew/COM

ELASTIC GARMENT/COVERING, New/COM

Print Feeder Locations
Use this option to print a list of feeder locations for all feeder systems. The output is sorted by

queue to print during non-peak hours. The only prompt is for a device.

Example: Print List of Feeder Locations

Select Maintenance Option: print
Print Feeder Keys
Print Feeder Locations

1
2

CHOOSE 1-2: 2 Print Feeder Locations

Print list of feeder locations.

Do you want the output in exportable format? NO//<RET>

DEVICE: HOME//

Feeder Location List For Feeder System PRO Page:

FEEDER LOCATION

552H02
552LAB
552NONL
5520RD

October 2014

DESCRIPTION

DAYTON Home Oxygen
DAYTON Prosthetics Lab
DAYTON Non Lab Location
DAYTON Ordering Location
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Example: Exported Print List of Feeder Locations

FEEDER SYSTEM |FEEDER LOCATIOMN DESCRIPTION

CLI 1102 D&Y AC AMOD

ECE 552-9& GERIATRICS ECS MD

VP IVPE ¥ Pharmacy-DOMICILIARY 552BU
LAB VIR WIROLOGY

PRE PRE4 Prescriptions-LIMA

FRO S552HO2 DAYTOMN Home Cwygen

RAD 552-1 G52-GEMERAL RADICLOGY

SUR ORWAS WARD-SURGERY TIME [SURGERY)
uop uppr1 Unit Dose Medications-DAYTON

(To save space, only a portion of the above reports and exports are shown)

4319 Prosthetics

Choosing the Prosthetics option from the Maintenance Menu will display the following sub-
menu and options.

Example: Prosthetics Menu Options

Select Prosthetics Option: ?

Cost by PSAS HCPC Report

Prosthetic Extracts Unusual Cost Report
Prosthetics (PRO) YTD HCPCS Report
Prosthetics (PRO) YTD Laboratory Report

A WNPE

4.3.1.9.1 Cost by PSAS HCPC Report

This menu option creates a report named Cost by PSAS HCPC REPORT. The Cost by PSAS
HCPC is a prosthetics report that includes expenditures for a given time frame.

Option Name File New/Modified
Cost by PSAS HCPC Report 660 New

The Cost by PSAS HCPC Report consists of the following fields:
e PSAS HCPC - DSS Field (#30)/VistA Field (#32) on PRO extract
e Description (Free text field of 64 characters)

e HCPC

e QTY

e Unit of issue
e Cost

e Grand Total

Select Prosthetics Option: Cost by PSAS HCPC Report
Enter Report Start Date: 2/1/13 (FEB 01, 2013)
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Enter Report Ending Date: (2/1/2013 - 8/26/2013): 2/28/13 (FEB 28, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999// HOME (CRT)

Example: Exported Cost by PSAS HCPC Report

PSASHCPC DESCRIPTION HCPC QTY | UNIT OFISSUE | COST
AS9D1 DELIVER PO# M35565 ADS00 | 1 JOB 168.92
V2100 SINGLEVISION ADS00 | 1 PAIR 33.50
V2020 FRAMIES ADS00 | 1 PAIR 21.00
V2795 TRANSITION 49900 | 1 PAIR 15.00

Example: Cost by PSAS HCPC Report Screen Print

Report for Jan 01, 2004 thru Jan 15, 2004

PSAS HCPC DESCRIPTION HCPC QTY Unit of Issue Cost
C1875 STENT L8699 1 EACH $ 2696.00
C1875 STENT L8699 1 EACH $ 2696.00
C1875 STENT L8699 1 EACH $ 2696.00
C2621 PACEMAKER L8699 1 EACH $ 5075.00
C2621 PACEMAKER L8699 1 EACH $ 4575.00
L3060 FOOT ARCH SUPP LONGITUD/META L3060 1 $ 22.00
L3060 FOOT ARCH SUPP LONGITUD/META L3060 1 $ 22.00
EO730 TENS FOUR LEAD EO730 1 $ 49.00
A4556 ELECTRODES A4556 5 $ 24.70
L3700 ELBOW ORTHOSES ELAS W STAYS L3700 1 $ 14.50
EO730 TENS FOUR LEAD EO730 1 $ 49.00
A4556 ELECTRODES A4556 4 $ 19.76
A9300 EXERCISE EQUIPMENT A9300 1 $ 38.50
A4556 ELECTRODES A4556 5 $ 2470
A4556 ELECTRODES A4556 5 $ 24.70
EOl1l16 CRUTCH UNDERARM EACH NO WOOD EOl16 1 $ 14.25
EO116 CRUTCH UNDERARM EACH NO WOOD EO116 1 $ 14.02
DL175 GLOVES, WHEELCHAIR K0108 1 $ 25.11
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A4670 AUTO BLOOD PRESSURE MONITOR A4670 1 $ 29.70

Grand Total $ 19805.00

4.3.1.9.2 Prosthetic Extracts Unusual Cost Report

Select Prosthetics Option: Prosthetic Extract Unusual Cost Report

This report prints a listing of unusual costs that would be
generated by the Prosthetic extract (PRO) as determined by a
user-defined threshold value. It should be run prior to the
generation of the actual extract(s) to identify and fix, as
necessary, any costs determined to be erroneous.

Unusual costs are those where the Cost of Transaction is
greater than the threshold value.

Note: The threshold can be set after a report is selected.

Run times for this report will vary depending upon the size of
the extract and could take as long as 30 minutes or more to
complete. This report has no effect on the actual extracts and
can be run as needed.

The report is sorted by Feeder Key, then by descending Cost of
Transaction and SSN.

Enter RETURN to continue or "~" to exit:

The default threshold cost for the Prosthetic extract is $500.00.
Would you like to change the threshold?? NO// n NO

Enter the date range for which you would like to scan the Prosthetic
Extract records.

Starting with Date: 2/1 (FEB 01, 2013)
Ending with Date: 2/8 (FEB 08, 2013)

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.
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DEVICE: 0;225;99999// HOME (CRT)

Example: Export Prosthetic Extracts Unusual Cost Report

NAME 55N DATE OF SERVICE PSAS HCPCS CODE FEEDER EEY QUANTITY COST OF TRANSACTION TRANSACTION TYPE
OO HOOEHNNNE 3/4/2014 25501 AS501NC 1 860 I
HEHE  oooonxn 3/4/2014 Re543 Re545NC z S5e3 I
HEHE  oooonxn 3/4/2014 Re543 Re545NC z S5e3 I
O 3/4/2014 26545 LE5439NC 2 563 I

Example: Prosthetic Extracts Unusual Cost Report Screen Print

Prosthetic Extract Unusual Cost Report Page: 1
Start Date: MAR 01, 2014 Report Run Date/Time: AUG 21, 2014
End Date: MAR 03, 2014 Threshold Value: 500
Date of PSAS Cost of Tran
Name SSN Service HCPCS CODE Feeder Key Quantity Transaction Type
XXXX XXXXXXXXX 03/04/14 A5501 A5501NC 1 $660.00 1
XXXX XXXXXXXXX 03/04/14 A6549 AB6549NC 2 $563.00 1
XXXX XXXXXXXXX 03/704/14 A6549 AB549NC 2 $563.00 1

4.3.1.9.3 Prosthetics (PRO) YTD HCPCS Report

The Prosthetics YTD HCPCS Report displays data from Prosthetics extracts from the beginning
of the fiscal year to the ending data of the last extract. Data from current or previous fiscal year
may be selected for the report. The report is divided into three sections: New (i.e., Initial,
Replacement or Spare items), Repairs, and Rentals.

Sites that are multidivisional prosthetics sites must specify the Primary Prosthetics Division for
the report. The user may then choose to generate a specific report for one division or a combined
report for all divisions. The report is sorted by PSAS HCPCS Code. A print device capable of
displaying a 132-character line is needed for output.

Setup for PRO Extract YTD HCPCS Report --

IT you belong to more than one Primary Division, you must
select a Primary Division for the report.
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NOTE: You will see the following prompt if you need to select a division:

Select Prosthetic Division: ?
Answer with INSTITUTION NAME, or *STATION NAME, or STATION NUMBER, or
OFFICIAL VA NAME, or CURRENT LOCATION
Do you want the entire INSTITUTION List? Y (Yes)
Choose from:

ALBANY 1SC NY VAMC 11000
HINES 1SC IL VAMC 14000
Select Prosthetic Division: ALBANY ISC VAMC 11000

You may select ONE or ALL of the following:

(1) 11000 ALBANY
(2) 11000B  TROY

Select 0(ne) or A(ID): ALL// ONE

Which one?: 2

Do you want the output in exportable format? NO// n NO
Select C(urrent) or P(revious) Fiscal Year: CURRENT// c¢ CURRENT

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999// HOME (CRT)

Please note: The PRO Extract YTD HCPCS Report requires 132 columns.
Select an appropriate device for output.

Example: Exported PRO Extract YTD HCPCS Report

REPORT anr TOTAL AVE amr TOTAL AVE am TOTAL | AVE ALL

TYPE PSASHCPCS COM COM COM VA VA VA LAB LAB LAB AVE

MNEW A4301 IMPLANTABLE ACCESS SYST | 7 3082 44029 [ O a 000 |0 a 0.00 44029

MEW A4556 ELECTRODES, PAIR 17 64.16 3.77 0 a 000 | 0 a 0.00 3.77

MEW A4557 LEAD WIRES, PAIR 3 0 0.00 0 a 000 | 0 a 0.00 0.00

MEW A4570 SPLINT 10 283.21 28.32 0 a 000 [ 0 a 0.00 28.32
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Example: PRO Extract YTD HCPCS Report Screen Print

Prosthetics (PRO) Extract YTO HCPCS Report
FY Date Range: OCT 11, 203 to AAR 3, 2014
Facility: ORYTON (552)

Run Date/Tine: AUG 21, 201481238

REPORT OF MEH PROSTHETICS ACTIVITIES (Initial, Replacenent, or Spare)

Le. §
-

0.00
0.00
0.00

Page 1

Oty. Total & Aue. &  fve. §

-Lab-  Lab-  -Lab- -All-

Oty.  Total & Ave. § Oty. Total & A
PSRS HCPCS ~Lotn- ~Con- ~COHR- - - -
fid265 PARAFFIN a9 1396 3974 ﬂ ﬂ
fi4301 THPLAMTRBLE ACCESS SYST PE B 3% ML ﬂ ﬂ
fid363 0STORY CLAP, REPLACEHENT 109 218 2. 00 ﬂ ﬂ
fd3g7 0STOMY BELT ! SRE I N ] 0 0

Prosthetics (PRO) Ewtract YTO HCPCS Report
F Date Range: OCT 01, 2013 to HAR 31, 2014
Facility:  DAYTON (552)

Run Date/Tine: AUG M, 2014812.3

REPORT OF REPAIR PROSTHETICS ACTIVITIES
Oty.  Total & Aee. & Oty Total § A
PSAS HCPCS =CoHH= =Codn- =(0HH - f- -lf-

0.0

i i o 38T
i i [Tt
i i 0o 2.1
[ [ [T ]
Page 1

Oty. Total & fee. & e, d

Lab-  -lab-  -Lab- -fll-

A503 DIABETIC SHOE W/ROLLER/ROC ] 6 B2
5504 DIABETIC SHOE NITH HEDGE z LA N
507 AODIFICATION DIRBETIC SHOE i Ef A
AB901 DELIVERY/SET UP/DISPENSIHG R T T

—_— = = =
—_— = = =

Prosthetics (PRO] Eutract YTO HCPCS Report
F Date Range: OCT 01, 2013 to HAR 31, 2014
Facility:  DAYTON (552)

Run Date/Tine: AUG 21, 20148123

REPORT OF REMTAL PROSTHETICS ACTIVITIES

0 0 .00 BL20
0 0 .00 1600
0 0 .00 5600
0 [ 000 18067
Page 1

Oty.  Tofal & fee. & fee. d

-Lab-  -lab-  -Lab- -fll-

! [ .o 4005

Oty.  Total & Aee. § Oty. Total & fue.
PSR HCPCS ~LobH= =Conn- ~(0HH- Jf- -
fd466 ELASTIC GARHEMT/COUERIHG 7 2l 40,05 [ 0
fRSEN KWEG PRES HOUMD THER ORSE 5 gon 1R 19.R0 [ 0

4.3.1.9.4 Prosthetics (PRO) YTD Laboratory Report

! [ .00 15.EN

The Prosthetics YTD Laboratory Report displays data from Prosthetics extracts from the
beginning of the fiscal year to the ending data of the last extract. It is intended for use by sites
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that have on-site prosthetics laboratories. Data from current or previous fiscal year may be
selected for the report. The report is divided into three sections: New (i.e., Initial, Replacement,
or Spare items), Repairs and Rentals. Sites that are multidivisional prosthetics sites must specify
the Primary Prosthetics Division for the report.

The report is sorted by PSAS HCPCS Code. It shows quantity and labor and material costs for
items within each PSAS HCPCS Code. Two sets of totals are displayed on each line: totals for
items produced for use at the local site and totals for items produced for other VA stations.

Select Prosthetics Option: Prosthetics (PRO) YTD Laboratory Report
Setup for PRO Extract YTD Laboratory Report --

I you belong to more than one Primary Division, you must
select a Primary Division for the report.

Select C(urrent) or P(revious) Fiscal Year: CURRENT// c CURRENT

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported PRO Extract YTD Laboratory Report

REPCRT PSAS HCPCS LOCAL LOCAL LOCAL MATERIAL LOCALAVE ALLOTHER  ALLOTHER  ALLOTHER ALL OTHER
TYPE ary LABOR COST  COST CosT amy LABOR COST MATERIAL COST AVECOST
NEW L1340 AFD MOLDED TO PATIENT PLAS 2 143 .47 76.00 108.74 4] 0.00 0.00 0.00

NEW L1360 AFD POS SOLID ANK PLASTIC 2 87.47 235.50 191.48 o 0.00 0.00 0.00

NEW L3000 FT INSERT UCB BERKELEY SHE 3 0.00 0.00 0.00 ] 0.00 0.00 0.00

Example: PRO Extract YTD Laboratory Report Screen Print
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Prosthetics (PRO) Eutract YTO Laboratory Report Paqe 1
FY Date Range: OCT 01, 2013 to HAR 3, 2014

Facility:  DAYTON (559)

Run Date/Tine: AUG 21, 2014814:50

REPORT OF WEW PROSTHETICS ACTIVITIES (Initial, Replacenent, or Spare)

Produced for Station #052 Produced for all other stations
PSAS HCPCS Oty. Labor &  Hat'l§  fue. § Oty.  Labor 5 fat'l s Fue. d
L2036 KAFD PLAS DOUB FREE KMEE H 1 i & 49,40 [ 0 0 0o
L3020 FOOT LOWGITUO/HETATARSAL S g 4R 1w [ 0 0 0o
L3221 ORTHOPEDTC HEMS SHOES OPTH 1 I [ 0.0 [ I I 0o
L5000 SHO THSERT W ARCH TOE FILL 1 3l 165 194.99 [ 0 0 0.0
Prosthetics (PRO) Eutract YD Laborataory Report Page 1
FY Date Range: OCT 01, 203 to HAR 31, 2014
Facility:  DAYTOM (552)
Run Date/Tine: AUG 21, 2014814:59
REPORT OF REPATR PROSTHETICS ACTIVITIES

Produced for Station #9552 Produced for all other stations
PSRS HCRCS Oty Labor & Hat'l§  Ave. § Oty. Labor &  Mat'l§  fue. §
L2220 DORST & PLAMTAR FLEX ASS/R 2 0 0 0. 0 0 0 0.0
L2350 FOOT PLATE AOLOED STIRRUP | 0 0 0. 0 0 0 0.0
L2415 KNEE JOINT CAH LOCK EACH J | 0 0 0. 0 0 0 0.0
L2452 KNEE LIFT LOOP DROP LOCK R | 0 0 0. 0 0 0 0.0

4.3.2.0 Setup for DSS Clinic Information

Choosing the Setup for DSS Clinic Information option from the Maintenance Menu will display
the following sub-menu and options.

Example: DSS Clinic Information Menu Options

Select Setup for DSS Clinic Information Option: ?

NATIONAL CLINIC CODES FOR DSS LIST

CREATE DSS CLINIC STOP CODE FILE

CLINICS AND DSS STOP CODES PRINT

ENTER/EDIT DSS STOP CODES FOR CLINICS
APPROVE REVIEWED DSS CLINIC WORKSHEET

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
DSS CLINIC & STOP CODES VALIDITY REPORT
CLINIC EDIT LOG REPORT

O~NOOA~WNPE
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NOTE: The “CLINIC EDIT LOG REPORT” requires the use of the SD SUPERVISOR
Security key.

43.2.0.1 National Clinic Codes for DSS List

Use this option to print a list of the national clinic codes with short descriptions from the NATIONAL
CLINIC file (#728.441). The only prompt is for a device. You might want to use the output generated by
this option as a reference guide when using the following options:

e Approve Reviewed DSS Clinic Worksheet
o Enter/Edit DSS Stop Codes For Clinics

e Clinics And DSS Stop Codes Print

e Create DSS Clinic Stop Code File

Example: National Clinic List

NATIONAL CLINIC LIST NOV 18,1997 13:54 PAGE 1
CODE SHORT DESCRIPTION

AETC Ambulatory Evaluation and Treatment Center

AFCC AFC Clinic

AGTO Agent Orange

AOTH A Other

ASOR Ambulatory Surgery Performed in an OR

ASOT Ambulatory Surgery Performed in Area Other than OR
ATEM A Team

BARA Bar 203-450 Audio

BOTH B Other

[This output has been abbreviated to save space.]

Example: Exported National Clinic List

CODE SHORT DESCRIPTION

4024 PROV AVD]1 402 TOGUS ME
4028 FROW B W1 402 TOGUS ME
402C FROW CWO1 402 TOGUS ME

4.3.2.0.2 Create DSS Clinic Stop Code File

e You can run this option at any time to add new clinics created by MAS.

e Running this option does not affect existing data in the CLINICS AND STOP CODES
file (#728.44). This file includes the RECORD LAST SYNCHED field that holds the last
date that the Create DSS Clinic Stop Code File option was run.

e |tis recommended that this option be run on a recurrent monthly basis. The suggested
time is prior to generating the Clinic Visit Extract.

Use this option to create local entries in the CLINICS AND STOP CODES file (#728.44).

Select Setup for DSS Clinic Information Option: 2 Create DSS Clinic Stop Code File

This option creates local entries in the DSS CLINIC AND STOP CODES
file (#728.44).
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The CREATE option last ran on 8/27/13.
Do you want to run the CREATE option? N// y YES
RUNNING CREATE . - . oo e i i e et e e e e e e e aecaaecaacacacaaacaaeaaaaaaaaaanannn

The CREATE option has completed on Aug 28, 2013@09:11:17.

Proceed to DSS Clinic and Stop Code Print menu? NO// y YES

This option produces a worksheet of (A) All Clinics, (C) Active, (D) Duplicate, (I)
Inactive, or only the (U) Unreviewed Clinics that are awaiting approval.

Clinics that were defined as "inactive" by MAS the last time the option
"Create DSS Clinic Stop Code File"™ was run will be indicated with an "*".

Choose (X) for exporting the CLINICS AND STOP CODES FILE to a text file for
spreadsheet use.

**REMINDER - The CREATE option last ran on 8/28/13.
IT the most recent clinic changes from the HOSPITAL LOCATION file #44
are desired, run the CREATE option before running a report.**

Select one of the following:

ALL CLINICS

ALL ACTIVE CLINICS

DUPLICATE CLINICS

ALL INACTIVE CLINICS

UNREVIEWED CLINICS

EXPORT TO TEXT FILE FOR SPREADSHEET USE

X C=0OO >

Enter A", "C", “D”, "I'', "U", or "X":

The software uses the following logic to create entries in the CLINICS AND STOP CODES file
(#728.44).

4.3.2.0.2.1 New Clinic Entries

The software searches the HOSPITAL LOCATION file (#44) for all clinics. It does not create
entries for clinics that are currently inactive.

New clinic entries are added to the CLINICS AND STOP CODES file (#728.44) with the
following field defaults.

Field # Field Name Default value
1 STOP CODE STOP CODE NUMBER field (#8) in the HOSPITAL LOCATION file
(#44)
2 CREDIT STOP CODE CREDIT STOP CODE field (#2503) in HOSPITAL LOCATION file
(#44)
3 DSS STOP CODE STOP CODE NUMBER field (#8) in HOSPITAL LOCATION file (#44)
4 DSS CREDIT STOP CREDIT STOP CODE field (#2503) in HOSPITAL LOCATION file
CODE (#44)
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5 ACTION TO SEND 1: SEND STOP CODE

4: SEND BOTH AS ONE RECORD WITH NATIONAL
CODE

5: SEND BOTH AS ONE RECORD WITHOUT NATIONAL
CODE

6: DO NOT SEND

4.3.2.1.0.2 Existing Clinic Entries

All preexisting clinics are checked against their counterparts in the HOSPITAL LOCATION file
(#44) to be sure that the STOP CODE field (#1) in the CLINICS AND STOP CODES file
(#728.44) matches the STOP CODE NUMBER field (#8) in the HOSPITAL LOCATION file
(#44). The same check is made on the CREDIT STOP CODE field (#2) to be sure that it matches
the CREDIT STOP CODE field (#2503) in the HOSPITAL LOCATION file (#44).

Any preexisting clinic that is currently marked as inactive in the HOSPITAL LOCATION file

(#44) is flagged as inactive in the CLINICS AND STOP CODES file (#728.44). This inactive

indicator will be displayed as an asterisk (*) beside the clinic name on the worksheet generated
by the Clinics and DSS Stop Codes Print option. Inactive clinics may still have valid past data

for DSS.

Any Stop Code changes to preexisting clinics will delete the “Last Approved” date in the
CLINICS AND STOP CODES file (#728.44). This will ensure that the edited clinics print out as
“unreviewed” the next time the clinic worksheet is generated using the Clinics and DSS Stop
Codes Print option.

4.3.2.0.3 Clinics and DSS Stop Codes Print

Use this option to produce the Worksheet for DSS Clinic Stops showing one of the following:
All DSS Clinic Stops

Active Clinic Stops

Duplicate Clinic Stops

Inactive Clinic Stops

Unreviewed Clinic Stops

A clinic will be reported as “unreviewed” if it is newly established or if there is a change to stop
code/credit stop or count/non-count clinic status or active/inactive clinic status.

The columns included on the spreadsheet are:
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IEN

Clinic

Stop Code

Credit Stop Code

DSS Stop Code

DSS Credit Stop Code
Action

Last Review Date
CHARA4 Code

Inact Date

React Date

Clinic Type

App Len

Div

App Type

Non Cnt

Occasion of Service (O0S)
OQOS Calling Pkg
Variable Length Appt
DSS Prod Dept

Columns listed in the Worksheet for DSS Clinic Stops printed from the screen include:

Last approved date

Print Date

Clinic (followed by * if inactive)
Stop Code

Credit Stop Code

DSS Stop Code

DSS Credit Stop Code

Action

CHARA4 Code

C/N

Column C / N, captures changes to a clinic’s Count / Non Count status. Values in the column
will be “C” for count or “N” for non-count on the printed report and “YES” and “NO” on the
exported report.

Only changes to the Stop Code and Credit Stop Code fields in the HOSPITAL LOCATION file
(#44) are noted.

The clinic name is truncated so that there is at least one space between the clinic name and stop
code columns.
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Clinics that are inactive have an asterisk “*” after the clinic name on the printed reports only. On
the exported reports, the date the clinic was inactivated is shown. (Note: if an inactive clinic was
reactivated the reactivation date is shown.)

Select Setup for DSS Clinic Information Option: 3 Clinics and DSS Stop Codes Print

This option produces a worksheet of (A) All Clinics, (C) Active, (D) Duplicate,
(1) Inactive, or only the (U) Unreviewed Clinics that are awaiting approval.

Clinics that were defined as "inactive" by MAS the last time the option
"Create DSS Clinic Stop Code File"™ was run will be indicated with an "*".

Choose (X) for exporting the CLINICS AND STOP CODES FILE to a text file for
spreadsheet use.

**REMINDER - The CREATE option last ran on 8/28/13.
1T the most recent clinic changes from the HOSPITAL LOCATION file #44
are desired, run the CREATE option before running a report.**

Select one of the following:

ALL CLINICS

ALL ACTIVE CLINICS

DUPLICATE CLINICS

ALL INACTIVE CLINICS

UNREVIEWED CLINICS

EXPORT TO TEXT FILE FOR SPREADSHEET USE

X C=0OO>X>

4.3.2.0.3.1 All Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP CREDIT DSS DSS ACTION CHAR4 C/N

CODE STOP STOP CREDIT CODE

CODE CODE STOP
( * - currently inactive) CODE
000 ADMIN SCHEDULING (NC) 674 674 1 N
OOO-EYE NON TREATMENT-X 407 485 407 485 4 NONC N
000-MH NON TREATMENT-X 674 674 1 N
0O00-NON TREATMENT-X 301 485 301 485 4 NONC N
3S D/C CLINIC DAYS-X 674 674 4 NONC N
DAY MH PRRC GRP SST* 583 117 583 117 5 C
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4.3.2.0.3.2 All Active Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP  CREDIT DSS  DSS ACTION  CHAR4 C/N
CODE  STOP STOP CREDIT CODE

CODE CODE STOP
( * - currently inactive) CODE
000 ADMIN SCHEDULING (NC) 674 674 1 N
OO0O-EYE NON TREATMENT-X 407 485 407 485 4 NONC N
000-MH NON TREATMENT-X 674 674 1 N
OO0O0-NON TREATMENT-X 301 485 301 485 4 STAT N
3S D/C CLINIC DAYS-X 674 674 4 NONC N
3S D/C CLINIC EVE-X 674 674 4 NONC N

4.3.2.0.3.3 Duplicate Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC NAME CLINIC DSS DSS CHAR4 CLINIC DIV
1EN STOP CREDIT CODE APPT
CODE STOP LENGTH
CODE

SICU 195 1

11CP SURG 359 1

NEW IMAGING LOCATION 611 1
N.PSYCHROOFTOP 616 1

RAD LOC #10 277 105 1

RAD LOC #11 286 105 1

4.3.2.0.3.4 All Inactive Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 1
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP CREDIT DSS DSS ACTION CHAR4 C/N
CODE STOP STOP CREDIT CODE

CODE CODE STOP
( * - currently inactive) CODE
ZZ1ST TUES SLEEP SC -X* 315 470 315 470 5 C
72723 HOUR OBSERVATION-X* 291 291 1 N
27320 DR N&FS OPT-X* 123 123 4 NONC N
October 2014 Decision Support System V. 3.0 User Manual

Patch ECX*3.0*149



ZZ3N N&FS OPT-X* 123 123 4 NONC N

4.3.2.0.3.5 Unreviewed Clinics Option

WORKSHEET FOR DSS CLINIC STOPS Page: 2
(last approved on 07/09/2013) Print Date:08/28/13
CLINIC STOP  CREDIT DSS  DSS ACTION  CHAR4 C/N
CODE  STOP STOP CREDIT CODE

CODE CODE STOP
( * - currently inactive) CODE
DAY MH PRP GROUP EDUCATIO 560 714 560 714 5 C
DAY PC XXXXXXXX 323 323 4 YYYY C
DAY POLYTRAUMA/CHIROPRACT 197 436 197 436 5 C

4.3.2.0.3.6 Export Clinic Review Report Option

Select Setup for DSS Clinic Information Option: Clinics and DSS Stop Codes Print

Choose (X) for exporting the CLINICS AND STOP CODES FILE to a text file for
spreadsheet use.

Select one of the following:

A ALL CLINICS

C ALL ACTIVE CLINICS

D DUPLICATE CLINICS

| ALL INACTIVE CLINICS

U UNREVIEWED CLINICS

X EXPORT TO TEXT FILE FOR SPREADSHEET USE

Enter "A™, "C", “D”, "I, "U", or "X": X
Select one of the following:

ALL CLINICS

ALL ACTIVE CLINICS
DUPLICATE CLINICS
ALL INACTIVE CLINICS
UNREVIEWED CLINICS

C=0O0O>

Enter A", "C", "D, "I", or "U": U

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width
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and 99999 is the screen length.

NOTE:

In order for all number fields, such as SSN and Feeder Key, to be

displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported All Clinics Spreadsheet

NOTE: For clinics that are inactive, the date that they were inactivated is listed. If an Inactive
Clinic was reactivated, the Reactivation Date has been listed.

Last 00s  Var Dss
Stop | Credit5top D55 Stop DSS Credit Approved CHAR4 Clinic App Non Calling Lensth Frod
IEN Clinic Code Code Code Stop Code  Action Date Code InactDate ReactDate Type Len Div AppType Cnt 005 Pkg Appt  Dept
1 ZZANKENEY,C [PA) A/C-X 301 117 301 117 6| 5/6/2014 4/27 /1992 CLINIC| 103 1 REGULAR NO
2 ZEMEU-X 315 117 315 117 6 CLINIC 10 1 NO
3 ZEPODIATRY-X 411 411 6 CLINIC| 15 1 REGULAR NO \J
4 DAY CRTHOPEDICE 408 408 1 1987 11/29/1989 CLINIC 15 1 REGULAR NO
Example: Exported All Active Clinics Spreadsheet
Last 008 Var Dss
Stop | Credit D55 5top  DES Credit Approved CHAR4 Clinic  App Non Calling Length Prod
IEN Clinic Code | Stop Code Code Stop Code  Action Date Code InactDate ReactDate Type Len Div AppType Cnt 005 Pkg Appt Dept
4 DAY ORTHOPEDICS 409 409 1 5/6/2014 8/27/1987 11/29/188% CLINIC 15 1 REGULAR MO
5 HEMALOGY PRINCIPAL CLINIC-X 301 485 301 485 4 014 NONC 11/19/1998 11/20/1998 CLINIC 10 1 REGULAR YES v
8 MH CLINIC [SRF) PRINCIFAL-X 550 550 4 014 NONC 1/22/1992 1/23/1992 CLINIC | 30 1 REGULAR YES i
13 OPHTHALMOLOGY PRINCIPAL-X 301 485 301 485 4 5/6/2014 NONC CLINIC ' 30 1 REGULAR YES v

Example: Exported Duplicate Clinics Spreadsheet

CLINIC MAME

CLIMICIEN | DES 5TOP CODE |DES CREDITSTOP CODE CHAR4 CODE CLIMIC APPOINTMENT LENGTH | DIVISION

ULTRASOUMND 2868 115 1
ZIMPORTED DAY US 5305 115 1
MRI [LOC) 4309 151 1
Z IMPORTED DAY MRI 5308 151 1
DAY NUCLEAR MEDICINE 273 103 20 1
DAY MUCLEAR MED PREFOLLOD 2411 109 30 1
Credit D5 DS3 Last o008 Var Dss
Stop Stop Stop Credit Approved CHAR4 Inact React Clinic App App Non Calling Length Prod
IEN Clinic Code Code Code Stop Code Aetion Date Code Date Date Type Len Div Type Cnt 005 Fkg Zppt Dept
1 ZZANFENEY,C (DR) A/C-X 301 117 301 117 & 5/8/2014 4/27/713832 CLINIC 10 1 REGULRR NO
2 ZZINEU-X 315 117 31s 117 & 5/8/2014 11/4/1931 CLINIC 10 1 Ho
3 ZZPODIATRY-X 411 411 & 5/8/2014 8/1/2005 CLINIC 15 1 REGULAR NO v
& ZZVIST-IMPAIBMENT SVC TEAM-X 407 407 & 5/8/2014 /272012 CLINIC &0 1 REGULAR NO
Credit DSS DSS Last 0os Var Dss
Stop Stop  Stop Credit Approved CHRR4 Inact Rezct Clinic 2pp Di App Nen Callin Length Prod
IEN Clinic Code Code Code Stop Code REotion Date Code Date Date Type Len v Type Cnt ©OOS g Pkg Eppt Dept
3507 RMBULRTORY SURGERY 401 117 401 117 4 NCONC 8/4/2010 8/5/2010 CLINIC 15 1 REGULAR YES v
4334 ZZDAY SCI TELEMED RT GENERAL-X 210 &30 210 €30 El 2/25/72011 CLINIC 30 1 REGULAR NO v
€037 ZZDAY MH VI CWI/TWE NON-X 570 570 1 PEER | 10/3/2012 CLINIC 30 1 REGULAR NO v
€933 DRY OPHTHAIMOLOGY CATRARACT 407 407 1 5/13/2014 CLINIC 20 1 REGULAR NO v
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4.3.2.0.4 Enter/Edit DSS Stop Codes for Clinics

Use this option to enter or edit the stop codes, credit stop codes and action to send codes
associated with each clinic for the DSS extract. Please note that these codes might be the same as
those associated with the clinic by MAS.

Stop codes (also known as DSS Identifiers) are assigned a restriction type of primary, secondary
or either.

e Primary types can only be used in the primary stop code position
e Secondary types can only be used in the secondary stop code position
e Either can be used in the primary or secondary stop code position

Stop codes that have a restriction type of primary or secondary will also have a restriction date to
track when the stop code is designated as a restricted stop code. Validity checks are performed to
restrict data entry to valid values only.

The option to select how the stop codes and/or credit codes are sent can be changed. The default
is set to SEND BOTH AS ONE RECORD WITH NATIONAL CODE. The example below
shows the options that are available.

Example: Action to Send Description and Menu Choices

ACTION TO SEND: SEND BOTH AS ONE RECORD WITH NATIONAL CODE
[l ??
This determines how alternate stop code and alternate credit stop
codes are combined to form a feeder key for this clinic.

Choose from:

1 SEND STOP CODE

4 SEND BOTH AS ONE RECORD WITH NATIONAL CODE

5 SEND BOTH AS ONE RECORD WITHOUT NATIONAL CODE
6 DO NOT SEND

Through prompts, there is the option the option to add or edit the National Code, DSS Unit
Identifier and DSS Product Department.

Example: Enter/Edit DSS Stop Codes for a Clinic

Select Setup for DSS Clinic Information Option: Enter/Edit DSS Stop Codes for Clinics
Select CLINICS AND STOP CODES CLINIC NAME: Ambulatory Surgery
EXISTING CLINIC FILE DATA: EXISTING DSS CLINIC FILE DATA:

STOP CODE : 401 DSS STOP CODE : 401
CREDIT STOP CODE :117 DSS CREDIT STOP CODE :117

DSS STOP CODE (3-digit code only): 401// GENERAL SURGERY 401
DSS CREDIT STOP CODE (3-digit code only): 117// NURSING (2ND ONLY) 117
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...Validity Checker Complete.

ACTION TO SEND: SEND BOTH AS ONE RECORD WITH NATIONAL CODE
//

NATIONAL CODE: NONC//

DSS UNIT IDENTIFIER:

DSS PRODUCT DEPARTMENT: ??
The nationally defined DSS Intermediate Department Number designated to
the patient care product being provided.

DSS PRODUCT DEPARTMENT: 123
4.3.2.0.5 Approve Reviewed DSS Clinic Worksheet

Use this option to approve all DSS Stop Codes and DSS Credit Stop Codes as defined in the
CLINICS AND STOP CODES file (#728.44) and to mark all currently existing entries in this
file as reviewed.

Example: Clinics and Stop Code File

This option allows you to mark the current clinic entries in the CLINICS AND
STOP CODES file (#728.44) as "reviewed". Those entries will then be omitted
from the list printed from the "Clinic and DSS Stop Codes Print" when you
choose to print only "unreviewed" clinics.

Are you ready to approve the reviewed information provided by the
"Clinic and DSS Stop Codes Print"? NO// Y YES

Requested Start Time: NOW// <RET> (DEC 06, 1996@10:28:25)

.. .approval queued

4.3.2.0.6 DSS Identifier Non-Conforming Clinics Report

Stop codes (also known as DSS Identifiers) are assigned a restriction type of primary, secondary
or either. Primary types can only be used in the primary stop code position; secondary types can
only be used in the secondary stop code position; and those with a type of either can be used in
the primary or secondary stop code position. Stop codes that have a restriction type of primary or
secondary will also have a restriction date to track when the stop code is designated as a
restricted stop code. Clinics are validated to insure that stop codes are in compliance with
restriction types.

The DSS Identifier Non-Conforming Clinics Report option is used to print or export a listing of
the clinics that do not conform to the stop code and Four Character Code (4CHAR) restriction
types. Clinics in the CLINICS AND STOP CODE file (#728.44) are also included on the report
when they contain the following:

e A stop code is inactive or has an inactive date in the future.

e A credit stop code is inactive or has an inactive date in the future.

e A DSS stop code is inactive or has an inactive date in the future.

e A DSS credit stop code is inactive or has an inactive date in the future.
o National Code Four Character is inactive
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NOTE: National Clinic Four Character code cannot be added, deleted, or modified by users.

You may choose to print or export the report for active clinics, inactive clinics, or both. The
report will list the IEN number, clinic name, primary stop code, secondary stop code, DSS
primary stop code, DSS secondary stop code, 4CHAR National Code, and the reason for non-
conformance.

If all the selected clinics conform to the stop code and Four Character Codes restriction types,
"No problem clinics found™ is displayed on the report. If necessary, you may use the Enter/Edit
DSS Stop Codes for Clinics option to make corrections to the problem clinics.

This option reviews the Primary and Secondary Stop Codes and any existing Four
Character Codes in the Clinics and Stop Codes file #728.44.

It produces a report highlighting any nonconformance reasons that pertain

to the Primary and Secondary Codes, or the Four Character Codes if present.
Please contact the responsible party for corrective action.

4.3.2.0.6.1 DSS ldentifier Non-Conforming Active Clinics

Select one of the following:

A Active Clinics
| Inactive Clinics
B Both

Select Report: a Active Clinics
Please be patient, this may take a few moments...

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns*
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported DSS Identifier Non-Conforming Clinics Report — Active
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CREDIT D55 D55

STOP S5TCPE 5TOP CREDIT CH2R4 RERSCH FOR HOH-
IEN CLINIC HAME CODE CODE CODE 5TOP CODE |CODE CONFORMANCE

3 PSYCHOLOGY g5 g5 85 Code is inactiwve
10 DEMO 101 117 101 117 101 Code is inactiwve
42 NEWCLIN 101 101 101 Code is inactiwve
45 JOELTEST a8 a8 98 Code is inactiwve
53 TESTee =11 =11 ge Code is inactiwve
54 TEST77 =11 =11 ge Code is inactiwve
55 TESTEE =11 =11 ge Code is inactiwve

Example: Screen Print of DSS Identifier Non-Conforming Clinics Report - Active
AUG 12, 2014@10:44:15 Page: 1

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
Active Clinics

CLINICS AND STOP CODES File (#728.44) - (Use "Enter/Edit DSS Stop Codes for
Clinics™ [ECXSCEDIT] menu option to make corrections)

IEN #  CLINIC NAME STOP CREDIT DSS STOP DSS CREDIT CHAR4 REASON FOR NON-

CODE STOP CODE CODE STOP CODE CODE CONFORMANCE
3 PSYCHOLOGY 85 85 85 Code is inactive
10 DEMO 101 117 101 117 101 Code is inactive
42 NEWCL IN 101 101 101 Code is inactive

4.3.2.0.6.2 DSS ldentifier Non-Conforming Inactive Clinics

Select one of the following:

A Active Clinics
1 Inactive Clinics
B Both

Select Report: i Inactive Clinics
Please be patient, this may take a few moments...

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
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displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
Example: Exported DSS Identifier Non-Conforming Clinics Report — Inactive

CREDIT D55 DSs

STCF STICE STOF CREDIT CHAR4 RERSCN FOR MNOMN-
IEN CLINIC NAME CODE CODE CODE | STOP CODE |CODE CONFORMANCE

85| *RICH a5 35 85 Code is inactive
225| *TEST 555 Mizzing primary code
225| *TEST 555 No D55 primary code
232|*INACT FUTURE 117 117 117 Cannot be primary
233|*INACT CURRENT 117 117 117 Cannot be primary
235| *INACT CURRENT/REACT 117 117 117 Cannot be primary

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.

Example: Screen Print of DSS Identifier Non-Conforming Clinics Report - Inactive

AUG 12, 2014@10:57:37 Page: 1

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
Inactive Clinics

CLINICS AND STOP CODES File (#728.44) - (Use "Enter/Edit DSS Stop Codes for
Clinics"™ [ECXSCEDIT] menu option to make corrections)

IEN #  CLINIC NAME STOP  CREDIT DSS STOP DSS CREDIT CHAR4 REASON FOR NON-

CODE  STOP CODE CODE STOP CODE CODE CONFORMANCE
85 *RICH 85 85 85 Code 1is inhactive
225 *TEST 555 Missing primary code
225 *TEST 555 No DSS primary code
232 *INACT FUTURE 117 117 117 Cannot be primary
233 *INACT CURRENT 117 117 117 Cannot be primary

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.

4.3.2.0.6.3 DSS Identifier Non-Conforming Both Active and Inactive Clinics

Select one of the following:

A Active Clinics
1 Inactive Clinics
B Both

Select Report: b Both
Please be patient, this may take a few moments...

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.
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Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;99999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: 1In order for all number Ffields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//
Example: Exported DSS Identifier Non-Conforming Clinics Report — Both Active and Inactive

CREDIT D55 D55

5TOP STOP 5TOP CREDIT CHhR4 RERSON FOR MOM-
IEN CLINIC HMAME CODE CODE CODE 5TOP CODE |CODE CONFORMAMCE
3| PEYCHOLOY a5 a5 85 Code is inactive
10) DEMO 101 117 101 117 101 Code is inactive
42 NEWCLIN 101 101 101 Code is inactive
45| JOELTEST g3 g3 88 Code is inactive
53| TESTGE 26 26 86 Code is inactive
54| TEST?T 26 26 86 Code is inactive

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.

Example: Screen Print of DSS Identifier Non-Conforming Clinics Report - Both Active and
Inactive
AUG 12, 2014@11:05:15 Page: 1

DSS IDENTIFIER NON-CONFORMING CLINICS REPORT
All Clinics

CLINICS AND STOP CODES File (#728.44) - (Use "Enter/Edit DSS Stop Codes for
Clinics™ [ECXSCEDIT] menu option to make corrections)

IEN # (*currently inactive) STOP CREDIT DSS STOP DSS CREDIT CHAR4 REASON FOR NON-

CODE STOP CODE CODE STOP CODE CODE CONFORMANCE
3 PSYCHOLOGY 85 85 85 Code is inactive
10 DEMO 101 117 101 117 101 Code is inactive
42 NEWCL IN 101 101 101 Code is inactive
45 JOELTEST 98 98 98 Code is inactive
53 TEST66 86 86 86 Code is inactive

NOTE: The Asterisk (*) before the clinic name denotes an Inactive Clinic.
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4.3.2.0.7 DSS Clinic & Stop Codes Validity Report

The DSS Clinic & Stop Codes Validity Report is used to identify clinic setups that have become
invalid due changes that have occurred with stop codes or credit stop codes subsequent to initial
clinic setup.

The clinic’s stop codes must be active, valid, and conform to the restriction types. If any of the
following six conditions are not met, the clinic will be listed on the report with a descriptive
message explaining what needs to be updated.

e Must be active

e Must be three numeric characters in length and be valid
e Must be in the correct position for the restriction type

e Must not have matching codes

e Must not have an inactive date in the future

e Must not have an inactive 4CHAR National Code

NOTE: National Clinic Four-Character cannot be added, deleted, or modified by users.

Example: Exported DSS Clinic and Stop Codes Validity Report

Select Setup for DSS Clinic Information Option: DSS Clinic & Stop Codes Validity
Report

This report will display stop code information of the ACTIVE
clinics in the Clinics and Stop Code file (#728.44). 1t will
display stop codes that do not conform to the Business Rules for
Valid Stop Codes.

Do you want the output in exportable format? NO// y YES
Gathering data for export...

To ensure all data is captured during the export:

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number Ffields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.
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DEVICE: 0;225;99999//

IE CLINIC STOF CREDI DS5 |DSS CHRR4 ERRCR 1 ERROR 2 ERROR 3
N | HAME CODE |T STOF CREDIT CODE
STCF CODE S5TOF
CODE CODE
3 PSYCHOLO B85 B85 B85 is an Inactiwve |B5 is an Inactiwve
=Y Stop Code D55 Stop Code
10 DEMO 101 117 101 117 101 is &n 101 This stop 101 is an
Inactive Stop code can only be Inactive D55
Code used in the Stop Code
secondary
position.
4Z MEWCLIN 101 101 101 is &n 101 This stop 101 is an
Inactive Stop code can only be Inactiwve D55
Code used in the Stop Code
secondary
position.

Example: DSS Clinic and Stop Codes Validity Report

Select Setup for DSS Clinic Information Option: DSS Clinic & Stop Codes Validity
Report

This report will display stop code information of the ACTIVE
clinics in the Clinics and Stop Code file (#728.44). It will
display stop codes that do not conform to the Business Rules for
Valid Stop Codes.

DEVICE: HOME//
DSS CLINIC & STOP CODES VALIDITY REPORT Page: 1

IEN# CLINIC NAME STOP CREDIT DSS DSS CHAR4
CODE STOP STOP CREDIT CODE
CODE CODE CODE STOP
CODE

1177 DAY FLU SHOT 323 710 323 710 BTEM
ERRORS:
BTEM CHAR4 Code is inactive, please change to an active code.

1921 PCT_G PRINCIPAL-X 323 323 BTEM
ERRORS:
BTEM CHAR4 Code is inactive, please change to an active code.

64 AUDIOLOGY 203 211 110
ERRORS:

110 is an Inactive DSS Credit Stop Code
9999 CHAR4 Code is invalid, please change to a legal value.

3 PROBLEM CLINICS FOUND.

Example: Exported DSS Clinic and Stop Codes Validity Report
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IEN  CLINIC NAME 5TOP CREDIT DSS DSS CREDIT CHAR4 ERROR 1 ERRCR 2 ERROR 3 WARNING
CODE STOF STOP STIOP CODE CODE

1428 NUCLEAR MEDICINE 109 o Cofaﬁ 3131 3151 CHAR4 Code is invelid, plesse change to = legal wvelue.
5309 Z IMPCRTED DAY NUC/MED 109 109 3131 3151 CHAR4 Code is invelid, plesse change to = legal wvelue.
7324 DAY HENRL TELEPHCNE 147 313 147 313 30zl 3021 CHRZR4 Code iz inwalid, plesse change to = legal wvalue.
7325 MID MH TELEHEALTH FAM SERV DS 502 832 50% 32 BEER PEER CHAR4 Code is inactive, plezse change to en active code.

4.3.2.0.8 Clinic Edit Log Report

This option prints a log of changes made to Clinic Locations. The user will select one of the following:
1 USER NAME
2 DATE CHANGED

Example: Clinic Edit log Report

CLINIC EDIT LOG

Page 1
Printed on Apr 17, 2010@08:28:56 for 3/1/10 to 3/30/10
USER NAME DATE/TIME CHANGED CLINIC IEN CLINIC NAME FIELD NAME
OLD VALUE
NEW VALUE
XXXXXXX, XXX MAR 1,2010 08:41 XXXX ZZDAYC&P MARSHALL
IN
ACTIVATE
MAR 01, 2010
XXXXXXX, XXX MAR 1,2010 08:44 XXXX ZZC&P MUNSEE-X
IN
ACTIVATE
MAR 01, 2010
Example: Exported Clinic Edit log Report
TUSER NAME DATE/TIME CHRNGED CLINIC IEN CLINIC MAME FIELD NaME OLD WVALUE NEW VALUE
ODOE DM ¥ MARR 15, 2014 11:32 4413 NUR MED 1 NAME NUR MED 1 HNUR
medical
HDOENE D ¥ MAR 15,2014 11:32 4413 NUR MED 1 INSTITUTICH DAYTON DRAYTON

4.3.2.1  Setup for Inpatient Census Information

Choosing the Setup for Inpatient Census Information option from the Maintenance Menu will
display the following sub-menu and options.

Example: Patient Census Information Menu Options

Select Setup for Patient Census Information Option: ?

Trial for Setup Extract

Generate the Inpatient Setup Extract
Active MAS Wards for Fiscal Year Print
Primary Care Team Print

A WOWNPE

4.3.2.1.1 Trial for Setup Extract
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Use this option to generate a printed report of the inpatient population on a selected date. The
report is sorted by inpatient ward. Within each ward, the data is sorted by patient name, SSN and
admit date. You can compare this report to reports from MAS to eliminate any problems in the
ADMISSION SETUP EXTRACT file (#727.82).

Example: Inpatient Population Report on a Selected Date

WARNING:
This is very resource intensive and should be queued to run at slack time.

This option will print the admission data and data for the last

transfer and treating specialty change for all patients who

were in the hospital on the day you select.

NOTE - This will generate a report of your inpatient population on the
BEGINNING of the day you select, not the end of the day as MAS reports do.
For example, for this report, if you choose October 1, 1994, the report will
start at midnight at the beginning of the day. For the MAS report, you would
choose September 30, 1994. The MAS report begins at midnight at the end

of the day.

Select the date : Dec 02, 1997// <RET>

This report must be queued to a 132-column printer.

DEVICE: HOME// QUEUE TO PRINT ON

Requested Start Time: NOW// <RET> (DEC 03, 1997@13:12:55)

INPATIENT WARD LIST (DSS) FOR Dec 02, 1997 FOR WARD 3E NORTH

PATIENT SSN ADMIT DATE

DSSPATIENT,ONE 000456789 Sep 02, 1997
DSSPATIENT,TWO 666456789 Apr 18, 1995
DSSPATIENT, THREE 666987654 Nov 01, 1997

4.3.2.1.2 Generate the Inpatient Setup Extract

Your site should run this option only if your site has never sent any DSS Extract data to AITC to
initialize the setup extract files listed below. Once this is accomplished, the option should not be
used again.

Use this option to generate the Inpatient Setup Extract, which creates the hospital population for
the selected DSS start date. This data is stored in the following files until it is transmitted to
AITC.

ADMISSION SETUP EXTRACT file (#727.82)
PHYSICAL MOVEMENT SETUP EXTRACT file (#727.821)
TREATING SPECIALTY CHANGE SETUP EXTRACT file (#727.822)

Example: Inpatient Setup Extract

WARNING
This is very resource intensive and should be queued to run at slack time.
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This option will extract the admission data and data for the last
transfer and treating specialty change for all patients who
were in the hospital on the day you select.

NOTE - This will generate a snapshot of your inpatient population on the

BEGINNING of the day you select, not the end of the day as MAS reports do. For
example, for the inpatient setup extract if you choose October 1, 1994, the report
will start at midnight at the beginning of the day. For the MAS report, you would
choose September 30, 1994. The MAS report begins at midnight at the end of the day.

Select the starting date : Oct 01, 1996// <RET> (OCT 01, 1996)
Requested Start Time: NOW// <RET> (DEC 17, 1996@09:43:16)

4.3.2.1.3 Active MAS Wards for Fiscal Year Print

This option is intended to provide help for building wards in the commercial database at AITC.

Use this option to print a list of all MAS wards that were active at any time during the current
fiscal year. The only prompt is for a device. The output is formatted for 132 columns. It is sorted
by Medical Center Division and displays the following information:

e Pointer to the HOSPITAL LOCATION file (#44)
e Service and specialty associated with the ward in the WARD LOCATION file (#42)
e DSS Department code associated with the ward in the DSS WARD file (#727.4)

Example: Active MAS Inpatient Census Information

Abbreviated Sample Output

Active Wards for FY1998
Printed on SEP 28,1998@14:42

DSS Pointer Ward Ward
WARD Department to File #44 Service Specialty
DIVISION: ALBANY
2 WEST 192 MEDICINE GENERAL (ACUTE MEDICINE)
3E NORTH 129 INTERMEDIATE MED INTERMEDIATE MEDICIN
3E SOUTH 219 SURGERY SURGICAL ICU
5 WEST PS 66 PSYCHIATRY LONG TERM PSYCHIATRY(>45 DAYS)
7A GEN MED UEK1 158 MEDICINE GENERAL(ACUTE MEDICINE)
[Svc: NURSING Prod. Unit: WARD GENERAL MEDICINE/ACUTE
MEDICINE 1
DOMICILLARY 16 DOMICILIARY DOMICILIARY
NHCU 14 NHCU NHCU
OBSERVATION 234 NON-COUNT NON-DOD BEDS IN VA FACILITY
DIVISION: TROY
3 NORTH GU 6 MEDICINE GASTROENTEROLOGY
3 NORTH SURG UF12 5 SURGERY ORTHOPEDIC

[Svc: NURSING Prod. Unit: WARDS - SURGERY 1 Div: TROY/500B]

7B MED UEK2 81 MEDICINE CARDIOLOGY
[Svc: NURSING Prod. Unit: WARD GENERAL MEDICINE/ACUTE MEDICINE 1 Div: TROY/5008B]
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Example: Exported Active MAS Inpatient Census Information

DIVISICH WRRD D55 LDEPT PBOINTER TO WERD WARD SPECIALTY
FILE 44 SERVICE

ALEB-PRRTP 7C MED LBCD 197 MEDICINE GENERRL (2CUTE
MEDICINE)

ALEB-PRRTP PRETP-DOM 493 DOMICILIARY PS¥CH RESID REHREB
TEMT DROE

ALBLNY 11 415 MEDICINE MEDICAL ICU

ALBLNY 44 4559 GENERRL SURGERY

4.3.2.1.4 Primary Care Team Print

Use this option to print a list of all primary care teams. The list is sorted alphabetically by team
name and displays the pointer to the TEAM file (#404.51). The intent of this option is to provide
help for building primary care teams on the commercial DSS system.

Example: Primary Care Team Print

This option prints a list of all Primary Care Teams. The list is sorted
alphabetically by TEAM name and displays the pointer to the TEAM file (#404.51).

The right margin for this report is 80.

DEVICE: HOME//
DEVICE: HOME// RIGHT MARGIN 80// <RET>

Requested Start Time: NOW// <RET> (DEC 08, 1997@13:16:22)

Primary Care Teams NOV 25,1997 10:22 PAGE 1
TEAM FILE

TEAM NAME POINTER

SAMPLE TEAM 1

Example: Exported Primary Care Team Print

TEAM MNEME TEAM FILE POINIER
CAYTCH +HBPC* TEAMLET =1
INDIANE BCMM COORD 1 1&
INDIANA, RICHMCOHD 1z
ALBANY 44

4.3.2.2  Setup for Inpatient Medications Information

Choosing the Setup for Inpatient Medications Information option from the Maintenance Menu
will display the following sub-menu and options.
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Example: Inpatient Medications Information Option

Select Setup for Inpatient Medications Information Option: ?

1 Print 1V Room Worksheet
2 Enter/Edit 1V Room Division
3 Pharmacy NDC Lookup

4.3.2.2.1 Print IV Room Worksheet

Use this option to print a worksheet listing all the entries in the IV ROOM file (#59.5) of the
Inpatient Medications package. This worksheet is intended to be used by the DSS Manager to
define the DIVISION (as a pointer to the MEDICAL CENTER DIVISION file [#40.8]) for each
IV room for DSS purposes. The report can be displayed normally to the screen, or in exported
format.

Example: IV Room Worksheet

This option will produce a worksheet listing all entries in the IV Room file
(#59.5). It should be used to help DSS and Pharmacy services define and
review the DIVISION assignments for each 1V Room.

Do you want the output in exportable format? NO// NO
DEVICE: HOME// HOME (CRT)

1V Room Worksheet Page: 1
Printed Aug 21, 2014

1V ROOM DIVISION INACTIVE DATE

A DAYTON

Example: Exported IV Room Worksheet
IV ROOM DIVISION INACTIVE DATE
-1 DARYTON

4.3.2.2.2 Enter/Edit IV Room Division

Use this option to create or edit entries in the DIVISION field (#.02) of the IV ROOM file
(#59.5). The purpose of the DIVISION field is to provide a way to tie outpatient 1V data to a
medical center division for DSS purposes.

Example: Option for Editing Room Division

This option allows editing of the DIVISION field for IV Rooms.

Select 1V ROOM NAME: 1WEST
DIVISION: ALBANY 500

Select 1V ROOM NAME: <RET>
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4.3.2.2.3 Pharmacy NDC Lookup
Refer to Appendix A for information about feeder key transmission.

Use this option to perform lookups on the local DRUG file (#50) for NDCs from DSS Pharmacy
Feeder Keys that have rejected because the first seven characters are zeros (e.g.,
"0000000051079014120™). This would occur when a pharmacy item has not been matched to the
National Drug File (NDF).

The software prompts you to enter the NDC (last twelve characters) from a rejected feeder key to
display the following information from the local DRUG file (#50) for any drug which has that
NDC.

e Local Generic Name

[ NDC

e Dispense Unit

e VA Classification

e Price Per Dispense Unit

The output will vary slightly, depending on the version of NDF running at your site, as indicated
in the following example:

Example: Pharmacy NDC Lookup

Your site is running NATIONAL DRUG FILE (NDF) v4.0.
If Pharmacy data is dated after September 30, 1998,
then PHA Feeder Keys are composed of 17 numeric characters.

Ex. "12006000003073531" where characters:

1-5 (12006) = pointer to VA PRODUCT NAME file (#50.68)
6-17 (000003073531) = NDC from the local DRUG file (#50)

IT Pharmacy data is dated prior to October 1, 1998,
then PHA Feeder Keys are composed of 19 numeric characters.
Ex. "0016006000003073531" where characters:

1-4 (0016)
5-7 (006)

pointer to the NATIONAL DRUG file (#50.6)
pointer to VA PRODUCT NAME subfile (#50.68)
of the NATIONAL DRUG file (#50.6)

NDC from the local DRUG file (#50)

8-19 (000003073531)

Enter RETURN to continue or "~" to exit: <RET>

This option will allow lookups on the local DRUG file (#50) using NDCs from DSS Pharmacy
Feeder Keys that have been rejected because the first five characters are zeros in a 17 character
Feeder Key. (Ex. "00000051079014120") OR the first seven characters are zeros in a 19
character Feeder Key. (Ex. "0000000051079014120")
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This would occur when a pharmacy item has not been matched to the National Drug File (NDF).

Enter the NDC (last twelve characters) from a rejected feeder key to display information from
the local DRUG file for any drug which has that NDC.

Example: Selecting a NDC

Enter 12 numeric characters at the prompt or <cr> to exit. <RET>

Select NDC: 000469065771 TACROLIMUS 5MG CAP IM600 (PROGRAF) DU=CAP
TACROLIMUS 5MG CAP

NDC: 00469-0657-71 VA Classification: IM600
Dispense Unit: CAP Price per Dispense Unit: 6.809

Enter 12 numeric characters at the prompt or <cr> to exit. <RET>
Select NDC: <RET>

4.3.2.3 Surgery

Choosing the Surgery option from the Maintenance Menu will display the following sub-menu
and options.

Example: Surgery Menu Options

Select Surgery Option: ?
1 SUR Volume Report
2 Surgery Extracts Unusual Volume Report

4.3.2.3.1 SUR Volume Report

This menu option creates a report that lists all surgical cases that would be generated to the
Surgery Extract for transmission to the AITC for review.

Example: SUR Volume Report

SUR Volume Report Page: 1
Start Date: JAN 01, 2004 Report Run Date/Time: DEC 15, 2004
End Date: JAN 15, 2004
Case Encounter Pt. Operation Anesthesia PACU OR Clean
Name SSN Day Number Number Time Time Time Time Time
Pt Holding Principal Procedure
Time
DSS1 666755516 01/14/04 45175 50401571 41.0 37 42.0 ## ##
2.0 SMALL BOWEL RES
DSS2 666023326 01/08/04 45318 02384601 28.0 23 31.0 ## ##
4.0 AVR
DSS3 000204422 01/07/04 45420 22042011 26.0 19 27.0 ## ##t
#Ht 14-5 PLIF63047
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DSS4 000299215 01/09/04 46333 52199211 25.0 19 26.0 # #

4.0 AAA REPAIR

DSS5 666295035 01/05/04 45776 92903561 24.0 19 26.0 6.0 #
4.0 MITRAL VALVE RE

DSS6 000206081 01/13/04 47182 60809101 24.0 20 25.0 H# H#
12.0 TOTAL LEFT PNEU

DSS7 666641607 01/14/04 36137 16090411 23.0 19 24.0 H#H H#
4.0 RADICAL PANCREA

Example: Exported SUR Volume Report

PT ANEST [PATIE [OPERA OR CANC/

HOLDIN |HESIA [NT  [TION |PACU |CLEAN |ABOR |PRINCIPAL
NAME [ssN DAY CASE # |ENCOUNTER # GTIME [TIME [TIME |TIME [TIME |TIME [T PROCEDURE
XXXX  |XXXXXXXXX  [02/04/14 [72666 |XXXXXX136140204I 2.0 920 [70 |[a 11.0 |## TONSILLECTOMY
XXXX  |XXXXXXXXX  [02/04/14 [72624 |XXXXXX801140204I 2.0 # (80 |5 11.0 |## RIGHT TOTAL KNE
XXXX  |XXXXXXXXX  [02/05/14 [73079 |XXXXXX186140204I 3.0 920 [70 |[a 10.0 |## INSERTION IM NA
XXXX  |XXXXXXXXX  [02/03/14 [73060 |XXXXXX424140203I 2.0 80 [60 [4 10.0 |## REVISION RIGHT
XXXX  |XXXXXXXXX  [02/04/14 [72760 |XXXXXX662140203I 4.0 19.0 [17.0 [13  [100 |## TRANSRECTAL EXC

4.3.2.3.2 Surgery Extracts Unusual Volume Report

Surgery Extract Unusual Volume Report prints a listing of high hourly volume surgery cases.
The report prints a listing of unusual volumes that would be generated by the Surgery Extract
that is determined by a user-defined threshold value. This report shall have the capability to be
run prior to running the Surgery extract. The unusual volumes to be provided in the report are
defined by the Operation Time field, Patient Time field, or Anesthesia Time field, whichever
fields have a value greater than the defined threshold hold value. The default threshold volume
shall be 25. The default threshold volume of 25 equates to 6 hours. The report is sorted by
descending Volume and Case Number.

The Surgery Extract Unusual Volume Report will now print records if a time segment is missing.
Example: Surgery Extracts Unusual Volume Report

This report prints a listing of unusual volumes that would be
generated by the Surgery extract (SUR) as determined by a
user-defined threshold value. It should be run prior to the
generation of the actual extract(s) to identify and fix, as
necessary, any volumes determined to be erroneous.

Unusual volumes are those where either the Operation Time,
Patient Time, Anesthesia Time, Recovery Room Time, OR Clean Time
or Pt Holding Time field is greater than the threshold value.

Note: The threshold can be set after a report is selected.

Run times for this report will vary depending upon the size of
the extract and could take as long as 30 minutes or more to
complete. This report has no effect on the actual extracts and
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can be run as needed.

The report is sorted by descending Volume and Case Number.

Enter RETURN to continue or "~" to exit:

The default threshold volume for the Surgery extract is 25.
The default threshold volume (25) equates to 6 hours.
Would you like to change the threshold?? NO// YES

Volume > threshold

Enter the new threshold volume: (0-99): 5
Enter the date range for which you would like to scan the

Surgery Extract records.

Starting with Date: 03012014 (MAR 01, 2014)
Ending with Date: 03082014 (MAR 08, 2014)
This report requires 132-column format.
DEVICE: HOME// ;132;

Surgery Extract Unusual Volume Report Page: 1
Start Date: MAR 01, 2014 Report Run Date/Time: AUG 28, 2014
End Date: MAR 08, 2014 Threshold Value: 5

Case Encounter Pt Holding Anesthesia Patient Operation PACU OR Clean Canc/ Principal
Name SSN Day Number Number Time Time Time Time Time Time Abort Procedure
XXXX  XXXXXXXX 03/05/14 73319 XXXXXXXXX140304I 1.0 ## 8.0 7 9.0 ##
ILEOCECECTOMY W
XXXX  XXXXXXXX 03/03/14 73064 xxxxxxxxx1403031I 4.0 13.0 9.0 7 9.0 #i#
LEFT FEMORAL AN
XXXX  XXXXXXXX 03/07/14 73353 XXXXXXXXX4064291 2.0 10.0 9.0 7 8.0 ##
GASTROJEJUNOSTO
XXXX  XXXXXXXX 03/03/14 73306 xxxxxxxxx1402271 ## ## 9.0 7 8.0 ##

PARTIAL LEFT CO

Example: Exported Surgery Unusual Volume Report
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NAME S5H DAY CASE ¢ ENCOUNTER # PT HOLDING TIME ANESTHESIR TIME PRTIENT TIME OPERATION TIME PACU TIME CR CLEAN TIME CANC/ABCRT PRINCIPAL PROCEDURE
HEE moooooooe 3/5/2014 0 73319 3083233771403041 1§ Jzn-00 7 el TLEOCECECTOMY W
HE xmooooms 3/3/2014 0 73064 1392601211403031 4 13-Jan-00 Jan-00 7 Elf 24 LEFT FEMORAL AN
CE rmoooo 3/7/E014 73353 BRERRRRRRRRERLEE i 10-Jan-00 Jan-00 l B CASTROJZJUNGSTO

O oo 3/3/2014 73306 2924034001402271 4 3] Jan-00 7 b DARTIAL IEFT CO

4.4 Package Extracts

Please refer to the current DSS Extracts v3.0 Data Definitions Guide and Extract File Formats
Manual for more information about the record layout for the extracted fields.

The Package Extracts Option was modified so that users with the Security Key ECXMGR may
rerun an extract without Information Resources Management (IRM) assistance. The user can
reschedule an extract to run again when it has already been scheduled to run, rerun an extract that
was previously run, or cancel an extract that is (already) currently running and set it up to run
again. Use caution (and read the information being provided to you) when rerunning an extract
as it would be possible to have multiples of the same extract running simultaneously.

Example: Prompt for Rerunning an Extract

Select Package Extracts Option: PRO Prosthetics Extract

Starting with Date: 02012013 (FEB 01, 2013)
Ending with Date: 02282013 (FEB 28, 2013)

The Prosthetics information has already been extracted through Feb 28, 2013.
Do you want to continue processing the PRO extract? NO// YES

Make sure you have checked that your selected dates are correct
before answering yes to the next question.

Are you SURE you want to run the PRO extract? N// YES
Requested Start Time: NOW// (JUN 12, 2013@12:02:16)
Request queued as Task #12804.

Choosing the Package Extracts option from the Extract Managers Menu will display the
following menu and options.

NOTE: The DSS application will remove tildes (~) from extract record data prior to
transmitting them in order to avoid sending extract record data that would be recognized as
an end-of-record indicator to the AITC, except where the end-of-record is intended.

Example: Package Extracts Options on Extract Managers Menu
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Select Extract Manager®s Options Option: P Package Extracts

ADM Admissions Extract
BCM BCMA Extract
LBB Blood Bank Extract
CLI Clinic Visit Extract
ECS Event Capture Extract
1VP 1V Extract
LAB Lab Extract
LAR Lab Results Extract
PRE Prescription Extract
ECQ QUASAR Extract
PRO Prosthetics Extract
RAD Radiology Extract
SUR Surgery Extract
MoV Transfer and Discharge Extract
TRT Treating Specialty Change Extract
UDP Unit Dose Extract
Fiscal Year Logic — DSS Testing Only

Select Package Extracts Option: Lab Extract

Extract Laboratory Information for DSS

Starting with Date: 7/1/14 (JUL 01, 2014)

Ending with Date: 7/31/14 (JUL 31, 2014)

Requested Start Time: NOW//<RET>(AUG 01, 2014@13:26:18)
Request queued as Task #300.

4.4.1. Admissions Extract (ADM)

Use this option to extract the patient admissions data for a selected date range. This data is stored
in the ADMISSION EXTRACT file (#727.802) until it is transmitted to AITC.

The mail group for this extract is DSS-ADMS. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.2. BCMA Extract (BCM)

Use this option to extract data for a selected date range. This data is stored in the BCMA
EXTRACT file (#727.833) until it is transmitted to AITC.

The mail group for this extract is DSS-BCM. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.3. Clinic Visit Extract (CLI)

Use this option to extract data for all scheduled clinic visits, add/edits and walk-ins for the
selected date range, with the following exceptions.
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Non-count clinics are excluded unless specifically assigned a DSS Action Code other than 6.
Canceled clinic appointments are excluded. Clinics with an ACTION TO SEND code of 6 in
CLINICS AND STOP CODES file (#728.44) are excluded.

This data is stored in the CLINIC EXTRACT file (#727.827) until it is transmitted to AITC.

The mail group for this extract is DSS-SCX. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.4. Event Capture Extract (ECS)

Use this option to extract the event capture data for a selected date range. This data is stored in
the EVENT CAPTURE LOCAL EXTRACT file (#727.815) until it is transmitted to AITC.

The mail group for this extract is DSS-EC. The purpose of this mail group is to receive messages
when extract is complete and when the data is transmitted to the AITC.

4.45. IV Extract (IVP)

Use this option to extract the pharmacy 1V data for a selected date range. This data is stored in
the IV DETAIL EXTRACT file (#727.819) until it is transmitted to AITC.

The mail group for this extract is DSS-I1V. The purpose of this mail group is to receive messages
when extract is complete and when the data is transmitted to the AITC.

4.4.6. Lab Extract (LAB)

Use this option to extract the laboratory data, including referrals and research tests, for a selected
date range. This data is stored in the LABORATORY EXTRACT file (#727.813) until it is
transmitted to AITC.

All inpatient, outpatient, and referral lab tests accessioned within the selected date range are
extracted. Lab tests can be performed on a patient in the PATIENT file (#2) or a referral patient
in the REFERRAL PATIENT file (#67). The identifying number is the SSN for in-house patients
or a selected non-SSN ID constant for referrals and research.

The mail group for this extract is DSS-LAB. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.7. Lab Results Extract (LAR)

Use this option to extract the laboratory results data for a selected date range. This data is stored
in the LAB RESULTS EXTRACT file (#727.824) until it is transmitted to AITC.

The mail group for this extract is DSS-LAB. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.
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4.4.8. Prescription Extract (PRE)

Use this option to extract the prescription (pharmacy outpatient) data for a selected date range.
This data is stored in the PRESCRIPTION EXTRACT file (#727.81) until it is transmitted to
AITC.

The mail group for this extract is DSS-PRES. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.9.QUASAR Extract (ECQ)

Use this option to extract audiology and speech pathology clinic visit data for a selected date
range. This data is stored in the QUASAR EXTRACT (#727.825) file until it is transmitted to
AITC.

The mail group for this extract is DSS-QSR. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.10. Prosthetics Extract (PRO)

Use this option to extract the prosthetics data for a selected date range. The data is stored in the
PROSTHETICS EXTRACT file (#727.826) until it is transmitted to AITC.

The following information is required to extract a prosthetics record.
e Station Requesting Station
e Patient Name (in Prosthetics)
e SSN
e Receiving Station
e Name (in PATIENT file (#2))
e Type of Transaction
e Delivery Date
e Source
e HCPS

For prosthetics records that could not be extracted, you will receive a Prosthetics DSS Exception
message indicating the record IEN in the RECORD OF PROS APPLIANCE/REPAIR file (#660)
and the critical information that is missing.

The records identified in this message were not extracted and should be reviewed to determine if
they must be corrected and the extract regenerated to assure proper DSS credit is received.

If you are extracting data for a division, you can only select a primary division (as defined for
your entries in the PROSTHETICS SITE PARAMETERS file (#669.9) and the NEW PERSON
file (#200)).
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The mail group for this extract is DSS-PRO. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.11. Radiology Extract (RAD)

Use this option to extract the radiology data for a selected date range. This data is stored in the
RADIOLOGY EXTRACT file (#727.814) until it is transmitted to AITC.

The mail group for this extract is DSS-RAD. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.12. Surgery Extract (SUR)

Use this option to extract the surgery data for a selected date range. This data is stored in the
SURGERY EXTRACT file (#727.811) until it is transmitted to AITC. Secondary procedures and
prostheses are also extracted.

The mail group for this extract is DSS-SURG. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.13. Transfer and Discharge Extract (MOV)

Use this option to extract all patient movement (transfers and discharge) data for the selected
date range. This data is stored in the PHYSICAL MOVEMENT EXTRACT file (#727.808) until
it is transmitted to AITC.

The mail group for this extract is DSS-MOVS. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.14. Treating Specialty Change Extract (TRT)

Use this option to extract treating specialty change data for a selected date range. This data is
stored in the TREATING SPECIALTY CHANGE EXTRACT file (#727.817) until it is
transmitted to AITC.

The mail group for this extract is DSS-TREAT. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.15. Unit Dose Extract (UDP)

Use this option to extract all unit dose orders for the selected date range. Data is extracted from
UNIT DOSE EXTRACT DATA file (#728.904) which is populated by the Inpatient Medications
package when a pick list is filed. This data is stored in the UNIT DOSE LOCAL EXTRACT file
(#727.809) until it is transmitted to AITC.
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The mail group for this extract is DSS-UD. The purpose of this mail group is to receive messages
when extract is complete and when the data is transmitted to the AITC.

4.4.16. Blood Bank Extract (LBB)

Use this option to extract blood bank data for a selected date range. This data is stored in the
BLOOD BANK EXTRACT file (#727.829) until the data is transmitted to AITC. This extract
enables DSS staff to see and manage the true economic costs of blood product use in Veterans
Health Administration (VHA).

The mail group for this extract is DSS-LBB. The purpose of this mail group is to receive
messages when extract is complete and when the data is transmitted to the AITC.

4.4.17. Fiscal Year Logic — DSS Testing Only

The Fiscal Year Logic - DSS Testing Only option allows selection of a fiscal year that may not
have the DSS logic implemented for that year. If a future year (e.g. 2015) is entered and the user
does not have the ECX DSS TEST security key, the software does not allow selection of a future
fiscal year.

AEAEAAAAAAAAAAXAAAXAAAAXAAAXAAAAAAAXAAAAAAAXAAAAAAAAAAAAAAAAAAAAAAAAddX

* *
* Use this option with caution since it will allow you to *
* run any supported DSS extract using specific fiscal year *
* logic. By running this option you may negatively impact *
* your extract data. *
* *
* DO NOT USE this option unless you are an official test site *
* for the DSS Fiscal Year Conversion. *
K o o o *
* *
* Note that this option does not update the last date used for *
* the given extraction. It also does not verify that the time *
* frame selected is after the last date used for the extract. *
* *
Enter RETURN to continue or *"/~" to exit:
Select DSS Extract to queue: CIINIC I (CLD)
Starting with Date: 3/1 (MAR 01, 2013)
Ending with Date: 3/31/2013// (MAR 31, 2013)
Select one of the following:

2012 Fiscal Year 2012

2013 Fiscal Year 2013

2014 Fiscal Year 2014

2015 Fiscal Year 2015
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Select fiscal year logic to use for extract: 2015 Fiscal Year 2015

WARNING: Logic has not been released for this year. Do not use unless
directed by DSO. Do you want to continue? YES//

45 SAS Extract Audit Reports

This section contains a brief description followed by a sample output for each SAS Extract Audit
Reports option. To execute any of the SAS Extract Audit Reports options, enter the DSS Extract
Log Record Number and a printer device. Please note that in an effort to streamline the
documentation, only a portion of the output might be provided for some reports.

Please refer to the Current DSS Extracts Data Definitions Guide and Extract File Formats
Manual for more information about the record layout for the extracted fields.

45.1 SAS Extracts Audit Reports Menu

Choosing the SAS Extracts Audit Reports option from the Extract Managers Menu will display
the following menu and options.

Example: SAS Extract Audit Reports Menu on Extract Managers Menu

Select Extract Manager®s Options Option: s SAS Extract Audit Reports
PRE SAS Prescription Audit Report
RAD SAS Radiology Audit Report
SUR SAS Surgery Audit Report
Select SAS Extract Audit Reports Option:
All of the SAS Extract Audit Reports options can be executed in the following manner:
Select SAS Extract Audit Reports Option: PRE SAS Prescription Audit Report
Prescription Extract SAS Report
Select DSS EXTRACT LOG RECORD NUMBER: 187 10-06-97 Prescription
Extract: Prescription #187
Start date: JAN 01, 1997

End date: JAN 31, 1997
# of Records: 6

DEVICE: HOME//
DEVICE: HOME// RIGHT MARGIN: 80// <RET>

Requested Start Time: NOW// <RET> (DEC 02, 1997@10:48:25)
Request queued as Task #188047.

October 2014 Decision Support System V. 3.0 User Manual 78
Patch ECX*3.0%¥149



45.2  SAS Prescription Audit Report

This option emulates the SAS routine at the AITC, which creates new records from the
Prescription (pharmacy outpatient) Extract. You can use it to print a summary report for all
records sorted by feeder location and feeder key.

Refer to Appendix A for information about feeder key transmission.

Example: SAS Audit Report for Prescription (PRE) Extract

SAS Audit Report for Prescription (PRE) Extract
DSS Extract Log #: 187

Date Range of Audit: JAN 01, 1997 to JAN 31, 1997
Report Run Date/Time: NOV 25, 1997@11:27

Division/Site: TEMPLE (1) Page: 1
Feeder Location Feeder Key Quantity
CMOPDSU1 10002000168035755 125

10070054162081019 18000
10140054629001162 5290

Example: Exported SAS Audit Report for Prescription (PRE) Extract

EXTRACT LOG # DIVISION/SITE FEEDER LOCATION FEEDER KEY QUANTITY

4733 TEMPLE(1) CMOPDSU1 10002000168035755 225

4733 TEMPLE(1) CMOPDSU1 10070054162081019 18000

4733 TEMPLE(1) CMOPDSU1 10140054629001162 5290

45.3 SAS Radiology Audit Report

This option emulates the SAS routine at the AITC, which creates new records from the radiology
extract. You may use it to print a summary report for all records sorted by feeder location and
feeder key. Note that bilateral modifiers will increase volumes.

Refer to Appendix A for information about feeder key transmission.

Example: SAS Audit Report for Radiology (RAD) Extract

SAS Audit Report for Radiology (RAD) Extract

DSS Extract Log #: 197

Date Range of Audit: JAN 01, 1990 to JAN 31, 1990
Report Run Date/Time: NOV 25, 1997@11:32

Division/Site: TOGUS, ME (402) Page: 1
Feeder Location Feeder Key Quantity
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402-1 70100 1
402-1 70470 1
402-1 71020 5
402-1 73120 1
402-1 73620 3
402-1 73660 1
402-1 74000 1
402-1 75712 1
402-1 888888 2
402-1 999999 2
Total for Feeder Location 402-GENERAL RADIOLOGY (402-1): 18
Grand Total for Division 402: 18
Example: SAS Audit Report for Radiology (RAD) Extract
EXTRACT LOE & DIVISICON/SITE FEEDER LOCATICON FEEDER EEY QUANTITY
2937 DRYTON (552) 552-1 (EENERLZL RADICLOGY) g28888 375
2957 DRYTON (552) 552-1 (EENERZL RADIOLOGY) 953999 34
3557 DRYTCN (552) 552-1 (EENERRL RADICLOGY) 7003001 25

45.4  SAS Surgery Audit Report

This option emulates the SAS routine at the AITC, which creates new records from the surgery

extract. You can use it to print a summary report for all records sorted by feeder location and
feeder key.

Refer to Appendix A for information about feeder key transmission.

Example: SAS Audit Report for Surgery (SUR) Extract

SAS Audit Report for Surgery (SUR) Extract

DSS Extract Log #: 255

Date Range of Audit: MAY 01, 1997 to MAY 31, 1997
Report Run Date/Time: NOV 25, 1997@11:35

Division/Site: ALBANY (500) Page: 1
Feeder Location Feeder Key Quantity
5000RCN CARDIAC/NEURO OR 062-10 5
062-30 2
5000RCNA CARDIAC/NEURO OR - ANESTHESIA 062-23 7
5000RCNS CARDIAC/NEURO OR - SURGERY 062-40 3

Example: Exported SAS Audit Report for Surgery (SUR) Extract
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EXTRACT LO= £ DIVISION/SITE |FEEDER LOCATICH FOR FEEDER QUANTITY

3988 DRYTOMN (1) S5Z0RCR CARDIAC OR 042-10 5
3988 DRYTOMN (1) S5Z0RCER CARDIARC OR 045-30 z
3988 DRYTON (1) 55Z0RCE CARDIAC OR 048-80 1

4.6 Extract Audit Reports

This section contains a brief description followed by a sample output for each Extract Audit
Reports option. To execute any of the Extract Audit Reports options, enter the DSS Extract Log
Record Number, starting and ending dates, divisions, locations, or accession areas (as
appropriate), and a printer device. There is also a narrative portion of each report that prints only
if the report is sent to a printer device. The format of the narrative is the same for all extract audit
reports, but the content will vary for each report. Please note that in an effort to streamline the
documentation, only a portion of the output might be provided for some reports.

Please refer to the current DSS Extracts Version 3.0 Data Definitions Guide for more
information about the record layout for the extracted fields.

4.6.1 Extract Audit Reports Menu

Choosing the Extract Audit Reports option from the Extract Managers Menu will display the following
menu and options.

Example: Extract Audit Reports Menu on Extract Managers Menu

Select Extract Manager®s Options Option: E Extract Audit Reports Menu

ADM Admission (ADM) Extract Audit

ECQ QUASAR (ECQ) Extract Audit

ECS Event Capture (ECS) Extract Audit

LAB Laboratory (LAB) Extract Audit

LAR Laboratory Results (LAR) Extract Audit

LBB Laboratory Blood Bank (LBB) Audit Reports..
MoV Physical Movement (MOV) Extract Audit

PRO Prosthetics (PRO) Extract Audit

RAD Radiology (RAD) Extract Audit

SUR Surgery (SUR) Extract Audit

TRT Treating Specialty Change (TRT) Extract Audit

The following dialog for the Admission (ADM) Extract Audit Report is typical of all the audit reports and
is provided as an example.

Example: Setup for ADM Extract Audit Report
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Select DSS EXTRACT LOG RECORD NUMBER: 193 10-06-97 Admission
Extract: Admission #193
Start date: DEC 01, 1996
End date: DEC 31, 1996
# of Records: 3

You can narrow the date range, if you wish.

The Start Date can"t be earlier than DEC 01, 1996,
or later than DEC 31, 1996.

Select Start Date: DEC 01, 1996// <RET> (DEC 01, 1996)

The End Date can"t be earlier than DEC 01, 1996
(the Start Date you selected), or later than DEC 31, 1996.

Select End Date: DEC 31, 1996// <RET> (DEC 31, 1996)
Do you want the ADM extract audit report for all divisions? NO// Y YES

DEVICE: HOME// QUEUE TO PRINT ON
DEVICE: HOME// A700 RIGHT MARGIN: 133// <RET>

Requested Start Time: NOW// <RET> (NOV 25, 1997@13:40:18)
Request queued as Task #186962.

Example: Admission (ADM) Extract Audit Report

DSS Extract Log #: 193
Date Range of Audit: DEC 01, 1996 to DEC 31, 1996
Report Run Date/Time: NOV 25, 1997@13:34 Page 3

AUDIT DESCRIPTION:

Verify against: Gains and Losses Sheet/Bed Status Report
Menu Option: Gains and Losses (G&L) Sheet [DG G&L SHEET]

The Gains and Losses Sheet is the primary VistA report against which ADM
extract data should be verified. However, if starting the verification
process at the beginning of the fiscal year, the Bed Status Report can also
be used. Copies of these reports are readily available from patient
administration services at most medical centers.

The G&L Sheet shows admissions by ward for a specific day. To verify the
data on the extract audit report, the verifier must accumulate the data
given on the G&L Sheet either manually or through use of a spreadsheet
application. For example, if the Admission Extract Audit Report covers

the period July 1 to July 15, then accumulate the admission data from the
G&L Sheet for each day from July 1 through July 15. The accumulated data
for a given ward (e.g., total number of admissions for Ward A during the
period) should match the figure reported on the extract audit for the same
ward and date range.

IT verification is done through the Bed Status Report, simply use the
"Cumulative Totals" table which displays fiscal year-to-date totals of
interward losses and discharges by ward group. The Admission (ADM) Extract
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Audit also displays totals by ward group. Some arithmetic manipulation is
needed here in order to compare the figures on the two reports. For
example, to verify data for the month of July, the user must first develop
a "Cumulative Totals" table for the month of July. This is done by
subtracting the figures contained in the "Cumulative Totals'™ table of
June 30 from the figures contained in the "Cumulative Totals" table of
July 31. (Again, this can be accomplished manually, or with the aid of a
spreadsheet application.) The resulting month of July table can then be
compared directly to the ward group totals shown on the extract audit
report generated for the period July 1 to July 31.

4.6.2 Admission (ADM) Extract Audit

Use this option to print a summary report from the ADMISSION EXTRACT file (#727.802) that
displays the number of patient admissions by ward and ward group.

Example: Admission Extract Audit Report

Admission (ADM) Extract Audit Report

DSS Extract Log #: 193

Date Range of Audit: DEC 01, 1996 to DEC 31, 1996

Report Run Date/Time: NOV 25, 1997@13:34

Medical Center Division: TROY (500B) Page: 1
Ward # of Admissions
SURGERY 0

Ward group SURGERY TOTALS subtotal: 0
3 NORTH SURG 0

Ward group NHCU TOTALS subtotal: 0
ICuU/CCU 0
GEN MED 2

Ward group MEDICINE TOTALS subtotal: 2

Division TROY Grand Total: 2

Example: Exported Admission Extract Audit Report

EXTRACT LOG § MEDICAL CENTER DATE EANGE OF AUDIT WERD <DS5 DEET.> £ OF AOMISSIONS
2378 DRYTON (552)  JARN 01, 2014 te JAN 31, 2014  ICU (3 &
2378 DRYTON (552)  JARN 01, 2014 te JAN 31, 2014  TCU (3 &
2378 DRYTON (552)  JRN 01, 2014 to JAN 21, 2014 4 N (3 27
Ward group SURGERY subtotal: 45
4.6.3 QUASAR (ECQ) Extract Audit
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Use this option to print a report from the QUASAR EXTRACT file (#727.825) file. The report
displays the number of procedures performed for patient visits to Audiology and Speech
Pathology.

Example: QUASAR Extract Audit Report

QUASAR (ECQ) Extract Audit Report

DSS Extract Log #: 192

Date Range of Audit: MAY 01, 1997 to MAY 31, 1997
Report Run Date/Time: NOV 26, 1997@10:39

QUASAR Site: ALBANY (500) Page: 1
DSS Unit Procedure Volume
Audiology
92506 SPEECH & HEARING EVALUATION 1
92508 SPEECH/HEARING THERAPY 2
Total Volume for Audiology: 3
DSS Unit Procedure Volume

Speech Pathology

92520 LARYNGEAL FUNCTION STUDIES 1
92531 SPONTANEOUS NYSTAGMUS STUDY 1
Total Volume for Speech Pathology: 2
Grand Total for Site ALBANY (500): 5

Example: Exported QUASAR Extract Audit Report

EXTRACT
LOG # QUASAR SITE DIVISION DSS UNIT PROCEDURE PROCEDURE DESCRIPTION VOLUME
CENTRAL TEXAS HCS AUSTIN REMOVE IMPACTED EAR WAX
4727 (674) (674BY) Audiology 69210 UNI 50
CENTRAL TEXAS HCS AUSTIN BASIC VESTIBULAR
4727 (674) (674BY) Audiology | 92540 EVALUATION 2
Volume for
Audiology 1605
CENTRAL TEXAS HCS AUSTIN Speech
4727 (674) (674BY) Pathology 92507 SPEECH/HEARING THERAPY 26
CENTRAL TEXAS HCS AUSTIN Speech EVALUATE SPEECH
4727 (674) (674BY) Pathology | 92522 PRODUCTION 2
CENTRAL TEXAS HCS AUSTIN Speech
4727 (674) (674BY) Pathology | V5363 LANGUAGE SCREENING 1
Volume for Speech
Pathology 38

4.6.4 Event Capture (ECS) Extract Audit

Use this option to print a summary report from the EVENT CAPTURE LOCAL EXTRACT file
(#727.815) that displays the number of procedures performed within each DSS Unit.
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Select Extract Audit Reports Menu Option: ECS Event Capture (ECS) Extract Audit
Setup for ECS Extract Audit Report --
Select DSS EXTRACT LOG RECORD NUMBER: 3846 04-24-13 Event Capture
Extract: Event Capture #3846
Start date: MAR 01, 2013
End date: MAR 31, 2013
# of Records: 25554

The extract which you have chosen to audit
was transmitted to Austin/DSS on MAY 07, 2013.

Do you want to continue with this audit report? NO// y YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than MAR 01, 2013,
or later than MAR 31, 2013.

Select Start Date: MAR 01, 2013// <RET> (MAR 01, 2013)

The End Date can"t be earlier than MAR 01, 2013
(the Start Date you selected), or later than MAR 31, 2013.

Select End Date: MAR 31, 2013// <RET> (MAR 31, 2013)
Do you want the ECS extract audit report for all Locations? NO// y YES

Do you want the output in exportable format? NO// y YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen”™ tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g-. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

Example: Exported ECS Extract Audit Report
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LOCATION  EXTRACT LOGE DSSUNIT CATEGORY PROCEDURE VOLUME

DAYTOM [552 3734 AUDIOLOGY ECS (76) 1Audiclogy Exam 92550 TYMPANOMETRY & REFLEX THRESH 32
DAYTOM [552 3794 AUDIOLOGY ECS (78] 1Audiclogy Exam SPO72 PURE TOME AUDIOMETRY, AIR OMLY 10
DAYTOM [552 3734 AUDIOLOGY ECS (76) 1Audiclogy Exam 5P0O74 SPEECH THRESHOLD TESTING 1

Example: ECS Extract Audit Report Screen Print

Event Capture (ECS) Extract Audit Report

DSS Extract Log #: 182
Date Range of Audit: JUN 01, 1997 to JUN 30, 1997
Report Run Date/Time: NOV 26, 1997@08:46
Event Capture Location: TROY (515.6) Page: 1
DSS Unit

Category Procedure Volume
DSS TEST UNIT (3)

DSS TEST ASSIGNMENT SWOO1N CASE MANAGEMENT, 15 MIN 250
Total Volume for Unit DSS TEST UNIT (3): 250
Grand Total for Location TROY (515.6): 250

Example: Exported ECS Extract Audit Report Screen Print

LOCATICH EXTRACT LOG £ D55 UNIT CATEGORY |PROCEDURE |VOLUME
SPRINGFIELD 3980 NsF5 HEPC SPRINGFIELD (44) Unknown (NUO003
SPRINGFIELD 3380 N&F5 HBEC SERINGFIELD (44) Unknown |(NUOOO04
SPRINGFIELD 3380 N&F5 HBEC SERINGFIELD (44) Unknown |NOO14 MDS

4.6.5 Laboratory (LAB) Extract Audit

|

Use this option to print a summary report from the LABORATORY EXTRACT file (#727.813)

that displays the volume of tests performed within each laboratory accession area.

Example: Laboratory Extract Audit Report

Laboratory (LAB) Extract Audit Report

DSS Extract Log #: 273

Date Range of Audit: APR 01, 1996 to APR 30, 1996
Report Run Date/Time: NOV 26, 1997@09:04

DSS Site: ALBANY (500) Page: 1
Accession Area (Feeder Location) LMIP LOINC # of Tests # of Tests
Procedure Code Code (Patients) (Referrals)

SURGICAL PATHOLOGY (SP)

SP Specimen 88000.0000 1234-5 1 0
Total for SURGICAL PATHOLOGY: 1 0
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Example: Exported Laboratory Extract Audit Report

EXTRACT ACCESSION AREA # OF TESTS | # OF TESTS
LOG # DSS SITE (FEEDER LOCATION) PROCEDURE LMIP CODE (PATIENTS) | (REFERRALS)
4065 DAYTON (552) ANCILLARY (ANC) Base Excess~DSS ACC 81246.9999 1 0

4065 DAYTON (552) ANCILLARY (ANC) Bicarbonate~DSS ACC 81216.9999 1 0

4065 DAYTON (552) ANCILLARY (ANC) Chloride~DSS ACC 82435.9999 10 0

4065 DAYTON (552) ANCILLARY (ANC) Creatinine~DSS ACC 82565.9999 10 0

4065 DAYTON (552) ANCILLARY (ANC) Glucose POC~DSS ACC | 82115.9999 1124 0

4.6.6 Laboratory Results (LAR) Extract Audit

DSS collects 75 unique LAR tests. The DSS LAR Test Number range from 0001 to 0076
(NOTE: 0012 is missing). Not in extract will display in the Total Count column if there has been
no workload for a particular DSS LAR test.

Example: Laboratory Results Extract Audit Report (report abbreviated to save space)

Lab Results (LAR) Extract Audit Report

DSS Extract Log #: 4071

Date Range of Audit: AUG 01, 2011 to AUG 31, 2011

Report Run Date/Time: JUN 13, 2012@04:57

Division: CHEYENNE VAMC (442) Page: 1
Test Code DSS TEST NAME Month Year Total Count
0001 Hemoglobin AUG 2011 1842
0002 Potassium (Serum) AUG 2011 2232
0003 Sodium (Serum) AUG 2011 2174
0004 Lithium (Serum) AUG 2011 9
0005 BUN (Blood Urea Nitrogen) AUG 2011 2125
0006 WBC (Total WBC Count) AUG 2011 1751
0007 Digoxin AUG 2011 15
0008 Theophylline AUG 2011 5
0009 AST (Aspartate Transferase) AUG 2011 1494
0010 Glucose (Serum) AUG 2011 2214
0011 Creatinine Clearance AUG 2011 7
0013 GGTP (Gamma GT) AUG 2011 576
0014 Dilantin (Phenytoin) AUG 2011 23
0015 Valproic Acid AUG 2011 8
0016 Carbamazepine (Tegretol) AUG 2011 6

Example: Exported Laboratory Results Extract Audit Report (abbreviated to save space)

EXTRACT LOG ¢ DIVISICHW TEST CODE DSS TEST MAME MONTH YEZR TOTAL COUNT
412% DRYTON (552) 1 Hemoglobin Mzr-14 EEEE
412% DRYTON (552) 2 Potassium (Sexum) Mar-14 §250
412% DRYTON (552) 3 Sodium (Serum) Mar-14 £258
4125 DRYTON (552) 4 Lithium (Serum) Mar-14 zz
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4.6.7 Laboratory Blood Bank (LBB) Audit Reports

There are two reports to choose from under the LBB Audit Reports. The LBB Comparative
Report can be run after the extract has run. The LBB Pre-Extract Audit Report, however, can
only be run prior to the extract which causes some sites to bypass this audit. If a discrepancy
exists, sites can correct the data and run the extract again prior to transmitting the data to AITC.

Example: LBB Audit Reports

Select Extract Audit Reports Menu Option: Laboratory Blood Bank (LBB) Audit Reports

1 Laboratory Blood Bank (LBB) Comparative Report
2 Laboratory Blood Bank (LBB) Pre-Extract Audit

4.6.7.1 Laboratory Blood Bank (LBB) Comparative Report

Select Laboratory Blood Bank (LBB) Audit Reports Option: Laboratory Blood Bank (LBB)
Comparative Report

Setup for LBB Extract Audit Comparative Report..

Select DSS EXTRACT LOG RECORD NUMBER: 2587 06-15-09 Blood Bank
Extract: Blood Bank #2587

Start date: MAR 01, 2009
End date: MAR 31, 2009
# of Records: 139

You can narrow the date range, if you wish.

The Start Date can"t be earlier than MAR 01, 2009,
or later than MAR 31, 2009.

Select Start Date: MAR 01, 2009// (MAR 01, 2009)

The End Date can"t be earlier than MAR 01, 2009
(the Start Date you selected), or later than MAR 31, 2009.

Select End Date: MAR 31, 2009// (MAR 31, 2009)
Do you want the LBB extract comparative report to sort by COMP? NO// YES

This report requires a print width of 132 characters.
DEVICE: HOME//

Example: LBB Extract Comparative Audit Report
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LEE Extract Comparatiwve Audit Report Pacge 1

01 Mar 2003 - 31 Mar 2009 Pun Date: 23 Jun 2009
—————————————————— LOCAL ELOOD EBANE SO0URCE ---—-—--—————————————— —-—-—--—-—--—--—- LBE EXTRACT (#Z&5&7) ----———-
Transf Number Transf MNunber
Name 8EN FOE LOC Date cCoMP of Units BEN Date COMFP of Units
DEEE AXHAHAAKK EBEEZ 3FL1309 APHP 1 HEXHXHAARK 3513509 APHP 1
DLEsZ HHEHHEHNNN EEEZZ 3513709 APHP 1 HEXHXNNEEX 3512709 APHP 1
DasZ AUXAKEAANE BEGZ3 3/15/709 APHP 1 HEEHNXERX 3/15/709 APHP 1
APHP TOTAL 3 APHP TOTAL 3
DEE2 AHHAUAAKK BEBEEZ 22400 LPC 1 HEXAHAARK 224500 LPC 1
LEs3 HHEHHEHNNN EEEZZ IFEEFDO LPC 1 HEXHXNNEEX IfEEFO9 LPC 1
D354 AUXAKEAANE BEGZ3 3/5/09 LFC 1 HEEHNXERX 3/5/509 LPC 1
Dasd AHHAUAAKK EBEBEEZ FFEES0D LPC 1 HEXAHAARK FSEES0D LPC 1
LPFC TOTAL 4 APHP TOTAL 4
TOTAL 7 7

4.6.7.2 Laboratory Blood Bank (LBB) Pre-Extract Audit

This report provides DSS on-site support staff with a list of unmatched blood products. The
report will contain those records that do not have a value in either the DSS Product Dept or DSS
IP # fields. The resulting report will enable the DSS on-site support team to correct the
unmatched blood products prior to running the LBB Extract.

Example: LBB Pre-Extract Audit Report

Select Extract Audit Reports Menu Option: LBB Laboratory Blood Bank (LBB) Audit
Reports

Laboratory Blood Bank (LBB) Comparative Report
Laboratory Blood Bank (LBB) Pre-Extract Audit

Select Laboratory Blood Bank (LBB) Audit Reports Option: 2 Laboratory Blood Bank
(LBB) Pre-Extract Audit

LBB Pre-Extract Audit Report Information for DSS

**NOTE: This audit can only be run prior to the LBB Extract being generated.
I you have already generated your LBB Extract, refer to the Processing
Guide Chapter 4 section on Regenerating.**

Starting with Date: 2/1/2012 (FEB 01, 2012)
Ending with Date: 2/29/2012 (FEB 29, 2012)

Previously, you have selected queuing.
Do you STILL want your output QUEUED? Yes// N (No)
DEVICE: HOME// Right Margin: 80//

Retrieving records. ..

LBB Extract Audit Report Page 1

01 Feb 2012 - 29 Feb 2012 Run Date: 07 Jan 2012
Transt Number

Name SSN FDR LOC Date COMP of Units

DSSA 000054102 BB523A4 2/6/12 LRB3 1
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DSSA 000054102 BB523A4 2/6/12 LRB3 1
DSSB 000224430 BB523A4 2/21/12 LRB3 1
DSSC 000403825 BB523A4 2/16/12 LRB3 1
DSSC 000403825 BB523A4 2/13/12 LPAX 1
DSSC 000403825 BB523A4 2/12/12 LPAX 1
DSSC 000403825 BB523A4 2/12/12 CR-P 10

Example: Exported LBB Pre-Extract Audit Report

HAME 35H FEEDER TRAMSFUSI COMEPOMENT NUMEBER OF
LOCATION 0N DATE UNMITS
K HEHHxExxxx BES5Z 4/1/72014 REC 1
HEE HEMHHHEKNx BBS5Z 4/1/2014 EBC 1
MR xxxunxxxxx BESEZ 4/1/2014 BEEC 1
HEE HEMHHHEKNx BBS5Z 4/3/2014 EBC 1

4.6.8 Physical Movement (MOV) Extract Audit

Use this option to print a summary report from the PHYSICAL MOVEMENT EXTRACT file
(#727.808). The report displays the total count of each MAS movement type (transfers and
discharges) by ward and ward group.

Example: Movement Extract Audit Report

Hovetent (HOV) Eutract Audit Report

055 Entract Log #: 419

Date Range of Audit:  HAR 01, 2014 to HAR 31, 2014

Report Run Date/Tine:  AUG 21, 201481204

fedical Center Diwision: DAYTOM (552) <O Page; 1

Hard <055 Dept.> RS Hovenent (Transfer] Types
P2 1 4 13 # ¥ 23 M4 % ¥ 4 # &H Tl

10 (%) T e | A | b
TCU (5] e e 1l
4 H (5] e | A | 3

Hard group SURGERY subtotals,

15 e e A R

Hard group PSYCHIATRY subtotals,
R | S A |y A I | A
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Example: Exported Movement Extract Audit Report

EXTRACT DIVISICH WARD <DSS DEET> 1 z 2 4 13 14 2z 23 24

LOG #
4131 |DAYTON (552) ICU (M) o a o 81 o o o a o
4191 | DAYTON (552) MED 1 M a a o za o 1 0 a a
4131 DRYTON (552) MED 1 W ] a o o o o o a ]
4191 DAYTON (552) MED1 CN a a a1 a a o a a
4131 |DRYTON (552) TCU (M) o a o 2 0o 1 0 a a
4131 |DRYTON (552) 4 N (M) o al o 12 o & 0 al o

4.6.9 Prosthetics (PRO) Extract Audit

Use this option to print the PSAS HCPCS Cost Report from the PROSTHETICS EXTRACT file
(#727.826). Sites that are multidivisional prosthetics sites may choose to generate a specific
report for one division or a combined report for all divisions.

The report is divided into two parts and includes the following:

Summary Detail
NPPD group summary. Individual patient detail within an NPPD Line
Data is reported in two sections: New and Repair Item.
VA, Commercial, and Total quantities. HCPCS code and description.
Total Cost and Average Commercial Cost. Delivery Date, Quantity, and Cost.
Type (i.e., VA or Commercial, Initial or
Repair).

Station Number is also displayed for
multidivisional Prosthetics sites.

Within each NPPD Group, the summary data for each | Sort order is by Delivery Date.
NPPD Line Item is displayed, followed by the group
totals. Summary totals are also provided for New and
Repair sections.

Example: Exported Summary Report for PRO Extract Audit
Select Extract Audit Reports Menu Option: PRO Prosthetics (PRO)Extract Audit

Setup for PRO Extract Audit Report --

Select DSS EXTRACT LOG RECORD NUMBER: 3897 05-22-13 Prosthetics
Extract: Prosthetics #3897
Start date: FEB 01, 2013
End date: FEB 28, 2013
# of Records: 5748
Station: DAYTON
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The extract which you have chosen to audit
was transmitted to Austin/DSS on MAY 22, 2013.

Do you want to continue with this audit report? NO// y YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than FEB 01, 2013,
or later than FEB 28, 2013.

Select Start Date: FEB 01, 2013// (FEB 01, 2013)

The End Date can"t be earlier than FEB 01, 2013
(the Start Date you selected), or later than FEB 28, 2013.

Select End Date: FEB 28, 2013// (FEB 28, 2013)
Select one of the following:

D DETAIL
S SUMMARY

Type of Report: SUMMARY// s SUMMARY

Do you want the output in exportable format? NO// YES

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns”
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where O is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number Ffields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

STATION # EXTRACT LOG # TYPE NPPD GROUP NPPDLINE VA COM TOTAL COST AWVECOM
352 3897 NEW WHEELCHAIRS AND ACCESSORIES 100 A 1 12 13 20912 1743

352 3897 NEW WHEELCHAIRS AND ACCESSORIES 100 AL o 2 2 0 0

352 3897 NEW WHEELCHAIRS AND ACCESSORIES 100 B o 13 13 1304 139

Example: Summary Report Screen Print for PRO Extract Audit

Prosthetics (PRO) Extract Audit Report Page 1

DSS Extract Log #: 3897

Date Range of Audit: FEB 01, 2013 to FEB 28, 2013

Station (#): 552 (DAYTON)
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Report Run Date/Time: AUG 19, 2013@16:25

REPORT OF NEW PROSTHETICS ACTIVITIES
Line Item VA Com Total Cost ($) Ave Com (%)

WHEELCHAIRS AND ACCESSORIES

100 A 1 12 13 20912 1743
100 Al 0 2 2 0 0
100 B 0 13 13 1804 139

Example: Exported Detail Report for PRO Extract Audit

Select Extract Audit Reports Menu Option: Prosthetics (PRO) Extract Audit

Setup for ECS Extract Audit Report --

Select DSS EXTRACT LOG RECORD NUMBER: 3969 06-20-13 Prosthetics
Extract: Event Capture #3969

Start date: FEB 01, 2013
End date: FEB 28, 2013
# of Records: 17419

The extract which you have chosen to audit
was transmitted to Austin/DSS on JUN 20, 2013.

Do you want to continue with this audit report? NO// YES
You can narrow the date range, if you wish.

The Start Date can"t be earlier than FEB 01, 2013,
or later than FEB 28, 2013.

Select Start Date: FEB 01, 2013// (FEB 01, 2013)

The End Date can"t be earlier than FEB 01, 2013
(the Start Date you selected), or later than FEB 28, 2013.

Select End Date: FEB 28, 2013//02102013 (FEB 10, 2013)
Do you want the ECS extract audit report for all Locations? NO// YES

Select one of the following:
D DETAIL
S SUMMARY
Type of Report: SUMMARY// DETAIL

1. WHEELCHAIRS AND ACCESSORIES

2. ARTIFICAL LEGS

3. ARTIFICAL ARMS AND TERMINAL DEVICES

4. BRACES AND ORTHOTICS

5. SHOES/ORTHOTICS

6. NEUROSENSORY AIDS

7. RESTORATIONS

8. OXYGEN AND RESPIRATIORY

9. MEDICAL EQUIPMENT, MISC., ALL OTHER NEW
10. REPAIR

Select NPPD Group : (1-10): 1

1. 100 A MOTORIZED
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2. 100 A1 SCOOTERS

3. 100 B MANUAL CUSTOM

4. 100 C  MANUAL A/0

5. 100 D  ACCESSORIES

6. 100 E = CUSHION FOAM

7. 100 F  CUSHION SPEC

8. 100 G CARRIERS

9. 100 H NSC VAN MODS

10. 100 1 SCOOTER ACCESSORIES

Select NPPD Line : (1-10): 1

Do you want the output in exportable format? NO// Y

NOTE: Appendix C contains instructions for exporting a report into an external spreadsheet.

Gathering data for export...
To ensure all data is captured during the export:

1. Select "Logging..." from the File Menu. Select your file, and where to save.

2. On the Setup menu, select "Display...",then "screen” tab and modify "columns
setting to at least 225 characters.

3. The DEVICE input for the columns should also contain a large enough
parameter (e.g. 225). The DEVICE prompt is defaulted to 0;225;9999 for you.
You may change it if need be.

Example: DEVICE: 0;225;99999 *Where 0 is your screen, 225 is the margin width

and 99999 is the screen length.

NOTE: In order for all number fields, such as SSN and Feeder Key, to be
displayed correctly in the spreadsheet, these fields must be formatted as Text
when importing the data into the spreadsheet.

DEVICE: 0;225;99999//

NPPD
EXTRACT | MPPD STATIOMN ENTRY
LOG # GROUP | MPPD LINE MNAME EEM HCPCE ary | TYPE | COST DATE HCPCE DESC # DATE
2801 100 A MOTORIZED | PAT1 M KDE48 1 1C 1600 0102 | PWC,GP3,5TDSING/S0L | 552 20121211
3801 100 A MOTORIZED | PATZ2 OO KDB22 1 I1C 1200.00 | 01/04 | PWC,GP2,5TDSLNG/S0L | 552 20121204
3801 100 A WMIOTORIZED | PATZ O KOE22 1 I1C 1200.00 | 01/07 | PWC,GP2,5TDSLNG/S0L | 552 20121130

Example: Detail Report Screen Print for PRO Extract Audit

Prosthetics (PRO) Extract Audit Report Detail Page 1

DSS Extract Log #: 3969

Date Range of Audit: FEB 01, 2013 to FEB 28, 2013

Station: 552 (DAYTON)

Report Run Date/Time: AUG 23, 2013@14:40

100 A -- MOTORIZED NPPD

NAME SSN HCPCS QTY TYP COST DATE HCPCS DESC STN# ENTRY DT

PAT5 XXXX K0848 1 1 C 1600 02/01 PWC,GP3,STD,SLNG/SOL 552 20130108

PAT6 XXXX K0856 1 1 C 4057 02/01 PWC,GP3,STD,SNGL PWR 552 20130117

PAT7 XXXX K0856 1 1 C 2038.1502/05 PWC,GP3,STD,SNGL PWR 552 20130114

4.6.10 Radiology (RAD) Extract Audit
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Use this option to print a summary report from the RADIOLOGY EXTRACT file (#727.814)
which displays the total count of each radiological procedure within a Feeder Location.

Example: Radiology Extract Audit Report

Radiology (RAD) Extract Audit Report

DSS Extract Log #: 195

Date Range of Audit: JAN 01, 1990 to JAN 31, 1990
Report Run Date/Time: NOV 26, 1997@10:47

Radiology Division: TOGUS, ME (402) Page: 1
Imaging Type (Feeder Location) # of Procedures
CPT Code Procedure Inpt. Outpt.

GENERAL RADIOLOGY (402-1)

70470 CT HEAD W&WO CONT 1 0
71020 CHEST 2 VIEWS PA&LAT 1 2
73120 HAND 1 OR 2 VIEWS 0 1
Sub-totals for GENERAL RADIOLOGY (402-1): 4 3
Grand Total for Division TOGUS, ME (402): 4 3

Example: Exported Radiology Extract Audit Report

EXTRRACT EBRDIOLOEY IMAGING TYPE CET PROCEDURE § OF & OF

LOE g DIVISION {FEEDER CODE INET OUTET
41534 DAYTON (552) ANGIO/NEURO/INTE 20552 INJECT 1 28
4154 DAYTON (552) ANGIOSNEURO/INTE 20553 INJECT a [
4154 DRYTON (552) ANEIO/NEURO/INTE 22520 VERTEEROE u] 1
4154 DAYTON (552) ANGIOSNEURO/INTE 22521 VERTEEBROE a Z

4.6.11 Surgery (SUR) Extract Audit

Use this option to print a summary report from the SURGERY EXTRACT file (#727.811). The
report displays the number of surgical procedures and surgical cases performed in O.R. and Non-
O.R. locations.

Example: Surgery Extract Audit Report

Surgery (SUR) Extract Audit Report

DSS Extract Log #: 255

Date Range of Audit: MAY 01, 1997 to MAY 31, 1997
Report Run Date/Time: NOV 26, 1997@10:50

Surgery Division: ALBANY (500) Page: 1
0.R. Surgical Procedures
CPT Code  Procedure # of Procedures
11041 DEBRIDE SKIN FULL 1
00100 ANESTH, SKIN SURGERY 1
00103 ANESTH, BLEPHAROPLASTY 1
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For Division ALBANY (500)--
Total O.R. Surgical Procedures: 3
Total O.R. Surgical Cases: 1

For Division ALBANY (500)--
Total Non-O.R. Surgical Procedures: 0
Total Non-O.R. Surgical Cases: 0

Example: Exported Surgery Extract Audit Report

EXTRACT ESUREERY TYEE OF CET PROCEDURE £ OF

LOE § DIVISION PROCEDURES CODE PROCEDURES
41595 DRYTON (55Z) O.R. Surgicel 10121 REMOVE
4155 DRYTON (552) ©.R. Surgical 11008 REMOVE
4155 DRYTOMN (552) O.R. Surgical 11042 DEB SUBQ 1

4.6.12 Treating Specialty Change (TRT) Extract Audit

Use this option to print a summary report from the TREATING SPECIALTY CHANGE
EXTRACT file (#727.817) which displays the total number of losses within each treating
specialty of a medical center service.

Example: Treating Specialty Change Extract Audit Report

Treating Specialty Change (TRT) Extract Audit Report

DSS Extract Log #: 247

Date Range of Audit: NOV 01, 1996 to NOV 30, 1996

Report Run Date/Time: NOV 26, 1997@11:09

DSS Site: ALBANY (500) Page: 1

Service Facility Treating Specialty # of Losses
Specialty (DSS Code)

DOMICILIARY DOMICILIARY PTSD
DOMICILIARY PTSD (88) 0
DOMICILLARY
DOMICILIARY (85) 0
Total for DOMICILIARY: 0
INTERMEDIATE MED GEM INTERMEDIATE
GEM INTERMEDIATE CARE (32) 0
INTERMEDIATE MED
INTERMEDIATE MEDICINE (40) 0
Total for INTERMEDIATE MED: 0

Example: Exported Treating Specialty Change Extract Audit Report
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EXTRRCT D55 SITE SEEVICE SPECIRLTY (D55 FACILITY £ OF LOSSES

LOC £ CODE ) TREATING
4135 DAYTON (552) DOMICILIARY DOMICILIARY (&5) DOMICILIRRY 5
4195 DAYTON (552) DOMICILIARY DOMICILIARY (85) SERTOUSLY
4135 DAYTON (552) DOMICILIARY DOMICILIRRY CHV DOM CHV 4

4.7 Transmission Management

This section initiates and controls the transmission of data from the extract files to AITC. This
menu provides users with the functionality to purge the IVP, UDP, or VBECS holding files. It
also provides users with the functionality to delete an individual or range of DSS extract files.

Choosing the Transmission Management option from the Extract Managers Menu will display
the following menu and options.

Example: Transmission Management Options on Extract Managers Menu
Select Extract Manager®s Options Option: T Transmission Management

Review a Particular Extract for Transmission
Transmit Data from Extract Files

Summary Report of Extract Logs

Delete Extract Files

Purge Extract Holding Files

Recreate Extract Holding Files ...

4.7.1. Review a Particular Extract for Transmission

Use this option to review a particular extract to verify the transmission of messages to the AITC.
The only prompts are for the extract log record number and a print device. The output includes
the following information:
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e Extract log record number e Transmission message numbers

e Extract name e \Whether or not the extract was
e Run date purged
e Division e Message status

Example: Extract for Transmission

Select DSS EXTRACT LOG RECORD NUMBER: 465 08-13-98 Admission ALBANY
ADM Extract (#465) Records: 2

Generated: AUG 13, 1998 Start date: APR 01, 1998

Division: ALBANY End date: APR 30, 1998

DEVICE: HOME//

Status Report for DSS Extract #465 (Admission)

ADM Extract (#465) Records: 2

Generated: AUG 13, 1998 Start date: APR 01, 1998
Division: ALBANY End date: APR 30, 1998
Purged: (Not purged)

Transmitted: AUG 17, 1998
Unconfirmed transmission message numbers --

202 208 209

200100 200101 200102
200103 200104 200105
200106 200107 200108
200109 200110 200111
200112 200113 200114
200115 200116 200117
200118 200119 200120
200121 200122 200123
200124 200125 200126
200127 200128 200129
200130 200131 200132
200133 200134 200135

4.7.2. Transmit Data from Extract Files

To receive mail messages confirming transmission of extract data, you must be enrolled in the
DSS mail group associated with the extract being transmitted.

Use this option to transmit a series of mail messages containing data from an individual extract
to the AITC. Members of the associated mail group(s) will receive confirmation messages
indicating that an extract was completed, transmitted, and received in Austin. You can only
transmit extracts for your division.

Example: Transmit Data from Extract Files

Select Transmission Management Option: T Transmit Data from Extract Files
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Your user setup will only allow you to transmit extracts from the following divisions:
SITE LOCATION NAME

ITf you can"t select an extract, it is probably from another division.

Transmit which extract: 2604 08-09-06 Admission
ADM Extract (#2604) Records: 117
Generated on: AUG 09, 2006 Start date: MAR 01, 2006
Division: DIVISION NAMR End date: MAR 31, 2006

The data was extracted using fiscal year 2006 logic.
Mai IMan transmission of the Admission extract is set to a
Limit of 131,000 bytes per message. Each extract record ends with a "~.

** This extract is being sent from a field office domain. **
** Extract message(s) will only be delivered to you and *x
** will be placed into your "DSSXMIT" mail basket. *x

Requested Start Time: NOW// (OCT 24, 2006@15:09:49)
Request queued as Task #33798.

Example: Sample Mail Message - Completed Extracted Data

Subj: ADMS 444 - ADM DSS EXTRACT MESSAGE 1 OF 2 [#7058653] 14 Sep 99 19:03 8 lines
From: DSS SYSTEM In "IN® basket. Page 1

The DSS-Admission extract (#759) for Jul 01, 1999
through Jul 31, 1999 was begun on Sep 14, 1999 at 19:02
and completed on Sep 14, 1999 at 19:03.

A total of 489 records were written.

Extract time was [HH:MM:SS] 0:00:48

Enter message action (in IN basket): IGNORE//

Sample Mail Message - Transmission of Extracted Data

Subj: QSR 444 - QSR DSS EXTRACT MESSAGE 1 OF 2 [#7058779] 05 Oct 99 03:16 10 lines
From: DSS SYSTEM In "IN® basket. Page 1

The DSS QUASAR (ECQ) extract, #786,
was transmitted on Oct 05, 1999 at 03:15.

Maximum number of lines (records) per message: 200

A total of 861 records were written.
A total of 5 messages were sent.
Message numbers :
7058774 7058775 7058776 7058777
7058778

Enter message action (in IN basket): IGNORE//
Sample Mail Message - Confirmation of Extracted Data

Subj: DRS1928 DMS Confirmation [#415417] 03 Dec 97 20:10 CST 2 Lines
From: <XXXXXXXX@XXXXXXXX.VA.GOV> in "IN" basket. Page 1
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Ref: Your DMS message #841928 with Austin ID #80378631,is assigned confirmation
number 942512003079972.

Enter message action (in IN basket): IGNORE//

4.7.3. Summary Report of Extract Logs

Use this option to print a summary report from the EXTRACT LOG file (#727). The only
prompts are for starting and ending dates and a print device. The output includes the following
information:

e Extract number e Date purged

e VistA Package e Date Extracted

e Data set dates (date range) e Data Month

e Record count e Msg Unconf (Message Number)
e Date transmitted e Requestor

The report prints properly to a 132-column output

Example: Summary Report Extract Logs

Select Transmission Management Option: s Summary Report of Extract Logs
Enter Report Start Date: 030106 (MAR 01, 2006)
Enter Report Ending Date: (3/1/2006 - 10/26/2006): 060106 (JUN 01, 2006)

** REPORT REQUIRES 132 COLUMNS TO PRINT CORRECTLY **

DEVICE: HOME// ;132;

DSS EXTRACT LOG STATISTICS

Page: 1

EXTRACT NUMBER  VISTA PACKAGE  DATA SET DATES RECORD COUNT DATE DATE PURGED
DATE EXTRACTED DATA MONTH  MSG UNCONF REQUESTOR TRANSMITTED
2179 Admission 060301-060331 O

Jul 26, 2006 Mar 2006 0 USER,ONE
2186 Prescription 060601-060630 O

Jul 27, 2006 Jun 2006 0 USER, TWO
2185 Unit Dose 060601-060630 O

Jul 27, 2006 Jun 2006 0 USER, TWO

Example: Exported Summary Report Extract Logs

EXTRACT NUMBER VISTA PACEAGE DATAZ SET DATES RECORD COUNT DATE TRAMSMITTIED DATE PURGED DATE EXTRACTED DATA MONTH MSG UNCONF REQUESTCOR

40Z4 Admission 140301-140331 570 Z23-Apr-14 23-Rpr-14 Mar-14 2 OO0, 000
4059 Admission 140301-140331 570 e-May-14 Mar-14 O 3000, 300
4092 Admission 140301-140331 570 27-May-14 2Z-May-14 Mar-14 2 OO, K
4142 RAdmission 140301-140331 570 10-Jun-14 10-Jun-14 Mar-14 2 000, M0N0
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4.7.4. Delete Extract Files

This option can be used to delete individual extracts residing in files (#727.802) through
(#727.833) or a range of extracts. Also, holders of the ECXMGR Security Key may only delete
extracts that are associated with a division assigned in the NEW PERSON file (#200).

Any existing extract may be deleted (including transmitted and untransmitted) and extracts that
did not run to completion due to errors or system problems.

Choosing a range of extracts could mean an excessively large number of records to be deleted
and it may be very resource intensive. Please be sure to queue this for non-peak hours and limit
the number of extracts to be deleted in a single queued session.

Example: Delete Extract File Option

This option will allow you to delete an
individual or a range of DSS extracts files.

Care must be taken for several reasons:

- You can delete ANY existing extract. This includes transmitted and non-
transmitted extracts as well as extracts that did not run to completion
due to errors or system problems.

- Choosing a range of extracts could mean an excessively large number
of records and be very CPU intensive.

Please be sure to queue this deletion for off-hours and
limit the number of extracts to be deleted per a single queued session.

Delete Extract Files?? NO// y YES

...one moment please

Do you want to print a list of extracts that can be deleted? NO//

You will not be able to select an extract that is not from your division.
Select extracts to be deleted: (3794-4071): 3794

I will delete the following extract(s):
#3794 - Event Capture 01/01/2013 to 01/31/2013

Is this OK? NO// YES

4.7.5.Purge Extract Holding Files

Use this option to purge the data that resides in the holding files for the I\VP, UDP, or VBECS
extracts. A prompt will appear for the start and end dates. Dates can be entered as 10 15 08,
10/15/08, or 10/15/2008.

The IV EXTRACT DATA file (#728.113) and UNIT DOSE EXTRACT DATA file (#728.904)
can become quite large if appropriate purging is not performed. This option will purge the data
from these files by date range. It is recommended that records over two fiscal years old be
purged from IV EXTRACT DATA file (#728.113) and UNIT DOSE EXTRACT DATA file
(#728.904).
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VBECS holding files can also be purged. Once purged, these files cannot be recreated for that
time period.

Purging of any local VistA extract data or VistA source of extract data (i.e., lab data, etc.) is not
recommended until your facility has successfully created extracts, transmitted them to the AITC,
audited the counts, loaded the data into DSS, and is content with the results.

When the Purge ends, a confirmation message will be created on MailMan.

Example: Purge Holding Files
Select Transmission Management Option: Purge Extract Holding Files

This option will allow you to purge:
1. data that resides in the "holding files" for the IVP and UDP extracts.
2. data that resides in the "holding Ffile"™ for the VBECS extract

Care must be taken for several reasons:

- The 1VP, UDP and VBECS "holding" files are intermediate files that
are populated "realtime™ by inpatient pharmacy and VBECS activity.
These files are then used to generate the IVP, UDP and VBECS extracts.
NOTE: The VBECS files CANNOT be regenerated.

Once it is purged for a date range, extracts can no longer be
generated for that time period.

Purge (1)VP data, (U)DP data or (V)BECS data? IVP Holding File
This file currently holds IVP data from <Oct 13, 1999> to <Apr 01, 2013>.

Beginning date for purge: 1/1/13 (JAN 01, 2013)
Ending date for purge: 1/31/13 (JAN 31, 2013)

I will purge the IVP holding file from <Jan 01, 2013> to <Jan 31, 2013>.

Is this OK? NO// y YES

Example: Confirmation Message
Select Transmission Management Option: MailMan Menu

VA MaillMan 8.0 service for XXXXXXX@XXXXX.PRE-PROD.VISTA.MED.VA.GOV
You last used MailMan: 10/28/08@11:57
You have 1 new message.

NML New Messages and Responses
RML Read/Manage Messages
SML Send a Message
Query/Search for Messages
AML Become a Surrogate (SHARED,MAIL or Other)
Personal Preferences ...
Other MailMan Functions ...
Help (User/Group Info., etc.) ...
Super Search Message File

You have 1 new message. (Last arrival: 10/28/08@®15:01)
Select MailMan Menu Option: n New Messages and Responses
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Subj: DSS - Purge of IVP Holding File [#560578] 10/28/08@15:01 3 lines
From: DSS SYSTEM In "IN® basket. Page 1 *New*

The information has been successfully PURGED
from Feb 01, 2007 to Feb 02, 2007

Enter message action (in IN basket): Ignore// <RET>

Select Transmission Management Option: ?

4.7.6. Recreate Extract Holding Files

Use this option to recreate an I'VP or UDP Extract holding file which has been purged at the
AITC. You will be prompted for the start and end dates. A background task will be launched.
When that task ends, it will create a confirmation message on MailMan.

It is unusual to purge and recreate these files. They normally are NOT purged.
The Recreate applies to the entire parent station.

To recreate an IVVP or UDP extract,

1. Run the Purge for the desired date range.
. Dates can be entered as 10 15 08 or 10/15/08 or 10/15/2008.

2. Check MailMan for a confirmation message that the Purge has completed
successfully.

3. Run the Recreate for the same date range.
e If you did not run the Purge and data exists for the requested time period, you will

be prompted to do so.

4. Check MailMan for a confirmation message that the Recreate has completed

successfully.

5. Run the IVVP or UDP Extract.

6. Compare the record count from the recreated extract to the record count of the
original extract. The counts should be close but may be slightly different due to
timing issues.

Example: Example of Recreate

Select Transmission Management Option: Q Recreate Extract Holding Files
Select File to Recreate: ?

| Recreate IVP Extract Holding File (#728.113)
U Recreate UDP Extract Holding File (#728.904)

Select Recreate Extract Holding Files Option: 1 Recreate IVP Extract Holding File
(#728.113)

Enter Start Date: 2 1 07

Enter Stop Date: 2 1 07
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Requested Start Time: NOW//<RET> (SEP 09, 2008@13:31:43)
Request queued as Task #155353.

Requested Start Time: NOW//<RET> (OCT 28, 2008@15:04:37)
Request queued as Task #2607.

When the Recreate is complete, a MailMan message will be sent to you. To view the message,
type “MailMan Menu” at the prompt. You will see the following lines.

Example of Confirmation Message for Recreate
Select Transmission Management Option: MailMan Menu

VA MailMan 8.0 service for XXXXX.XXXXX@XXXXX.XXXXXX.VISTA_MED.VA.GOV
You last used MailMan: 10/28/08@11:57
You have 1 new message.

NML New Messages and Responses
RML Read/Manage Messages
SML Send a Message
Query/Search for Messages
AML Become a Surrogate (SHARED,MAIL or Other)
Personal Preferences ...
Other MailMan Functions ...
Help (User/Group Info., etc.) ...
Super Search Message File

You have 1 new message. (Last arrival: 10/28/08@15:01)
Select MailMan Menu Option: n New Messages and Responses

Subj: 1V INTERMEDIATE DATA FOR DSS [#560579] 10/28/08@15:05 5 lines
From: DSS SYSTEM In "IN® basket. Page 1 *New*

The 1V information has been successfully regenerated
from Feb 01, 2007 to Feb 01, 2007@99:99

A total of 151 records were written.
Enter message action (in IN basket): Ignore// <RET>

Select Transmission Management Option: ?
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5 Glossary

Term

Definition

Action to Send Code

Indicates which code should be sent to the DSS commercial software
(e.g., stop code, credit stop code, or both).

ADPAC Acronym for Automated Data Processing Application Coordinator

ADM Abbreviation for Admission Extract

AITC Acronym for Austin Information Technology Center

BCM Abbreviation for BCMA Extract

BCMA Acronym for Bar Code Medication Administration

CBOC Acronym for community Based Outpatient Clinic

CLI Abbreviation for Clinic Extract

CPT Acronym for Common Procedure Terminology

Credit Stop Code The credit stop code (from the HOSPITAL LOCATION file [#44]) as
determined by Medical Administration Service (MAS).

CSHD Acronym for Customer Support Help Desk

DSO Acronym for Decision Support Office

DSS Acronym for Decision Support System

DSS Credit Stop Code

The credit stop code as determined by DSS.

DSS Department Code

A code associated with products or services, which assists in the
categorization and costing of those products. At this time, only medical
center wards are being associated with a DSS Department code in the
DSS WARD file (#727.4). The DSS Department code consists of a
minimum of 4 characters as:

ABBCxxx

A =DSS CODE in NATIONAL SERVICE file (#730)

BB = DSS PRODUCTION UNIT CODE in DSS PRODUCTION
UNIT file (#729)

C =DSS DIVISION IDENTIFIER in DSS DIVISION IDENTIFIER
file (#727.3)

xxx = A suffix of not more than three characters which must be
numeric digits or uppercase alpha characters. The first character of the
string may be "-", but that is not recommended.

DSS Division Identifier

A single character code, either numeric (but not zero) or an uppercase
alpha character. The character used in VistA file #727.3 (DSS
DIVISION IDENTIFIER) as division identifier should exactly match
the identifier associated with a medical center division in DSS/Austin.

DSS Production Unit

A two character code which may contain both numeric and uppercase
alpha characters. These DSS-compatible codes are based on the FMS
sub-cost center scheme to categorize production unit output. The DSS
PRODUCTION UNIT file (#729) holds the production unit codes
approved for use by DSS.

DSS Stop Code The stop code as determined by DSS.

ECS Abbreviation for Event Capture Extract

ECQ Abbreviation for QUASAR Extract
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Term

Definition

Extract

Management tool used to track and account for procedures and
delivered services, which are not handled in any existing VistA
package.

Extract Files

The files that hold the data that has been extracted via the DSS Extract
software.

Feeder Key The product for workload extracted.

Feeder Location The site location of data extracted.

IVP Abbreviation for 1V Detail Extract

LAB Abbreviation for Laboratory Extract

LAR Abbreviation for Lab Results Extract

LBB Abbreviation for Blood Bank Extract

MAS Acronym for Medical Administration Service

MOV Abbreviation for Transfer and Discharge Extract

NDC Acronym for National Drug Code

NDF Acronym for National Drug File

PRE Abbreviation for Prescription Extract

PRO Abbreviation for Prosthetics Extract

Provider The actual provider of care performing the procedure. This provider can
be a doctor, nurse, technician, or any designated team of medical
professionals.

QUASAR Acronym for Quality: Audiology and Speech Pathology Audit &
Review

RAD Abbreviation for Radiology Extract

SSN Acronym for Social Security Number

Stop Code The stop code (from the HOSPITAL LOCATION file [#44])as
determined by Medical Administration Service (MAS).

SUR Abbreviation for Surgery Extract

TRT Abbreviation for Treating Specialty Change Extract

UDP Abbreviation for Unit Dose Local Extract

VA Acronym for Department of Veterans Affairs

VHA Acronym for Veterans Health Administration

VistA Acronym for Veterans Health Information Systems and Technology
Architecture

Volume Volume is associated with the number of procedures performed or the
length of time actually spent performing the procedures.

YTD Acronym for Year-to-Date
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Appendix A - Feeder Key Transmission

The Feeder Key for the Clinic Extract is transmitted in the following format.
SSSCCCTTTPPPP

These characters are determined by the Action To Send code as indicated in the following table.

Action to Send Code Description

1 SSS is the stop code.
CCC=000.
TTT is the length of appointment.
PPPP=0000.

2 SSS is the credit stop code.
CCC=000.
TTT is the length of appointment.
PPPP=0000.

3 Two records are sent:
For the first: For the second:
SSSis the stop code. SSSis the credit stop code.
CCC=000. CCC=000.
TTT is the length of TTT is the length of the appointment.
appointment. PPPP=0000.
PPPP=0000.

4 SSS is the larger of the stop code or the credit stop code.
CCC is the smaller of the stop code or the credit stop code.
TTT is the length of appointment.
PPPP is the pointer to the HOSPITAL LOCATION file.

5 SSS is the larger of the stop code or the credit stop code.
CCC is the smaller of the stop code or the credit stop code.
TTT is the length of appointment.
PPPP=0000.
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Appendix B - Create a LAR Translation Table

A translation table is required to convert entries in the results field of the LAR extract from a free
text to a numeric value for all types of lab tests. The translation table is a new table for the DSS
VistA Extract Package. LAR TRANSLATION TABLE will convert free text results to a
numeric value for all lab tests.

The translated numeric values are:

0- Negative, Non-Reactive.

1- Positive, Reactive.

2- Borderline, Indeterminate.

3- Test not Performed, Qty not sufficient or other reason.

5- Result cannot be translated.

The Lab results free text field contains many different coding schemes to indicate whether the
results are negative or positive. The list of text with the translated values is as follows:

RAW Translation RAW Translation
Negative 0 EQUIV 2
Positive 1 NRG 5
NEGATIVE 0 N 0
POSITIVE 1 R 1
Neg 0 Borderline 2
Pos 1 NEG . 0
nonreactive O POS. 1
NONREATIVE 0 ND 0
reactive 1 Reactive 1
REACTIVE 1 Detected. 1
NEG 0 React 1
POS 1 Nonreact 0
NOTDET 0] WK POS 1
DETEC 1 +/-=pos 2
NON REAC 0] LSG 5
REAC 1 Reactive* 1
WK .POS 1 =+pos 1
WK.POS. 1 NEGATIV 0
NEG# 0 ND 0
POS# 1 INCONC. 2
BRDLINE 2 DONE 5
NR 0] NEH 5
Non-react 0 MEG 5
BRDLNE 2 P 1
**pos 1 NRG 5
***pos 1 Repeat 2
BDL 2 NE 5
EQUIVOCAL 2 NGE 5
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RAW Translation
REM

ND

NRE

See com
See rpt
Reac
NREACT
Type 1
2b

3a

BAS

N-1
Pend
RPC

QNS

P

FFT

+

(el NON NONOEONONONO RO N Nel N NN NN

Note:

Any value not in the table should return a “5”.

The sites will be responsible for maintaining/updating the table.
Translations cannot change the meaning of the free text field.

Non-numeric reported values for all tests would be stored in the translation field and available to
Ad Hoc and SQL.

In many cases, it may take a long time to run this report (possibly more than an hour or two).
Your screen may be tied up for some time once you set the report to run.
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Appendix C — Exporting a Report to a Spreadsheet

1. Select Display from the Setup menu.

File Edit Connection [Setup| Macro Window Help
D@ -& @] Temina. c BRPEE W

Display...
Events...

File Transfer...
Hotspot...
Keyboard Map...
Menw...

Meouse Map...
Safeguards...
Toolbar...

View Settings...

Defaulis

2. On the Screen tab, modify the number of Columns to at least 225. Click OK.

2 X
Cursor
@l vse
Control characters
@ Interpret ) Desplay
Scrofing
@ Jump Jump scroll speed:
*) Smooth

3. Select Logging... on the File menu.
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File | Edit Connection Setup Macro Window Help

Mew Session... L ] | e | B | h?

Open...

Save vista.dss.dayton.preprod.med.va.gov

Save As...

Import and Export 2
Layout 2

Save Display As...
Properties...

Transfer...

Legging...
Print...

Print Setup...
Page Setup...

Close Printer
Send...

Exit

Exit All

| Log text from a host to a printer or a file

4. On the Logging popup, click to select Logging on. Then, select the Disk option and name

the file. Click Browse...

:.{_..t-'.lr-hlfr

/| Logging on
Liag oudpit ta

1 Pa | =
(] Printer ;Smd To OneNote 2010

| Print Setup.

[V] Digk

5. Select the folder where the text file will be saved and click Save.
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[ 15 Rl s g
Date modified

Me itemns match your search.
Recent Places

Desktop

PRO Bxtract [fTD HCPCS Report
Save a3 type: [_TudFlu

6. The file will be created in the folder identified.

Organize v Includein library »  » = - 7]
< Favorit = Mame }

B Desktop ﬂ || PRO Extract ¥TD HCPCS Report

8 Downloads

7. Press Enter on your keyboard to keep the parameters at the DEVICE: 0;225;99999// prompt.
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8. Once the running of the report has completed, to turn off the logging select Logging... on
the File menu. On the Logging popup, click to deselect Logging on.

"] Printes @Sm To OneMote 2010

[ Disk.

[] Sedial devies: NOME

9. Open a new Excel workbook. Click the Data tab and select From Text.

I-h: me Insert Pal;e Layout Formulas Data Review
———————
) From Access - 3 _\i 2] Connections 3l E
i From Web S —U 3 Properties [
From Other | Existing Refresh _ Z] Sort
FromText  cources= ' Connections | All» =2 Edit Links
Get External Data Connections 5

10. Navigate to the folder where the file was created. Select the text file that was created and click
Import.
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OO coer T

Mew fobder

= Mame
|| PRO Extract ¥TD HCPCS Report B/2/2013 2:19 PM 52 KB

Organize -
o] Dn.s.unp
B Downloads
2. Recent Places

~4 Libraries
* Documents
.J' Music
= Pictures
B videos

& Computer

: Date modified Type

[ g

H p ||

- |TetFies

-

File name:  PRO Extract YTD HOPCS Report

Tools Import || | Concel |

2

11. Chose Delimited as the data type on the Text Import Wizard — Step 1 of 3 screen. Click Next

™

Bz

Text Import Wizard - Step 1 of 3

Start import at cow:

Preview of file

The Text Wizard has determined that your data is Delimited.
If this is cormect, choose Next, or choose the data type that best desaribes your data.

Original data type
Choose the fie type that best describes your data:

= Characters such as commas or tabs separate each field.

ﬁ&- Delimited
) Fied width - Fields are aligned in columns with spaces between each field,

i ] Fewon: | 65000+ Uncode U7

12. Under delimiters, uncheck Tab, then check Other and type a caret () as your delimiter on the
Text Import Wizard — Step 2 of 3 screen. Click Next.
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This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview
balow.

13. Text will be chosen as the format for each column on the Text Import Wizard — Step 3 of 3
screen. In the Data Preview section of the screen, click to highlight the column and select Text as
the data format. (Note: All columns can be selected at once if the first column is selected and then

hold the shift key and move the scroll bar to the far right and select the last column). Click Finish
after each column has been formatted.
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Text Import Wizard - Step 3 of 3 B S

This screen lets you select each column and set the Data Format.

'‘General’ converts numeric values to numbers, date values to dates, and all
remaining values to text.

o [

() Do notimport column (skip)

Note: When each column has been formatted. the
Data preview column heading changes from General to Text.

CATH IMPL WASC RACCESS PORT
IMPLANTRBLE RCCESS SYST PE
O5TOMY CLAMP, REPLACEMENT
ELASTIC GARMENT/COVERING

TRACHEOSTOMA FILTER

L
k2

oo

14. Click OK when the Import Data screen appears.

Import Data l ? ﬁl

Where do you want to put the data?
(@) Existing worksheet:

() Mew worksheet

Properties... ] [ (0]4 ] [ Cancel ]

15. The report will be created and displayed in Excel.

A B C D E F G H 1
REPORTTYPE  PSAS HCPCS QTY COM TOTALCOM AVECOM QTY VA TOTALVA AVEVA QTY LABE
NEW A4265 PARAFFIN 68 145532 2140 0 0 0 0
NEW A4300 CATH IMPL VASC ACCESS PORT 1 310 310.00 0 0 0 0
NEW A4201 IMPLANTABLE ACCESS SYST PE 22 9787 444.86 0 0 0 0
NEW A4363 OSTOMY CLAMP, REPLACEMENT 21 as 2.14 0 0 0 0
NEW A4466 ELASTIC GARMENT/COVERING 85 175443 20.64 0 0 0 0
NEW A44381 TRACHEOSTOMA FILTER 28 232 8.29 0 0 0 0
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